TIBCO® MDM Add-on for
Global Data Synchronization

User's Guide

Version 3.0.3
December 2020

Copyright © 1999-2020. TIBCO Software Inc. All Rights Reserved.



2 | Contents

Contents
Contents .. 2
TIBCO Documentation and Support Services ... ... ... 7
Global Data Synchronization Network Overview ......................................... 9
Terminology Differences in the GDSN Edition ... 9
GDSN Specific Configuration Properties ... ... ... ... 10
GDSN SpecCific ROLES ... .. e 11
GDSN Predefined Components ... . 12
GDSN Menu Options and Pages ... ... ... . 13
GDSN Specific Menu tems .. 13
Datapool Profiles in the Administration Menu ... ... ... 13
GDSN SpeCifiC Pages ... o 14
All Company Profiles Page ... .. 14
My Company Profiles Page ... .. .. . 15
Extended Credentials ... ... ... 15
DatAPOOl 17
Datapool Profiles Page ... . .l 18
Trading Partner Profiles Page ... ... ... 19
View Repository Page ... . ... 20
Message Acknowledgments . . 21
Enabling Message Acknowledgments ... .. ... 21
Sending Message Acknowledgments ... .. .. ... 22
N OX Ul 23
Event Log Search . L 24
GDSN Customization ... . 25
Synchronization .. ... 27

TIBCO® MDM Add-on for Global Data Synchronization User's Guide



3| Contents

Synchronization Profiles ... L 28
Creating Synchronization Profiles ... .. 28
DIV Y L 29
Format Specific Attributes .. . 29
Synchronization Formats ... ... 32
GDSN Specific Synchronization Formats ... ... 32
Using Custom Synchronization Formats ... 33
Synchronization Status ... 34
Updating Synchronization Status ... ... 34
Updating Synchronization Status Using Utility ... ... ... 35
Validations and Codelists ... ... . 38
1WorldSync Validations Overview ... ... 38
Supported 1WorldSync Validations ... ... 38
MDM Validation for 1WorldSync Mandatory Attributes ... 39
MDM Validation for 1WorldSync Optional Attributes ...... ... 40
MDM Implementation of 1WorldSync Codelist ... .. .. ... ... ... 45
Maintaining Validations and Codelists ... ... 53
Updating Codelists ... .. ... 53
Updating a Codelist Implemented Using Datasource ... ... ... 53
Updating a Codelist Implemented Using Enumeration ... 54
Updating Validations ... 54
Message Choreography .. ... . . 56
MDM Message Choreography for 1WorldSync ... .. .. 56
1WorldSync Attribute Mapping .. . .. 57
MDM Operations for 1IWorldSync Messages ... ... .. 93
Specifying Catalogue Item Confirmation Response ... .. ... ... ... 96
Specifying Request For Catalogue Item Notification Message ............................... 96
Correction Versus Modify ... L o7

TIBCO® MDM Add-on for Global Data Synchronization User's Guide



4 | Contents

Supported IWorldSynC RESPONSES ... .o 98
Changing Message Choreography ... ... . . 99
Configurable Components ... .. 100
GDSN Impact on Workflows and Rulebase ... 101
GDSN Impact on Rulebase ... .. 101
GDSN Impact on Workflows ... . 102
Settingup CIM to CIM .. . 105
Need for Synchronization .. ... 105
Synchronizing Two CIM Instances ... ... .. 107
Setting up Queue Configuration ... .. ... 108
Creating Enterprise and Prepopulating Data ... 112
Configuring Database Changes ... ... 117
Company Profile and GLN credentials ... 119

Creating GLN for BrandOwner Enterprise ... 120

Creating GLN for VeloselMarketplace Enterprise ... .. ... ... 120

Creating GLN for Bottlerl Enterprise ... ... ... 121

Creating GLN for Bottler2 Enterprise ... . .. 121
Trading Partner Profile ... . 122

Creating Trading Partner Profile for BrandOwner Enterprise ............................. 122

Creating Trading Partner Profile for VeloselMarketplace Enterprise ..................... 123

Creating Trading Partner Profile for Bottlerl and Bottler2 ... .. ... 124
Changing Rulebase ... ... 124
Datasource and Input Map for BrandOwner ... 126

Creating DatasoUrCe .. 126

Creating INnpUtMap . 127
Processing Reverse Relationships (Optional Step) ... ... 128
Testing your CIMto CIM Setup ... 130
Troubleshooting CIM to CIM ... .. . 131

TIBCO® MDM Add-on for Global Data Synchronization User's Guide



5 | Contents

Supplier and Retailer Setups ... 132
SupPlier SEtUD L. 132
Creating Supplier ENterprise ... 132
Defining Supplier Enterprise .. . 132
Defining Repository for Outgoing Messages ... ... 134
Selecting Repository for Incoming Messages ... ... 134
Retailer SetUD .o 135
Creating the Retailer Enterprise ... .. 135
Define the Retailer Enterprise ... .. 135
Selecting Repository for Incoming Messages ... .. ... 136
Selecting Approvers for Received Records ... ... ... 137
Selecting Editors for Received Records ... . .. ... . 137
Detecting New Backend Systems .. ... . 138
Setting up GPC Classification Scheme Data Load ..................................... 139
Configuring GPC Classification Scheme Loading .............................................. 139
Configuring Support for GPC Code ... ... 140
Configure TIBCO BusinessConnect and TIBCO BusinessWorks ................. 144
Setting up TIBCO Administrator .. ... ... 144
Setting up BusinessConnect ... ... . 145
Configuring New BusinessConnect ... ... 146
Creating Participants ... 147
Creating New Operations ... . .l 153
Configuring System Settings ... . ... 155
Defining Business Agreement _. .. L 156
Deploying the BusinessConnect configuration (Single Server Mode) .................... 158
Setting up Business Works .. ... 161
Testing the MDM-BusinessWorks-BusinessConnect Connectivity ......................... 166
GDSN Predefined Components - An Overview ... 168
GDSN-Specific RUIEDASES ... ... L 168

TIBCO® MDM Add-on for Global Data Synchronization User's Guide



6 | Contents

GDSN-SpecCific FOrMS 170
GDSN-Specific Workflows ... . 170
GDSN-SPeCific MaPS ... 172
Error Messages . .l 173
RULEDASE ErTOrS o 173
Miscellaneous Errors . 173
Administration Errors .o o 174
Catalog ErrOrs 175
GDSN SaMIPleS .o 180
WorldSync Samples ... 181
MIXmMLINdoC (SUPPLIEN) .. o 181
sync messages (retailer) .. 181
Sync mMessages (SUPPLier) .. 183
cim2cim metadata ... 186
Legal and Third-Party Notices ... ... . 187

TIBCO® MDM Add-on for Global Data Synchronization User's Guide



7 | TIBCO Documentation and Support Services

TIBCO Documentation and Support Services

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation
website, mainly in HTML and PDF formats.

The TIBCO Product Documentation website is updated frequently and is more current
than any other documentation included with the product. To access the latest
documentation, visit https://docs.tibco.com.

Product-Specific Documentation

The following documentation for TIBCO® MDM Add-on for Global Data Synchronization is
available at TIBCO® MDM Add-on for Global Data Synchronization Product Documentation

page:
o TIBCO® MDM Add-on for Global Data Synchronization Release Notes
o TIBCO® MDM Add-on for Global Data Synchronization Installation
o TIBCO® MDM Add-on for Global Data Synchronization User's Guide

To access documentation for this product, go to the following location:
TIBCO_HOME /release_notes/TIB_cim-gdsn_3.0.3_docinfo.html

Here, TIBCO_HOME is the top-level directory in which TIBCO products are installed. On
Windows, the default TIBCO_HOME is C:\tibco. On UNIX systems, the default TIBCO_HOME
is /opt/tibco.

How to Contact TIBCO Support

You can contact TIBCO Support in the following ways:
o For an overview of TIBCO Support, visit http://www.tibco.com/services/support.

o For accessing the Support Knowledge Base and getting personalized content about
products you are interested in, visit the TIBCO Support portal at
https://support.tibco.com.

» For creating a Support case, you must have a valid maintenance or support contract
with TIBCO. You also need a user name and password to log in to
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https://support.tibco.com. If you do not have a user name, you can request one by
clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee
subject matter experts to share and access their collective experience. TIBCO Community
offers access to Q&A forums, product wikis, and best practices. It also offers access to
extensions, adapters, solution accelerators, and tools that extend and enable customers to
gain full value from TIBCO products. In addition, users can submit and vote on feature
requests from within the TIBCO Ideas Portal. For a free registration, go to
https://community.tibco.com.
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Global Data Synchronization Network Overview

The Global Data Synchronization Network (GDSN) was created as an industry endorsed
initiative to overcome product data inaccuracies and increase efficiency among trading
partners and their supply chains. GDSN is a web based, interconnected network of
interoperable data pools and a global registry.

With GDSN you can capture and exchange product information in a secure environment
conforming to global standards. By using GDSN you can assure that data exchanged
between trading partners is accurate and compliant with universally supported standards.

GDSN consists of supplier and retailer trading partner, data pools that hold and process
trading partner data and the GS1 Global Registry. A directory that helps locate data
sources and keep relationships between trading partners in sync.

With GDSN, trading partners always have the latest information in their systems. Any
changes made to one company's database are automatically and immediately provided to
all of the other companies who do business with them.

With accurate and updated data, a supplier and a customer can do business in a
smoother, quicker, and less expensive way.

Terminology Differences in the GDSN Edition

There are some differences between GDSN and MDM software editions. The default
edition is MDM.

Terminology Differences in GDSN

GDSN Name MDM Name
Repository Repository
Synchronize Synchronize
Trading Partner  Backend System

Record Record
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GDSN Name

Datapool

MDM Name

Integration Hub

GDSN Specific Configuration Properties

The following configuration properties are specific to GDSN:

GDSN Specific Configuration Properties

Property

Plugins

Software
Edition
>Application
Usage Profile

Software
Edition >
Common
Menus
Configuration

Function >
Enable Market
Place

Function >
Company
Profile

Integration
Setup - External
> Connector
Rulebase

Integration

Configuration
Outline

Advanced

Basic

Advanced

Advanced

Advanced

Advanced

Advanced

Value

GDSN

GDSN

config/security/
allmenu.xml

True

True

standard/rulebase/
rbconnectorprotocol
derivation_gdsn.xml

standard/rulebase/

Description

List of Plugins installed.
For example, GDSN.

Defines whether the
application is used for
data synchronization
(GDSN) or master data
management (MDM)

The configuration file
location for common
menus (navigation bar)

Marketplace related
menus is visible.

Company Profile menu
is visible.

The rulebase to identify
the protocol (for
example, CIM2CIM,
1WorldSync)

Sync status derivation,
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Property Configuration Value Description

Outline
Setup - External rbsyncstatus used to identify
> Sync Status updatederivation.xml operation and
Rulebase suboperation.
Integration Advanced rbformatattributes_ The name of the
Setup - External gdsn.xml rulebase file used to
> customize format
Synchronization specific attributes on the
Format Specific Synchronization profile
Attributes File View and Edit page.
Rule Base- Advanced rbsendmessage_ The name of the
>Send Message gdsn.xml rulebase file used to
Screen customize record
Rulebase File attribute display on the

SendMessage page

Integration Advanced rbworkitemdescription_ ~ The name of the
Setup - External gdsn.xml rulebase file to
-->Work Item customize work item
Description messages

Rulebase File

GDSN Specific Roles

You can access the Roles page by clicking Administration > Roles. It displays all available
Roles and descriptions.

In addition to the standard MDM roles, the following roles are GDSN specific and visible
only in the GDSN edition of MDM:

Channel Manager

Is a user responsible for business activity in a particular sales channel. Typically
responsible for relationships with Datapools or a set of buying organizations.

Sales Rep

Is a member of the supplier sales organization who acts upon current items in the Inbox
that pertains to their area. Sales Rep is not created for the MDM edition. If it existed
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already, it is not deleted during migration.

Roles
Role Name Role Description

©J Administrator Manages users, roles, permissions, and so on.

*) Command Line User Persons having command line access

©) Channel Manager Role who has data stewardship

*) External User External User

") Repository Approver Approver for changes to records

"] Repository Editor Editor who can initiate changes to records

") Repository Manager Role who manages metadata

") Support Engineer Support Engineer who can inquire raw data

") work Supervisor Role who can override workflow actions and reassign work i
Page 1 of 1 w0 v View 1-9of9

GDSN Predefined Components

For GDSN, a set of predefined components such as maps, rulebases, workflows, and
templates are shipped with the application.

All these components are located in relevant folders under $MQ_
HOME /plugins/gdsn/<version>/common/standard

For details, see GDSN Predefined Components.
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GDSN Menu Options and Pages

GDSN-specific options (that are not displayed in the standard MDM version) in the menus
and pages in TIBCO MDM.

» Datapool Profiles in the Administration Menu
o All Company Profiles Page

o My Company Profiles Page

« Datapool Profiles Page

« Trading Partner Profiles Page

o View Repository Page

o Message Acknowledgments

e Inbox Ul

o Event Log Search

o Customizing Workitem Descriptions

GDSN Specific Menu Items

Some menu items are available specific to GDSN version of MDM.

Datapool Profiles in the Administration Menu

The Administration menu includes a Datapool Profiles option that is specific to the GDSN
version of MDM.

A Datapool Profile defines an electronic sales channel, datapool, or hub - where backend
systems can exchange goods. Datapool Profiles and credentials are used to establish new
datapools and manage the datapool activities.

A Datapool Profile correlates to a workflow associated with the datapool and you can
subscribe or unsubscribe a Datapool as required. Datapool credentials are provided
automatically; however, you can define additional credentials. For more details, see
Datapool Profiles Page.
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GDSN Specific Pages

Some pages are available specific to the GDSN version of TIBCO MDM. Also, a few menu
names are also changed. For example, the Master Data menu name is changed to Item
Data in the GDSN version.

All Company Profiles Page

The All Company Profiles page is accessed by clicking Administration > All Company
Profiles > Create and is used by super users to create enterprises.

You can specify the Name, and Internal Name for the enterprise, the Industry Vertical,
and the Type. The Type list contains Supplier, Retailer, and Datapool as options.

Create Company

Name

Internal Name

Industry Vertical

Type Supplier ¥
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My Company Profiles Page

You can access the Company Profile page by clicking Administration > My Company
Profile and displays the profile of the company that you have logged into.

This page consists of contact information and credentials for your company. The purpose
of company credentials is to enable your organization to communicate with a datapool.

The following information is GDSN-specific:

My Company Profile
Ed Modify
Name suU pps
Contact Information
Main Phone No "Main Phone" assigned.
General Info No "General Info Email” assigned.
Email
Main FTP No "Main FTP" assigned.
Datapool
1SyncTest Credentials
Credentials
+ Create
Identity * Domain Action
0040885037340 GLN Delete
Page 1 of 1 mn v Viewl-1ofl

Extended Credentials

Each credential can be supplemented with additional information known as extended
credentials.
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To create extended credentials, click the Credentials link in the Datapool section of the
Company Profile page.

This data is used for authentication when communicating with the datapool. To define an
extended credential, first define a basic credential.

Extended credentials are unique across enterprises. These constraints are implemented
using predefined seed data and cannot be changed using the UL.

The following constraints apply to datapools:
 Basic credentials must be unique in an organization.
o Only one GLN per enterprise

To create extended credentials, click Administration > MyCompany Profile > and then
click Credentials in the Datapool section. Click Create.

TIBCO® MDM Add-on for Global Data Synchronization User's Guide
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Create Credential

Company Name suppé

Domain GLN v
Identity 0040885037340 v

Batch User ID
User ID admin

Password ssasesens
Synchronize With v
Global Registry

Enter the required details and click Save.

Datapool

The page displays the datapool the company is subscribed to. A "Not subscribed to any
Datapool" message indicates that no datapool subscriptions have been made for the
company.

You can subscribe to a datapool by clicking Datapool Profiles (see Datapool Profiles
Screen). This opens the Datapool Profiles page that displays all the datapools supported
by TIBCO MDM. Click Subscribe to subscribe to that datapool. Only datapools that the

TIBCO® MDM Add-on for Global Data Synchronization User's Guide
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company is subscribed to are available for participation by the backend system.

Datapool Profiles Page

This is the first page you see when you click Administration > Datapool Profiles. It
displays all datapools that you can subscribe to and are supported by TIBCO MDM.

Datapool

View  All v

Datapool Status Actions

1SyncTest Subscribed Modify Unsubscribe
1Sync Unsubscribed Madify Subscribe
SA2 Unsubscribed Modify Subscribe

Page 1 of1 Fr View1-3of3

Use this page for the following activities:

« Modify Datapool ProfilesTo modify a datapool profile, click Modify in the Actions
column. The Datapool Profiles - Synchronization Formats page is displayed. On this
page you can:

o Modify supported synchronization formats. TIBCO MDM supports formats
specific to datapools, and default formats can be set for each datapool. If
custom formats are required, they can be created using synchronization
formats.

o Create Credentials. A Datapool credential uniquely identifies a datapool or
backend system within a datapool. This establishes message origination and
destination for that backend system. For example, a supplier wants to do
business with a backend system through a datapool such as 1WorldSync. the
datapool provides User IDs and Passwords or credentials to both the supplier
and backend system, and identifies itself to both using its own password and
credentials.

o Subscribe or Unsubscribe to DatapoolsClick the Subscribe or Unsubscibe button in
the Actions column.

« Filter Datapools By default, all datapools are displayed. They can be sorted based

TIBCO® MDM Add-on for Global Data Synchronization User's Guide
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on subscription from the View drop-down list.

There are two forms of Datapool profiles. The most common form is when a company
wants to communicate with a Datapool. In this case, the only data elements visible are:

o Subscribe to this Datapool.
« Define any integration URL, if applicable.

« Define credentials. Here, the credentials of the Datapool are defined (and not the
company as company credentials are defined in the Company Profile).

o Some preexisting credentials are displayed as read only. These credentials are global
and can only be modified by a super user.

A supplier organization Datapool Profile consists of:
o Documents for communication - such as Item Add, or Item Publish.

o A document format - such as EANUCC, XML, 1WorldSync, and so on.

Trading Partner Profiles Page

You can access the page by clicking Administration > Trading Partner Profiles, and then
clicking Create.

Using this page, you can create a new trading partner profile for your company. Two ways
to exchange data with a trading partner are:

o Publish data to the Datapool from where the data gets synchronized with the trading
partner.

« Deliver the data to the trading partner directly through FTP or email.

TIBCO® MDM Add-on for Global Data Synchronization User's Guide
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Trading Partner Profile
Name Retailer
Global v

Contact Information

Phone 12345
Synchronization Defaults

Default Synchronization Format ~ NONE v

Transport Mechanism Email ® FTP Local

Email

FTP Details

Name Directory

Host Login

Password Re-enter Password

The Datapool option in this page is GDSN-specific. Select to subscribe.

When you view a trading partner profile, if not subscribed to any datapools, you see the
message "Not subscribed to any datapools" in the Datapool Participation section.

View Repository Page

The View Repository page displays the content of a selected repository and you can access
by clicking Item Data > Repositories. The following information is GDSN-specific:

Selected Predefined Classification Schemes

Classification schemes that are provided with the application by default are referred to as
predefined classification schemes and are listed here. The schemes listed here are those
selected at the time of creating the repository.
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View Repository

Repository Name SYNC1 Table Name MCT_35279
Last Modified 2020-04-15 16:56:34.792 Last Modified By admin,admin
Repository Description  SYNC1 Display Name SYNC1
Attribute History No Precedence Management No

Attributes | Relationships | Output Maps Classification Schemes

Classification Scheme Name Description Scheme Type User Defined?
GPC GPC Rulebase Based Mapping YES
UDEX UDEX Rulebase Based Mapping YES

You can click the Classification Scheme name to view details; this displays the
Classification Scheme Modify page. On this page, click Show Usage to view the
Classification Scheme Usage.

Message Acknowledgments

When a message is sent from a Supplier to a Retailer, the retailer can send an
acknowledgment for the message using the Send Response utility.

Enabling Message Acknowledgments

By default, message acknowledgments are not enabled. You need to enable permissions
for a user to send a response.

Procedure
1. Go to Administration > Resource Security.

2. From the list, select Resource Type as Repository and Resources as <name of
Repository>. Click Show Permissions. The Manage Resource Security for
Repositories page is displayed.

3. On the Manage Resource Security for Repositories page, select Resource Type as
Record and click the Add Grantee button.
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Manage Resource Security for Repositories

Repository Name SYNC1

Repository Description SYNC1

Resource Type Record v

Grantee Type

® admin User
Permission Name Default Allow Deny
Allow confirmation of record without workflow Denied O O
Allow action - Send Message Allowed ® O
Allow record saved as unconfirmed without workflow Allowed C O
Allow action - Send Response Denied O O
Update synchronization status Allowed O O
View Allowed O O -

4. You can assign a user or a role as grantee. Select the grantee and click OK.

5. A list of permissions is displayed in the Permission Name column.Click Allow
against Allow action - Send Response permission and click Save.

Sending Message Acknowledgments

You can send a record as a response.

@ The Send Response option is not available in the 3.0.3 release.

Procedure
1. Click Browse and Search.
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2. From the Repository Name list, select the name of the repository.

3. Click View All.
A list of records is displayed.

4. Click the record ID of a record.
5. On the View Record page, select Send Response.

6. On the Send Response page, you can set the following options:

Send Response

Record ID testwwreadd0-00600000002514
Record ID Extension testwwreadd-00600000002914-ext

SHORTDESC tem-add-BASE_UNIT_OR_EACH
Datapool Name SAZ
Trading Partner Name DS-0040885021622

Current Record State PUBLISHED
Action " review © accepTen € svyNCHRONISED ¢ REJECTED

Retailer Credential I GLN - 0040825022629 LI

submit_ | [ Cancel |

o Action: Select Review, Received, Synchronised, or Rejected.

o Retailer Credential: Select the retailer credential from the drop-down list.
7. Click Submit.

8. On the View Record page, click Ok.
The acknowledgment is sent to the Supplier.

Inbox Ul

You can access the page by clicking Inbox on the main menu. The Inbox shows a list of
tasks or work items assigned or delegated based on the configured business process rule.
The Inbox content is influenced by your Role. Work items are classified as notification (no
action required) or action (action required).

You can search for items (by clicking the Search button) based on criteria such as:

« State: View work items by state - All, Canceled, Closed, Open, or Timed out work
items.

« Type: Filter work items by type - All, Action Items, Notifications.

o Document Type: Filter work items by Document Type such as All, Mass Update,
Record Content Notification, Record Edit, or Synchronization.

TIBCO® MDM Add-on for Global Data Synchronization User's Guide



24 | GDSN Menu Options and Pages

Action: Filter work items by the Action performed, such as Data Change, Data
Correction, MassUpdate, Record Add, Record Add Notification, and Synchronization.

Trading Partner: Filter work items by trading partner.
Event ID: Filter work items by entering the exact event ID.

From Date/To Date: Filter work items created within a certain date range. It is not
mandatory to specify both the start and end dates of a period that you are tracking.
You can specify either of them.

Repository: Filter work items by repository. It displays the list of repositories to
which you have access (at least LIST access). Work items can be searched for a
specific repository. To remove a filter the search needs to be cleared.

Record Attribute: Filter work items based on the values of Record Attributes. For
example, to search SecuritylD - 00049822430355; you can either enter the complete
SecuritylD or enter a partial value (00049822) to get the work item.

Sort by Record Attribute: Sort work items based on record attribute. Select the
record attribute from the drop-down list. If you want to sort the list in the
descending order of the record attribute, select the Descending check box.

Datapool: Filter work items by datapool.
Show Action Items First: If selected, displays action items followed by notifications.

Search/Sort: Enter your search criteria and click Search/Sort to generate a list of
work items matching your criteria. If you want to change the search criteria, click
Clear to reset the criteria.

Clear: Clears the search

Configure: To configure the columns displayed in the table.

Inbox
» Search

State All b4 Type Al v Document Type All v Action All
Event ID Repository Al v Keyword Datapool All
From Date 7 To Date

[Seorcn § Ciear J e |

Summary

Event Log Search

You can access this page by clicking Event Log in the main menu and then click the
Search option.
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The Event Log page shows a list of all events in the system. You can click Search to search

for events based on criteria such as:

o Event Status

o Event Type

e EventID

e User ID

o Operation

e Trading Partner
« Datapool

o Event Start Date
o Event End Date

e Record ID

o RecordID Ext.

Event End Date

Event D

2020-12-07 16:35:35.192

Date/Time

Event

[ | 34410 Datapool response notification 322042—05 23.09:35.6
0O a4408 Synchronization 2020-12.06 2308:50.5
[ | 34407 Record Modify 322042—05 22:66:56.4
O a4406 Synchronization 20201206 21:2531.7
[ 34405 Registry Response Notfication | 2020-42-06 2031:34 2
[ 34404 Datapool response noffication | 20201206 20119:16.9
0O 34402 Synchronization 2020-12-06 20:17:42.4
O 34401 Record Add

2020-12-06 20:04:22.8
A0

Last Update Date/Time

2020-12-06 23:09:36.30
2
2020-12-06 23.09:36.64
5
2020-12-06 22:56:57.15
9
2020-12-06 21.25:35.92
2
2020-12-06 20:31:34.82
5
2020-12-06 20:19:22.40
5
2020-12-06 20:31:35.48
5

2020-12-06 20:04:48.94
4

ltems/Page | 50

RecordID Ext

Duration(D:H:M:5)

1 Seconds

46 Seconds

2 Seconds

4 Seconds

0 Seconds

6 Seconds

13 Minutes 53 Seconds
26 Seconds

« <

Page

status

Success

Success

Success

Success

Success

Success

Success

Success

1 of2

Trading Partner

>»

Current state

Done

Start new workflow

Done

Done

Done

Done

Start new workflow

Done

Event Log
O, Hide Search

Search
Event Status Al B Event Type Al %
Event ID (I User ID
Operation Al = Trading Partner Al ©

Datapool Al o
Event Start Date 2020-11-07 16:35.35 102 Record ID

Datapool

NIA

18yncTest

NIA

18yncTest

N/A

NIA

1SyncTest

NIA

GDSN Customization
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Customizing Workitem Descriptions

You can include hyperlinks to objects such as Repositories, Catalogs, Trading Partners,
and so on in your workitem description. You can include only one hyperlink per object in
a message by including the relevant token in the description.

For details on tokens that can be used, refer to chapter Customizing Workitem
Descriptions in the TIBCO MDM Customization Guide .

GDSN Specific Information

For the $Catalog$ token that is used to create a hyperlink with a catalog, the name of the
catalog appears in place of the token, hyperlinked to the latest version of the catalog.
However, there are some exceptions applicable to the GDSN version:

« Catalogue Item Notification (CIN) message notifications received by retailers

« Catalog Item Confirmation (CIC) received by suppliers, which were not sent to the
retailers using the catalog
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Synchronization

The application has some GDSN-specific information in synchronization profiles and
formats in TIBCO MDM.

Synchronization Profiles

o GDSN Specific Synchronization Formats

Using Custom Synchronization Formats

Updating Synchronization Status
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Synchronization Profiles

Synchronization Profiles provide a way of extracting information from repositories.

As part of the Synchronization Profile definition, you can choose records and attributes to
be extracted, record versions, whether to apply transformation rules, and where to send
the extracted data. Synchronization Profiles once created can be reused to extract data.

You can view the Synchronization Profile by clicking Item Data > Synchronization Profiles.
Details for all available synchronization profiles can be viewed here, with related
information in specific columns such as the Repository, Synchronization Format, Delivery,
and so on.

Synchronization Profiles
Filter By Trading Partner Name

All

<> Create

Synchronization Profile Repository Name Trading Pariner | Synchronizafion Format | Output Map Deliver To
LINK_D0001122110004 syncl ta_ret 1SYNC 15YNC Trading partner with data pc
LINK_00001122110028 syncl ta_ret 1SYNC 15YN Trading partner with data pc

SINGL_DATAPOOL_D0001122110042 syncl NA 1SYNC 1SYN Dstspoo

SINGLE_TP_00001122110059 synct tp_ret 15VNG 18YN rading partnerwith dats pe

LINK_TP_0000 synct tp_ret 1SYNG 1SYNC Trading partner with data pc
LINK_TP_0000 0 synct tp_ret 1SYNG 1SYNC Trading partner with data p
LINK_DATAPOOL_0000 synct NiA 18YNC 1S¥NC Dstapao
LINK_DATAPOOL_D 7 synct NiA 18YNC 1S¥NC Dstapao
SINGLE_TP_00001 0141 synct tp_rat 18YNC 1S¥NC Trading pariner with dsta pc
synct tp_ret 18YNC 1S¥NC Trading pariner with dsta pc
22110202 synet A 15YNC 1SYNC Dstapao
1Cvhs 1TV Fimtmmmn T

1 Items per page 50 ¥  Results: 1-350f35

Creating Synchronization Profiles

Procedure
1. Click Item Data > Synchronization Profiles.

2. Then click Create on the Synchronization Profiles page.

Note: When creating a Synchronization Profile, some options are GDSN-
specific.
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Delivery

In the Delivery section of the Create Synchronization Profile page, you can select the
entity to deliver records to. The following entities are GDSN-specific:

Delivery

Deliver To Trading Pariner'® Datapool''Trading partner on datapool
Datapool 1SyncTest v
Qutput Map 1SYNC v

Delivery Mechanism (e Local ( JFTP ( JE-mail
Destination Address

« Datapool

Datapool is the central repository. When you select Datapool, and click Synchronize,
the system sends the data as a message to the Datapool. The message is sent in the
XML format and the system requires an acknowledgment from the Datapool. You
need to provide the name of the Datapool, the output map, and the delivery
mechanism.

Trading Partner on Datapool

When you select this option, and click Synchronize, the message is sent to only
those trading partners who are subscribed to the Datapool. The trading partner
should have a valid GLN account with the Datapool. You can select multiple trading
partners in this option. You need to specify both the Datapool and trading partners
subscribed to the Datapool. You also need to specify the Output Map format and the

delivery mechanism.

Format Specific Attributes

Format Specific Attributes vary based on where you want to deliver the records.

If Datapool is selected in the Delivery group, the following is displayed:

« Operation: You can select from the following operations:
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Format Specific Attributes

Operation Add () Data Correction [ Cancel [ Discontinue [ Reinstate

Classification Scheme UDEX v | Deliver Synchronization ®yes No

Profile

Supplier Credential GLN - 0040885037340 r
Generate Output file? L

o Add: Adds the record to the Datapool.

o Data Correction: If there is a discrepancy in the published record, you can

select Data Correction to rectify the record. In this case, the record reverts to
its original state.

o Cancel: If you cancel a record, you cannot publish or reinstate the same record
within 24 to 48 months of cancellation.

o Discontinue: If you discontinue a record, you cannot publish the same record
within 24 to 48 months.

o Reinstate: Using reinstate, you can republish a discontinued record.

« Classification Scheme: The classification scheme listed in the Company Profile are
displayed here.

« Supplier Credential: The credentials listed in the Company Profile are displayed
here.

« Deliver Synchronization Profile: Select Yes if you wish to deliver the synchronization
profile to the backend system.

« Generate Output file?: Select the option to generate output file.

If Trading Partner on Datapool is selected in the Delivery group, the following additional
fields are displayed:

Format Specific Attributes

Operation Add [ Data Correction Publish

Classification Scheme Mene v | Deliver Synchronization ®'es No
Profile

Supplier Credential GLM - 0040885037340 r

Generate Output file? o

« Operation: You can select from the following operations:
o Add: Adds the record to the Datapool.

o Data Correction: If there is a discrepancy in the published record, you can
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select Data Correction to rectify the record. In this case, the record reverts to
its original state.

o Publish: Publishes the record to the selected backend systems.

« Classification Scheme: The classification scheme listed in the Company Profile are
displayed here.

o Supplier Credential: The credentials listed in the Company Profile are displayed
here.

« Deliver Synchronization Profile: Select Yes if you wish to deliver the synchronization
profile to the backend system.

« Generate Output file?: Select the option to generate output file.
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Synchronization Formats

The application currently provides a set of predefined synchronization formats.

You can access this page by clicking Item Data > Synchronization Formats.

GDSN Specific Synchronization Formats

Synchronization formats define the attributes and structure of the data required by the
consumers of that data (external systems or datapools).

Output maps define mappings of repository attributes to synchronization formats. When a
repository is synchronized, the synchronization format provides the structure for the
output information.

For GDSN, many predefined synchronization formats are supplied which are not modified.
The following are GDSN-specific synchronization formats:

e 1SYNC

o EAN.UCC

o EAN.UCC.SUBSCRIPTION
e GS1

e SA2

« TIBCO

« XML

Synchronization Formats

Synchronization Format Name Description Pre-defined Fixed Length Delimiter Text Qualifier

SYNC 15YNC Catalog Format Yies No Comma None

EAN.UCC EAN.UCC Cataleg Format Yes Mo Comma Mone
EAN.UCC.SUBSCRIPTION Subscription Catalog Format Yes No Comma MNone
GS GS1 Catalog Format Yes No Comma None
SA2 SA2 Catalog Format Yes No Comma Mone
TIBCO TIBCO Cataleg Format Yes No Comma Mone

XML XML Catalog Format (] Mo Comma Mone
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Using Custom Synchronization Formats

Procedure
1. Copy the EAN.UCC synchronization format to create the <CustomUCC> format.

o Select the EAN.UCC format check box and click the Copy button.

o Provide a name and description on the Synchronization Format copy page.

2. Create output map <CustomOutputMap>.
o Go to Item Data->Repositories

o Select a repository, go to the Output Maps tab, click Create.

3. Change the rulebase to select <CustomOutputMap>. For more information on
creating a rulebase, refer the TIBCO MDM Studio Rulebase Designer Guide. The
modified rulebase section will look like the following:

<assign> <var>OUTPUTFORMAT</var> <const
type="string">CustomOutputMap</const> </assign>

Note: If you are not using the default EAN.UCC format, you need to make
changes to the rulebase to publish an output map created for a custom
synchronization format.

Navigate to <MQ_
COMMONDIR>/standard/rulebase/rbsyncstatusupdatederivation.xml to
add the name of custom output map instead of "EAN.UCC" as in the
following section:

<assign>

<var>OUTPUTFORMAT</var>

<const type="string">EAN.UCC</const>
</assign>

There may be several similar replacements required.

4. Perform Update sync status. For more information on updating synchronization
status, see Updating Synchronization Status.
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Synchronization Status

Synchronization Status (synch status) is the status of the record synchronized with
Datapool.

You can update the synch status using Updating Synchronization Status.

Updating Synchronization Status

Records are always synchronized with Datapools.

The synchronization state (sync status) of a record can be incorrect in the following cases:
« Datapool failed to respond.
o Message(s) failed in Datapool(s) and there was no response from messages.

« Response was received but response format was not comprehensive and the
processing failed.

« Record was synchronized outside the application. For instance, you migrated from
MDM to another GDSN system.

When the sync status is incorrect, it affects the next message generated by the application
and synchronization is not possible. To resolve this issue, the sync status needs to be
updated.

You can update the sync status of the record.

Procedure

1. Click Browse and Search.
A list of Repositories are displayed.

2. In the Repository list, select the repository.

3. Click View All.
A list of records is displayed.

4. Click the record whose synch status you want to update.

5. On the View Record page, click Update Sync Status.
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6. On the Update Synch Status page, select the values for the following fields:

« Datapool
o Trading Partner
o Operation

e Sub-Operation

Update Synch Status

Repository Name SYNCA1
Repository Descri  SYNC1
ption

Record ID - Ext 00001044011045

Version 1

Last Modified On  09/06/2020
Datapool -
Operation "~

New Synch Status

Status

Last Modified By
Trading Partner

Sub-Operation

CONFIRMED

admin,admin

w

7. Click Save to update sync status.

o Note: An out-of-the-box installation assumes that EAN.UCC is associated
with the repository. If this format is not associated, the operation fails. To
correct this, either associate the synchronization format or use another

synchronization format in the rulebase
rbsyncstatusupatederivation.xml.

Updating Synchronization Status Using Utility

By using the updateSyncStatus utility, you can correct the synchronization status of a
record in TIBCO MDM. Run the utility if the synchronization status of records in
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1WorldSync and TIBCO MDM is different. The updateSyncStatus.bat and
updateSyncStatus.sh utility files are available in $MQ_HOME\b-in.

Procedure

1.

Navigate to $MQ_HOME/bin/migration and create a file named
updatesyncoperations.txt and enter the details of a operation (in the following
format) that you want to perform:

productkeyid,operation,suboperation
SQL command to retrieve PRODUCTKEYID

For example,

10004 ,ADD,NEW

SQL command to retrieve PRODUCTKEYID

select * from MCT_34819 to get CPRODUCTKEYID of 00005555565578 =>
10013
Navigate to $MQ_HOME\b-in.

Run the following command:

updateSyncStatus.bat -cid SYNCI_CATLOG_ID -of Catalog outputmap name -mid
organization_ID for the market place

e CATLOG_ID: selects ID from catalog where NAME=SYNCI

e Catalogoutputmap name (outputformat): 1SYNC

e organization_ID for the market place: selects ID from ORGANIZATION
where NAME=1SYNCTEST

For example,

updateSyncStatus.bat -cid 34819 -of 1SYNC -mid 32699

The optional tradingPartner attribute is required if you want to publish records to
a trading partner.
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Result
The synchronization status is updated. You can synchronize the records.
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Validations and Codelists

MDM has validations present for mandatory and optional attributes in 1WorldSync and
MDM'’s implementation of the 1WorldSync codelists.

o 1WorldSync Validations Overview
o MDM Validation for 1WorldSync Mandatory Attributes
o MDM Validation for 1WorldSync Optional Attributes

o MDM Implementation of 1WorldSync Codelist

1WorldSync Validations Overview

While communicating to subscribers, 1WorldSync specifies certain rules to be followed to
ensure that the data received is correct.

1WorldSync performs validation on different types of messages received and processed.

Supported 1WorldSync Validations

MDM supports the following 1WorldSync validations:

o When messages of type Item Load (Item Add, Item Modify Item Link, or Item Unlink
transaction) are received

o When messages of type Item Publish are received

For more details, refer MDM Validation for 1WorldSync Mandatory Attributes and
MDM Validation for 1WorldSync Optional Attributes for validations implemented in
MDM for mandatory and optional attributes by 1WorldSync for Item Load messages.
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MDM Validation for 1WorldSync Mandatory Attributes

The following table lists validations implemented in MDM for mandatory attributes specified by 1WorldSync for Item Load messages (Item Add, Item Modify).

In the table below:

o IM Attribute is the attribute name in 1WorldSync.

o 1WorldSync Error Code is the error displayed by 1WorldSync in case of validation problems.

« MDM Repository Attribute is corresponding name of the 1WorldSync attribute in the MDM Repository.

« 1WorldSync Catalog Output Map Attribute is the name of an attribute created by MDM using the 1WorldSync Catalog Output Map.

Validation for 1WorldSync mandatory attributes

IM Attribute

Global Trade Item Number
GTIN Name

Product Type

Target Market

Language

Information Provider (GLN)
Brand Name

Item Classification Code (GPC)
Qty of Next Level Item(s)
Ordering Unit Indicator
Start Availability Date
Height

Height UOM

Width

1WorldSync Error Code
1021, 1024, 1025

1040

1080

1160

No error code available
1011 1061, 1064, 1062, 4020
1050

1070

1130

1140

1150

1100

1101

1120

Repository Attribute
GTIN

GTIN_NAME

UOM

TARGET_MARKET_ID
DESCLANGUAGE
INFORMATION_PROVIDER_ID
ITEM_BRAND_NAME
ADDITIONAL_CLASS_CAT_CODE
UNITS_PER_CONTAINER
ORDERING_UNIT
START_AVAILABILITY_DATE
PRODUCTHEIGHT
HEIGHT_UOM

PRODUCTWIDTH

Sync Profile Attribute
GTIN

GTIN_NAME

PRODUCT _TYPE
TARGET_MARKET
LANGUAGECODE
INFORMATION_PROVIDER
BRAND_NAME
ALT_ITEM_CLASSN_CODE
PACK
ORDERING_UNIT_INDICATOR
START_AVAILABILITY_DATE
HEIGHT

HEIGHT_UOM

WIDTH
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IM Attribute 1WorldSync Error Code
Width UOM 1121
Depth 1110
Depth UOM 1111

Repository Attribute

Sync Profile Attribute

WIDTH_UOM WIDTH_UOM
PRODUCTDEPTH DEPTH
DEPTH_UOM DEPTH_UOM

MDM Validation for 1WorldSync Optional Attributes

The following table lists validations implemented in MDM for optional and dependent attributes specified by 1WorldSync for Item Load messages (Item Add, Item Modify).

Validation for 1WorldSync Optional Attributes
IM Attribute

Alternate Item Classification Scheme

Flash Point Temperature UOM

Product Strength UOM

Product Strength Basis UOM

Diameter UOM

Drained Weight UOM

Gross Weight UOM

1WorldSync Error Code

1071, 1077, 3085

1548, 1549

1686, 1687

1689, 1690

1780, 1781

1783, 1784

1786, 1787

Repository Attribute
ADDITIONAL_CLASS_CAT_CODE
CLASSIFICATIONSCHEME
FLASHPOINT_TEMP1
FLASHPOINT_UNITS1
PROD_STRENGTH
PROD_STRENGTH_UOM
PROD_STRENGTH_BASIS
PROD_STRENGTH_BASIS_UOM
DIAMETER

DIAMETER_UOM
DRAINED_WEIGHT
DRAINED_WEIGHT_UOM
GROSSWEIGHT

GROSS_WEIGHT_UOM

Sync Profile Attribute
ALT_ITEM_CLASSN_CODE
CLASSIFICATION_SCHEME
FLASHPOINT_TEMP
FLASHPOINT_TEMP_UOM
PROD_STRENGTH
PROD_STRENGTH_UOM
PROD_STRENGTH_BASIS
PROD_STRENGTH_BASIS_UOM
DIAMETER
DIAMETER_UOM
DRAINED_WEIGHT
DRAINED_WEIGHT_UOM
GROSS_WEIGHT

GROSS_WEIGHT_UOM
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IM Attribute

Net Weight UOM

Volume UOM

Width UOM

Max Stacking Weight UOM (formerly Max Admissible Stacking Weight UOM)

Storage/Handling Temp UOM

Alternate Item Number

Fat Content Basis of Measure UOM

Net Content (Metric) UOM (formerly Size (Metric) UOM)

Ordering Unit Indicator

Gross Weight

Gross Weight UOM

Product Strength Basis

1WorldSync Error Code

1790, 1789

1801, 1802

1804, 1805

1901, 1902

6228

2002

2084, 2085

4043

3013, 3014, 3015

3040, 3041

Repository Attribute
NETWEIGHT

NET_WEIGHT_UOM

VOLUME

VOLUME_UOM

PRODUCTWIDTH

WIDTH_UOM
STACKING_WEIGHT _MAX
MAX_ADM_STACKING_WEIGHT_UOM
STORAGE_HANDL_TEMP_MIN_UOM
STORAGE_HANDL_TEMP_MAX_UOM
ALTERNATE_ID
ALTERNATE_ITEMID_MNT_AGENCY
FAT_CONTENT_BASIS_MEASURE
FAT_CONTENT_BASIS_UOM
BASE_UNIT
NET_CONTENT_PRIMARY
NET_CONTENT_UOM
ORDERING_UNIT

GROSSWEIGHT
GROSS_WEIGHT_UOM
PROD_STRENGTH

PROD_STRENGTH_BASIS

Sync Profile Attribute

NET_WEIGHT

NET_WEIGHT_UOM

VOLUME

VOLUME_UOM

WIDTH

WIDTH_UOM
MAX_ADM_STACKING_WEIGHT
MAX_ADM_STACKING_WEIGHT_UOM
STORAGE_HANDL_TEMP_MIN_UOM
STORAGE_HANDL_TEMP_MAX_UOM
ALTERNATE_ITEM_ID
ALTERNATE_ITEMID_MNT_AGENCY
FAT_CONTENT_BASISOF_MEASURE
FAT_CONTENT_BASIS_UOM
BASE_UNIT_INDICATOR
SIZE_METRIC

SIZE_METRIC_UOM
ORDERING_UNIT_INDICATOR
GROSS_WEIGHT
GROSS_WEIGHT_UOM
PROD_STRENGTH

PROD_STRENGTH_BASIS

TIBCO® MDM Add-on for Global Data Synchronization User's Guide



42 | Validations and Codelists

IM Attribute

Ordering Unit Indicator

Ordering Unit Indicator

Ordering Unit Indicator

Fat Content Basis of Measure

Non GTIN Pallet Height UOM

Non GTIN Pallet Gross Weight UOM

Global Item Classification Code
EAN/UCC Code

EAN/UCC Type

EAN/UCC Code

Qty of Next Level Item(s)

Brand Name

Sub Brand

Ordering Unit Indicator

Special Item Code

1WorldSync Error Code

3051

3053

3055

3100, 3101

3138

3140

1072

4008

4002, 4003
212, 4005, 106, 4023
1051

1740

655, 111

4022

Repository Attribute
ORDER_INCREMENT
ORDERING_UNIT
MAXIMUMORDER
ORDERING_UNIT
MINIMUMORDER
ORDERING_UNIT
FAT_PERCENT_IN_DRY_MATTER
FAT_CONTENT_BASIS_MEASURE
PACKAGEDHEIGHT
NONGTIN_PL_HEIGHT_UOM
NONGTIN_PL_GR_WEIGHT
NONGTIN_PL_GR_WEIGHT_UOM
ADDITIONAL_CLASS_CAT_CODE
EAN_UCC_CODE
EAN_UCC_TYPE

EAN_UCC_CODE
UNITS_PER_CONTAINER
ITEM_BRAND_NAME
ITEM_SUB_BRAND_NAME
ORDERING_UNIT

SPECIAL_ITEM_CODE

Sync Profile Attribute

ORDER_QUANTITY_MULTIPLE
ORDERING_UNIT_INDICATOR
MAX_ORDER_QUANTITY
ORDERING_UNIT_INDICATOR
MIN_ORDER_QUANTITY
ORDERING_UNIT_INDICATOR
FAT_CONTENT
FAT_CONTENT_BASISOF_MEASURE
NONGTIN_PL_HEIGHT
NONGTIN_PL_HEIGHT_UOM
NONGTIN_PL_GR_WEIGHT
NONGTIN_PL_GR_WEIGHT_UOM
ALT_ITEM_CLASSN_CODE
EAN_UCC_CODE
EAN_UCC_TYPE

EAN_UCC_CODE

PACK

BRAND_NAME

SUB_BRAND
ORDERING_UNIT_INDICATOR

SPECIAL_ITEM_CODE
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IM Attribute

Depth UOM

Width UOM

Height UOM

Diameter UOM

Peg Hole Number

Peg Horizontal UOM

Peg Vertical UOM

Net Content (Metric (formerly Size Imperial UOM))

Net Content (Metric (formerly Size (Metric))

List Price Basis UOM

Product Size Code Maintenance Agency

Storage/Handling Temp UOM

1WorldSync Error Code

3120

6216

6216

6216

6216

6216

6216

6216

6216

Repository Attribute
DEPTH_UOM

WIDTH_UOM

HEIGHT_UOM

DIAMETER_UOM
PEG_HORIZONTAL
PEG_VERTICAL
PEG_HOLE_NUMBER
PEG_HORIZONTAL
PEG_HORIZONTAL_UOM
PEG_VERTICAL
PEG_VERTICAL_UOM
NET_CONTENT_SECONDARY,
NET_CONTENT_SECONDARY_UOM
NET_CONTENT_PRIMARY
NET_CONTENT_UOM
LIST_PRICE_BASIS_PER_UNIT
LIST_PRICE_BASISPERUNIT_UOM
SIZE_CODE
SIZE_CODE_LIST_AGENCY
STORAGE_HANDLING_TEMP_MAX,

STORAGE_HANDL_TEMP_MAX_UOM

Sync Profile Attribute
DEPTH_UOM

WIDTH_UOM

HEIGHT_UOM
DIAMETER_UOM
PEG_HORIZONTAL
PEG_VERTICAL
PEG_HOLE_NUMBER
PEG_HORIZONTAL
PEG_HORIZONTAL_UOM
PEG_VERTICAL
PEG_VERTICAL_UOM
SIZE_IMPERIAL,
SIZE_IMPERIAL_UOM
SIZE_METRIC
SIZE_METRIC_UOM
LIST_PRICE_BASISPERUNIT
LIST_PRICE_BASISPERUNIT_UOM
PROD_SIZE_CODE
PROD_SIZE_CODE_MAINT_AGENCY
STORAGE_HANDL_TEMP_MAX,

STORAGE_HANDL_TEMP_MAX_UOM
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IM Attribute

Storage/Handling Temp UOM

Color

Color Code Maintenance Agency
Organic Claim Agency

Organic Claim Item Code

Material Code Agency

Packaging Material Code

Packaging Material Composition
Packaging Material Composition UOM

List Price Basis Per Unit List Price Basis Per Unit UOM

Tax (Rate)
Type Code Tax (Rate)
Type Description Tax (Rate)

Type Agency

1WorldSync Error Code

6216

6216

6216

6216

6216

6216

Repository Attribute Sync Profile Attribute

STORAGE_HANDLING_TEMP_MIN STORAGE_HANDL_TEMP_MIN

STORAGE_HANDL_TEMP_MIN_UOM STORAGE_HANDL_TEMP_MIN_UOM

COLOR COLOR
COLOR_CODE_AGENCY COLOR_CODE_MNT_AGENCY
ORGANIC_CLAIM_AGENCY ORGANIC_CLAIM_AGENCY
ORGANIC_CODE ORGANIC
MATERIAL_CODE_AGENCY MATERIAL_CODE_AGENCY
PKG_MATERIAL_CODE PACKAGING_M ATERIAL_CODE
PACKAGING_WEIGHT PACKAGING_WEIGHT
PACKAGING_WEIGHT_UOM PACKAGING_WEIGHT_UOM
LIST_PRICE LIST_PRICE

PRICEUOMCODE PRICEUOMCODE
LIST_PRICE_BASISPERUNIT_UOM LIST_PRICE_BASISPERUNIT_UOM
LIST_PRICE_BASISPER_UNIT LIST_PRICE_BASISPERUNIT
LIST_PRICE_DATE_START LIST_PRICE_DATE_START
TAX_RATE TAX_RATE

TAX_TYPE_CODE TAX_TYPE

TAX_TYPE_DESC TAX_TYPE_DESC
TAX_AGENCY_CODE TAX_AGENCY_CODE
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IM Attribute

Tax Amount

Tax Amount Currency

Tax (Amount) Type Description

Tax (Amount) Type Agency

Tax (Amount) Type Code

Alternate Item Classification Code
Information Provider (GLN)

Brand Owner(formerly Owning Organization)
Variant

Functional Name

MDM Implementation of 1WorldSync Codelist

Certain 1WorldSync attributes accept only values from a code list.

1WorldSync Error Code  Repository Attribute

6216 TAX_AMOUNT
CURRENCY_CODE
TAX_AMT_TAX_TYPE_DESC
TAX_AMT_TAX_AGENCY_CODE

TAX_AMT_TAX_TYPE_CODE

1078 UDEXCODE

VE-0180_VE-0190 INFORMATION_PROVIDER_ID
VE-0270 BRAND_OWNER_ID

VE-0320 VARIANT

VE-0330 PRODUCTNAME

Sync Profile Attribute

TAX_AMOUNT

CURRENCY_CODE
TAX_AMT_TAX_TYPE_DESC
TAX_AMT_TAX_AGENCY_CODE
TAX_AMT_TAX_TYPE_CODE
GLOBAL_CLASSIFICATION_CODE
INFORMATION_PROVIDER
OWNING_ORGANIZATION_GLN
VARIANT

PROD_NAME

The following table lists the MDM implementation of the 1WorldSync code list. For a given attribute in the ‘IM Attribute’ column, the Repository Attribute column lists how the code list is implemented on

the attribute.

MDM Implementation of 1WorldSync Codelist
IM Attribute

Language

Storage/Handling Temp UOM

Barcode Type
Alternate Item Classification Scheme
Country of Origin

Country of Assembly

Repository Attribute
DESCLANGUAGE

STORAGE_HANDL_TEMP_MAX_UOMSTORAGE_HANDL_TEMP_MIN_
UOM

BAR_CODE_TYPE
CLASSIFICATIONSCHEME
COUNTRYOFORIGINCODE

TRADE_ITEM_COUNTRY_ASSEMBLY

MDM Datasource Name
LANGUAGE_CODES

TEMP_CODES

BAR_CODE_TYPES
CLASSIFICATION_SCHEMES
COUNTRY

COUNTRY
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IM Attribute

Variable Trade Item Type

Depth UOM

Width UOM

Height UOM

Diameter UOM

Peg Horizontal UOM

Peg Vertical UOM

Size Dimension UOM

Non GTIN Pallet Height UOM

Gross Weight UOM

Net Weight UOM

Drained Weight UOM

Material Weight UOM

Packaging Material Composition UOM
Non GTIN Pallet Gross Weight UOM
Max Stacking Weight UOM

Fat Content UOM,

Fat Content Basis of Measure UOM
Product Strength UOM

Product Strength Basis UOM

List Price Basis Basis UOM

Suggested Retail Price Basis UOM

Repository Attribute

VARIABLE_TRADE_ITEM_TYPE

DEPTH_UOM

WIDTH_UOM

HEIGHT_UOM

DIAMETER_UOM
PEG_HORIZONTAL_UOM
PEG_VERTICAL_UOM
SIZE_DIMENSION_UOM
NONGTIN_PL_HEIGHT_UOM
GROSS_WEIGHT_UOM
NET_WEIGHT_UOM
DRAINED_WEIGHT_UOM
MATERIAL_WEIGHT_UOM
PACKAGING_WEIGHT_UOM
NONGTIN_PL_GR_WEIGHT_UOM
MAX_ADM_STACKING_WEIGHT_UOM
FAT_CONTENT_UOM
FAT_CONTENT_BASIS_UOM
PROD_STRENGTH_UOM
PROD_STRENGTH_BASIS_UOM
LIST_PRICE_BASISPERUNIT_UOM

RECOMMEND_PRICE_PERUNIT_UOM

MDM Datasource Name

No Datasource.Code values are of type enumeration, contained in the rulebase XML

file.

LINEARUNIT

WEIGHTUNIT

PRICE_MATERIAL_UOM_CODES
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IM Attribute

Selling UOM

Ordering UOM

Price Comparison Measurement UOM
Order Sizing Factor UOM

Generic Ingredient Strength Units of Measure
Product Size Code Maintenance Agency
Organic Claim Agency

Size System

Size Group

Size Type

Composition Width UOM

Packaging Material Code

Material Code Agency

Returnable Package Deposit Amount Currency
Tax Amount Currency

List Price Currency

Retail Price On Trade Item Currency

Security Tag Location

Security Tag Type

Packaging Marked Expiration Date Type

Package Marks Diet Allergen

Repository Attribute
SELLING_UOM
ORDERING_UOM
PRICE_COMP_UOM
ORDER_SIZING_FACTOR_UOM
GENERIC_INGREDIENT_STR_UOM
SIZE_CODE_LIST_AGENCY
ORGANIC_CLAIM_AGENCY
SIZE_SYSTEM

SIZE_GROUP

SIZE_TYPE

TRADE_ITEM_COMPOS_WIDTH_UOM

PKG_MATERIAL_CODE
MATERIAL_CODE_AGENCY
RETURN_PKG_DEPOSIT_AMT_CURR
CURRENCY_CODE

PRICEUOMCODE
RETAIL_PRICE_ON_ITEM_CURR
SECURITY_TAG_LOCATION
SECURITY_TAG_TYPE
PKG_MARKED_EXPIRE_DATE_TYPE

PACKAGE_MARKS_DIET_ALLERGEN

MDM Datasource Name

SELLING_ORDERING_UOM_CODES

GENERIC_INGR_STRGTH_UOM_CODES

PRODUCT_SIZE_CODE_AGENCIES

ORGANIC_CLAIM_AGENCY_CODES

SIZE_SYSTEM_CODES

SIZE_GROUP_CODES

SIZE_TYPE_CODES

No Datasource.

Code values are of type enumeration, contained in the rulebase xml file.

PACKAGING_MATERIAL_CODES

PACKAGING_MATERIAL_CODES

CURRENCY_CODES

SECURITY_TAG_LOCATIONS

SECURITY_TAG_TYPES

No Datasource. Code values is of type enumeration, contained in the rulebase xml file.

PACKAGE_MARKS_DIET_ALLERGEN
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IM Attribute

Package Marks Free From
Package Marks Ethical

Pallet Code

Pallet Terms and Conditions
Import Classification Type

Min Storage Humidity UOM
Max Storage Humidity UOM

Min DC Delivery Temp UOM
Max DC Delivery Temp UOM
Min Market Delivery Temp UOM
Max Market Delivery Temp UOM
Flash Point Temperature UOM

Storage/Handling Temp UOM

Compliance Regulation Code
Goods Pick Up Lead Time UOM
Price Comparison Content Type
Price By Measure Type

Target Consumer Gender

Season Parameter

Dangerous Goods Regulation Code

Color Code Maintenance Agency

Repository Attribute
PACKAGE_MARKS_FREE_FROM
PACKAGE_MARKS_ETHICAL
PALLET_TYPE_CODE
PALLET_HANDL_ONEWAY_REUSE
IMPORT_CLASS_TYPE
STORAGE_HUMIDITY_MIN_UOM
STORAGE_HUMIDITY_MAX_UOM

DELIVERY_DC_TEMP_UOM

DELIVERY_MARKET_TEMP_UOM

FLASHPOINT_UNITS1

STORAGE_HANDL_TEMP_MAX_UOM

STORAGE_HANDL_TEMP_MIN_UOM
CLASS_COMPLIANCE_REG_CODE
GOODS_PICKUP_LEAD_TIME_UOM
PRICE_COMP_CONTENT_TYPE
PRICE_BY_MEASURE_TYPE

TARGET_CONSUMER_GENDER

SEASON_PARAMETER
HAZMAT_CLASSCODE1

COLOR_CODE_AGENCY

MDM Datasource Name

PACKAGE_MARKS_FREE_FROM_LIST

No Datasource.Code values are of type enumeration, contained in the rulebase xml file.

PALLET_TYPE_CODES

PALLET_TERMS_AND_CONDITIONS

IMPORT_CLASSIFICATION_TYPES

No Datasource.Code values are of type enumeration, contained in the rulebase xml file.

TEMP_CODES

CLASS_COMPLIANCE_REG_CODES

No Datasource.Code values are of type enumeration, contained in the rulebase xml file.

PRICECOMPARISIONCONTENTTYPES

PRICE_BY_MEASURE_TYPES

No Datasource.

Code values are of type enumeration, contained in the rulebase xml file.

SEASON_PARAMETERS

DANGER_GOODS_REGULATION_CODES

COLOR_CODE_AGENCIES_1SYNC
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IM Attribute Repository Attribute MDM Datasource Name

Handling Instruction Code SPECIAL_HANDLING_CODE SPECIAL_HANDLING_CODES

Lead Time UOM LEADTIMEUOMCODE No Datasource.

Organic Trade Item Code ORGANIC_CODE ORGANIC_TRADE_ITEM_CODES

Packaging Terms And Condition PACKAGING_TERMS_CONDITIONS PKG_TERMS_CONDITIONS_CODES

Packaging Type Code PACKAGING_TYPE_CODE PACKAGING_TYPE_CODES

Primary Delivery Methods PRIMARY_DELIVERY_METHOD PRIMARY_DELIVERY_METHOD_CODES

GTIN Variation Registry GTIN_VARIATION_REGISTRY No Datasource.Code values are of type enumeration, contained in the rulebase xml file.
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IM Attribute

Base Unit Indicator
Consumer Unit Indicator
Dangerous Goods Indicator
Dispatch Unit Indicator

Has Batch Number

Invoice Unit Indicator

Is Trade Item Reorderable
Is Size Based Pricing

Net Content Declared
Ordering Unit Indicator
Packaging Marked Returnable
Pricing On Product

Pricing Item Indicator

Is Private

Private Label

Product Marked Recyclable

Right of Return for Non-Sold Trade Item

Variable Weight Trade Item
Product Marked with Ingredients
Is Barcode Symbology Derivable
EANUCC Type

Volume UOM

Repository Attribute
BASE_UNIT

CONSUMER_UNIT
DANGEROUS_GOODS
DESPATCH_UNIT
HAS_BATCH_NUMBER
INVOICE_UNIT
IS_REORDERABLE
IS_TRADEITEM_SIZE_BASED_PRIC
NET_CONTENT_DEC_INDICATED
ORDERING_UNIT
PACKAGE_MARKED_RETURNABLE
PRICE_ON_PACKAGE
PRICING_ITEM

PRIVATE

PRIVATE_LABEL
PROD_MARKED_RECYCLABLE
RIGHT_RETURN_NONSOLD_TRADE
VARIABLE_UNIT
WITH_INGREDIENTS
ISBARCODEDERIVABLE
EAN_UCC_TYPE

VOLUME_UOM

MDM Datasource Name

No Datasource.

Code values are of type enumeration, contained in the rulebase xml file.

EANUCCTYPE

VOLUMEUNIT
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IM Attribute Repository Attribute MDM Datasource Name

Net Content UOM NET_CONTENT_UOM NETCONTENTUNIT

Product Type UOM UNITDESCRIPTOR

Target Market TARGET_MARKET_ID COUNTRY

Alternate Item |dentification Maintenance Agency ALTERNATE_ITEMID_MNT_AGENCY ALTERNATEITEMIDMAINTAINAGENCY
Special Item Code SPECTAL_ITEM_CODE SPECTALITEMCODE

Is Ingredient Irradiated INGREDIENT_IRRADIATED No Datasource.

s Raw Material Irradiated RAW_MATERTAL_TRRADIATED Code values are of type enumeration, contained in the rulebase xml file.
Is Trade Item Irradiated IRRADIATED

Genetically Modified GENETICALLY_MODIFIED

Is Product Subject To A Manufacturer Take Back Program TAKE_BACK_PROGRAM

Is Hazardous Component Brokendown Easily For Recycling HAZARDOUS_COMP_REMOVABLE

Is Product Disassembly By Recycling Facility Completed Using Standard Tools  DESIGN_FOR_EASY_DISASSMBLY

Product RoHS Compliance Code IS_RIGID_PLASTIC_PACKAGING
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IM Attribute

Does Product Contain SCCPs

Does Product Contain PVC

Can Product Be Easily Upgraded Or Maintained By Consumer
Is Tradeltem Auto Powered Down Enabled When Shipped To Customer
Is Product Chemical Not Intended For Human Consumption
Is Product A Pesticide

Is Product Aerosol

Is Product Considered Universal Waste

Is Product RPPC Compliant In TargetMarket

Is Tradeltem Packed Irregularly

Has Display Ready Packaging

Repository Attribute
CONTAINS_SCCP

CONTAINS_PVC
IS_UPGRADEABLE_OR_MAINTAIN
POWER_DOWN_ENABLED
CHEMICAL_FOR_HUMAN_CONSUME
CONTAINS_PESTICIDE
CONTAINS_PROPELLANT
IS_UNIVERSAL_WASTE
IS_ROHS_COMPLIANT
IS_ITEM_PACKED_IRREGULARLY

HAS_DISPLAY_READY_PKG

MDM Datasource Name

No Datasource.

Code values are of type enumeration, contained in the rulebase xml file.
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Maintaining Validations and Codelists

Validations and codelists can be maintained by updating codelists and adding validations.

Updating Codelists

Certain attribute values are from a list of values only, called the code list.

Values not in the list are not accepted. In MDM, code lists are implemented using a
rulebase and in most cases, populated using a predefined datasource created for the
tibcocim/tadmin (enterprise/user) super user.

If datapool has released an update to the code list, first establish whether the code list
was implemented using a datasource or enumeration.

Updating a Codelist Implemented Using Datasource

Procedure

1.

S o

Find the name of the datasource used for the code list. See MDM Implementation of
1WordSync Codelist.

Create a CSV file of the updated codelist.
Log in to the super user enterprise.

Click Item Data > Data Sources.

Modify the datasource as obtained in step 1.

Expand the Attribute tab on the Data Source Modify page. Ensure the attribute name
in the datasource definition on the Ul and the CSV file’s (created in step 2) header
are the same.

Provide the CSV file created in step 2 to the File to Upload field.
Click Save and Upload.

Check the Event Log to ensure the event completes successfully, and all rows of the
CSV file import successfully.
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Updating a Codelist Implemented Using Enumeration

Procedure

1. Edit the $MQ_COMMON_DIR/standard/rulebase/_XX_mastercatalog_validation.xml
file. Here XX is the name of datapool for which you want to update the code list.

2. Find the name of the MDM attribute for which the enumeration is defined.

3. In the validation file, search for the constraint with the attribute name. For example,
to update the code list for MATERIAL_WEIGHT_UOM for 1WorldSync, update the
following constraint in the _1sync_mastercatalog_validation.xml validation file.

<constraint>
<name>Drop down for MATERIAL_WEIGHT_UOM</name>
<description>Valid value list for MATERIAL_WEIGHT_UOM</description>
<usefor>
<var>MATERIAL_WEIGHT_UOM</var>
</usefor>
<action>
<select novalue="default">
<enum header="yes" col="2">
<const type="string">UOM<sep/>Description</const>
<const type="string'">0ON<sep/>0Ounces per square yard</const>
<const type="string'">GM<sep/>Grams per square meter</const>
</enum>
</select>
</action>
</constraint>

For more details on rulebase constraints, refer to the TIBCO MDM Studio Rulebase Designer
guide.

Updating Validations

You can add a new validation by adding a new constraint with the new attribute name in
the relevant rulebase.

Example

New Attribute to Add
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Consider a new mandatory attribute Target Region to be added to 1WorldSync. And
presume that TARGET_REGION is the attribute name added to both the 1WorldSync
catalog format and TIBCO format.

Files to Add Constraint to

The constraint should be added to both the files listed below, both in the $MQ_COMMON_
DIR/standard/rulebase folder.

_1lsync_mastercatalog_catalogvalidation.xml_lsync_catalogvalidation.xml

Constraint to Add

<constraint>
<name>Mandatory validation for TARGET_REGION </name>
<description>This attribute 1is mandatory.</description>
<usefor>
<var> TARGET_REGION </var>
</usefor>
<action>
<check>
<explanation>This attribute is mandatory.</explanation>
<defined>
<var />
</defined>
</check>
</action>
</constraint>
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Message Choreography

Message choreography, in this context, refers to the information flow between a specific
datapool (1WorldSync for instance) and the GS1 Global Registry.

GDSN supports trading partners to use the (certified) datapool of their choice to
synchronize data with other trading partners in GDSN. GDSN certified datapools help in
continued synchronization of data, and registered trading partners are assured of updated
and accurate data in their systems.

MDM Message Choreography for 1WorldSync

MDM currently supports 1WorldSync datapool. For MDM to work with this datapool, some
specific changes are required.

Validation takes place in 2 instances: on the record ID when entering the records and
when synchronizing data. GS1 and 1WorldSync specify certain rules which must be
followed to ensure that the quality of data received is correct.
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1WorldSync Attribute Mapping

o Note: In the following table, "Sync Profile Attribute" refers to the 1WorldSync Output map attribute. Sync is the abbreviated form of Synchronization.

The following table lists how attributes in 1WorldSync map to attributes in MDM.

1WorldSync Attribute Mapping

1WorldSync Attribute MDM Data Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message
Type

Global Trade Item Number String GTIN GTIN os:envelope/catalogueRequest/
document/item/gtin

Information Provider String INFORMATION_PROVIDER INFORMATION_PROVIDER_ID os:envelope/catalogueRequest/
document/item/information
ProviderGLN

Effective Date Date TDC_PRODUCTION_DATE TDC_PRODUCTION_DATE os:envelope/catalogueRequest/

document/item/effectiveDate

GTIN Name String GTIN_NAME GTIN_NAME os:envelope/catalogueRequest/
document/item/globalAttributes/
gtinName
NA String LANGUAGECODE DESCLANGUAGE "This is a common attribute, which is being used in many elements of the

1WorldSync message, for example:

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/productDescription
[@lang]; os:envelope/catalogue
Request/document/item/
targetMarketAttributes/
shortDescription[@lang]"

Product Type String PRODUCT_TYPE UOM os:envelope/catalogueRequest/
document/item/globalAttributes/
productType

Brand Name String BRAND_NAME ITEM_BRAND_NAME os:envelope/catalogueRequest/
document/item/globalAttributes/
brandName

Brand Owner GLN String OWNING_ORGANIZATION_GLN  BRAND_OWNER_ID os:envelope/catalogueRequest/
document/item/globalAttributes/
brandOwnerGLN
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1WorldSync Attribute

Net Content

Net Content UOM

Alternate Item Classification Code

Packaging Type

Qty of Next Level Item(s)

Packaging Information Height

Packaging Information Height UOM

Packaging Information Depth

Packaging Information Depth UOM

Packaging Information Width

MDM Data
Type

Decimal

String

String

String

String

Float

Varchar

Float

Varchar

Float

Sync Profile Attribute

SIZE_METRIC

SIZE_METRIC_UOM

GLOBAL_CLASSIFICATION_

CODE

PACKAGING_TYPE

PACK

PACKAGING_HEIGHT

PACKAGING_HEIGHT _

UuoM

PACKAGING_DEPTH

PACKAGING_DEPTH_UOM

PACKAGING_WIDTH

Repository Attribute

NET_CONTENT_PRIMARY

NET_CONTENT_UOM

UDEXCODE

PACKAGING_TYPE_CODE

UNITS_PER_CONTAINER

PACKAGING_HEIGHT

PACKAGING_HEIGHT _

UOM

PACKAGING_DEPTH

PACKAGING_DEPTH_UOM

PACKAGING_WIDTH

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/globalAttributes/
netContent[@uom]

os:envelope/catalogueRequest/
document/item/globalAttributes/
netContent[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/alternateClassification/
code

os:envelope/catalogueRequest/
document/item/globalAttributes/
packagingInformation/packaging
TypeCode

os:envelope/catalogueRequest/
document/item/globalAttributes/
totalQuantityOfNextLower
TradeItem

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingInformation/
height

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingInformation/
height

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingInformation/
depth

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingInformation/
depth

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingInformation/
width
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1WorldSync Attribute

Packaging Information Width UOM

Inner Pack

Product Form

Base Unit Indicator

Consumer Unit Indicator

Variable Weight Trade Item

Num of Complete Layers Cont in Item/GTIN Pallet Hi

Num of Items in a Complete Layer/GTIN Pallet Ti

Storage/Handling Temp Max

Storage/Handling Temp UOM

Storage/Handling Temp Min

Storage/Handling Temp UOM

MDM Data
Type

Varchar

String

String

Boolean

Boolean

Boolean

Integer

Integer

Decimal

String

Decimal

String

Sync Profile Attribute

PACKAGING_WIDTH_UOM

INNER_PACK

PRODUCT_FORM

BASE_UNIT_INDICATOR

IS_TRADE_ITEM_CONSUMER
UNIT

VARIABLE_WEIGHT_TRADE_
ITEM

HI

TI

STORAGE_HANDL_TEMP_MAX

STORAGE_HANDL_TEMP_MAX_

UOM

STORAGE_HANDL_TEMP_MIN

STORAGE_HANDL_TEMP_MIN_

Repository Attribute

PACKAGING_WIDTH_UOM

UNITS_PER_INNER_
CONTAINER

FORM_DESCRIPTION

BASE_UNIT

CONSUMER_UNIT

VARIABLE_UNIT

HI

TI

STORAGE_HANDLING_TEMP_
MAX

STORAGE_HANDL_TEMP_MAX_

UOM

STORAGE_HANDLING_TEMP_
MIN

STORAGE_HANDL_TEMP_MIN_

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingInformation/
width

os:envelope/catalogueRequest/
document/item/globalAttributes/
innerPack

os:envelope/catalogueRequest/
document/item/globalAttributes/
ProductForm

os:envelope/catalogueRequest/
document/item/globalAttributes/
isBaseUnit

os:envelope/catalogueRequest/
document/item/globalAttributes/
isConsumerUnit

os:envelope/catalogueRequest/
document/item/globalAttributes/
isVariableWeightItem

os:envelope/catalogueRequest/
document/item/globalAttributes/hi

os:envelope/catalogueRequest/
document/item/globalAttributes/ti

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemTemperature
Information/maximumTemperature

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/storageHandling
TempMax [@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemTemperature
Information/minimumTemperature

os:envelope/catalogueRequest/
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1WorldSync Attribute MDM Data Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message
Type
UOM UOM document/item/targetMarket
Attributes/storageHandling
TempMin[@uom]
Own Label/Private Label Boolean OWN_LABEL_PRIVATE_LABEL  PRIVATE_LABEL os:envelope/catalogueRequest/

document/item/globalAttributes/
brandDistributionTradeItemType

Number of Items/Pallet Integer NUM_OF_ITEMS_PER_PALLET = PALLET_QUANTITY os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/numberOfItems
PerPallet

Target Market String TARGET_MARKET TARGET_MARKET_ID os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/targetMarket

Target Market Description String TARGET_MARKET_DESC TARGET_MARKET_DESC os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/targetMarketName

NA String MARKET_GROUP MARKET_GROUP os:envelope/catalogueRequest/
document/publication/
marketGroup

EANUCC Code String EAN_UCC_CODE EAN_UCC_CODE os:envelope/catalogueRequest/

document/item/targetMarket
Attributes/gslTradeItem
IdentificationKey/value

EANUCC Type String EAN_UCC_TYPE EAN_UCC_TYPE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/gslTradeItem
IdentificationKey/code

Manufacturer GLN String MANUFACTURER_GLN null os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/manufacturer/gln

Sub Brand String SUB_BRAND ITEM_SUB_BRAND_NAME os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/subBrand

Functional Name String PROD_NAME PRODUCTNAME os:envelope/catalogueRequest/

document/item/targetMarket
Attributes/functionalName[@lang]
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1WorldSync Attribute

Variant

Country of Origin

Is Private

Primary Delivery Method

Coupon Family Code

Has Batch Number

Net Content Declared

Product Strength

Product Strength UOM

Product Strength Basis

MDM Data
Type

String

String

Boolean

String

Integer

Boolean

Boolean

Decimal

String

Decimal

Sync Profile Attribute

VARIANT

COUNTRY_OF_ORIGIN

IS_PRIVATE

PRIMARY_DELIVERY_METHOD

COUPON_FAMILY_CODE

HAS_BATCH_NUMBER

NET_CONTENT_DEC_

INDICATED

PROD_STRENGTH

PROD_STRENGTH_UOM

PROD_STRENGTH_BASIS

Repository Attribute

VARIANT

COUNTRYOFORIGINCODE

PRIVATE

PRIMARY_DELIVERY_METHOD

COUPON_FAMILY_CODE

HAS_BATCH_NUMBER

NET_CONTENT_DEC_

INDICATED

PROD_STRENGTH

PROD_STRENGTH_UOM

PROD_STRENGTH_BASIS

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@nhame="variants']/row/attr
QualMany[@name="variant]/
value

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/countryOfOrigin/
countryCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/isPrivate

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/distributionDetails/
distributionMethodCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/couponFamilyCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/hasBatchNumber

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/isNetContentDeclaration

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonFoodIngredient/
ingredientStrength/ingredient
Strength

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/productStrength[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket

Attributes/nonFoodIngredient/
ingredientStrength/ingredient
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1WorldSync Attribute

Product Strength Basis UOM

Product Size Code

Product Size Code Maintenance Agency

Product Description

Product Color Description

Min Product Lifespan from Arrival

Additional Description

Order Sizing Factor

Lead Time

Order Quantity Multiple

MDM Data
Type

String

String

String

String

String

Integer

String

String

Integer

Integer

Sync Profile Attribute

PROD_STRENGTH_BASIS_UOM

PROD_SIZE_CODE

PROD_SIZE_CODE_MAINT_
AGENCY

PROD_DESC

PROD_COLOR_DESC

MIN_PROD_LIFE_SPAN

ADDITIONAL_DESCRIPTION

ORDER_SIZING_FACTOR

LEAD_TIME

ORDER_QUANTITY_MULTIPLE

Repository Attribute

PROD_STRENGTH_BASIS_UOM

PROD_SIZE_CODE

SIZE_CODE_LIST_AGENCY

SHORTDESC

PROD_COLOR_DESC

LIFESPAN_FROM_ARRIVAL_
MIN

ADDITIONAL_DESCRIPTION

ORDER_SIZING_FACTOR

LEADTIME

ORDER_INCREMENT

Xpath in 1WorldSync message

StrengthBasiis

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/productStrength
Basis[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/productSize/code

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/productSize/
maintenanceAgency

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/productDescription
[elang]; os:envelope/catalogue
Request/document/item/
targetMarketAttributes/
shortDescription[@lang]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/color/description

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/minimumTradeIltem
LifespanFromArrival

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/additionalDescription

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/orderSizingFactor

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/distributionDetails/
orderinglLeadTime

os:envelope/catalogueRequest/
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1WorldSync Attribute

Min Order Quantity

Max Order Quantity

Start Availability Date

End Availability Date

First Ship Date

Last Ship Date

Height

Height UOM

Width

Width UOM

Depth

MDM Data
Type

Integer

Integer

Date

Date

Date

Date

Decimal

String

Decimal

String

Decimal

Sync Profile Attribute

MIN_ORDER_QUANTITY

MAX_ORDER_QUANTITY

START_AVAILABILITY_DATE

END_AVAILABILITY_DATE

FIRST_SHIP_DATE

LAST_SHIP_DATE

HEIGHT

HEIGHT_UOM

WIDTH

WIDTH_UOM

DEPTH

Repository Attribute

MINIMUMORDER

MAXIMUMORDER

START_AVAILABILITY_DATE

END_AVAILABILITY_DATE

FIRST_SHIP_DATE

LAST_SHIP_DATE

PRODUCTHEIGHT

HEIGHT_UOM

PRODUCTWIDTH

WIDTH_UOM

PRODUCTDEPTH

Xpath in 1WorldSync message

document/item/targetMarket
Attributes/orderQuantityMultiple

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/minimumOrderQuantity

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/maximumOrderQuantity

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/startAvailabilityDate

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/endAvailabilityDate

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/firstShipDate

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/lastShipDate

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/height

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/height[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/width

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/width[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/depth
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1WorldSync Attribute

Depth UOM

Non GTIN Pallet Height

Non GTIN Pallet Height UOM

Diameter

Diameter UOM

Drained Weight

Drained Weight UOM

Gross Weight

Gross Weight UOM

Non GTIN Pallet Gross Weight

Non GTIN Pallet Gross Weight UOM

Net Weight

MDM Data
Type

String

Decimal

String

Decimal

String

Decimal

String

Decimal

String

Decimal

String

Decimal

Sync Profile Attribute

DEPTH_UOM

NGTIN_PL_HEIGHT

NGTIN_PL_HEIGHT_UOM

DIAMETER

DIAMETER_UOM

DRAINED_WEIGHT

DRAINED_WEIGHT_UOM

GROSS_WEIGHT

GROSS_WEIGHT_UOM

NGTIN_PL_GR_WEIGHT

NGTIN_PL_GR_WEIGHT_UOM

NET_WEIGHT

Repository Attribute

DEPTH_UOM

PACKAGEDHEIGHT

NGTIN_PL_HETIGHT_UOM

DIAMETER

DIAMETER_UOM

DRAINED_WEIGHT

DRAINED_WEIGHT_UOM

GROSSWEIGHT

GROSS_WETIGHT_UOM

NGTIN_PL_GR_WEIGHT

NGTIN_PL_GR_WEIGHT_UOM

NETWEIGHT

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/depth[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonGTINPalletHeight

os:envelope/catalogueRequest/
document/item/targetMarket

Attributes/nonGTINPalletHeight[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/diameter

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/diameter[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/drainedwWeight

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/drainedweight[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/grossWeight

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/grossWeight[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonGTINPallet
GrossWeight

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonGTINPallet
GrossWeight[@uom]

os:envelope/catalogueRequest/
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1WorldSync Attribute

Net Weight UOM

Packaging Material Composition

Packaging Material Composition UOM

Peg Horizontal

Peg Horizontal UOM

Peg Vertical

Peg Vertical UOM

Volume

Volume UOM

Percentage of Alcohol per Volume

MDM Data
Type

String

String

String

Decimal

String

Decimal

String

Decimal

String

Decimal

Sync Profile Attribute

NET_WEIGHT_UOM

PACKAGING_WEIGHT

PACKAGING_WEIGHT_UOM

PEG_HORIZONTAL

PEG_HORIZONTAL_UOM

PEG_VERTICAL

PEG_VERTICAL_UOM

VOLUME

VOLUME_UOM

PERCENT_ALCOHOL_PER_VOL

Repository Attribute

NET_WEIGHT_UOM

PACKAGING_WEIGHT

PACKAGING_WEIGHT_UOM

PEG_HORIZONTAL

PEG_HORIZONTAL_UOM

PEG_VERTICAL

PEG_VERTICAL_UOM

VOLUME

VOLUME_UOM

PERCENT_ALCOHOL

Xpath in 1WorldSync message

document/item/targetMarket
Attributes/netWeight

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/netWeight[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMaterial
[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMaterial
[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/pegMeasurements/
pegHorizontal

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/pegMeasurements/
pegHorizontal[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/pegMeasurements/
pegVertical

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/pegMeasurements/
pegVertical[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/volume

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/volume[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
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1WorldSync Attribute

Packaging Material Code

Product Marked with Ingredients

Product Marked Recyclable

Packaging Marked Returnable

Dispatch Unit Indicator

Invoice Unit Indicator

Ordering Unit Indicator

Handling Instruction Code

Max Stacking Weight

MDM Data
Type

String

Boolean

Boolean

Boolean

Boolean

Boolean

Boolean

String

Decimal

Sync Profile Attribute

PACKAGING_MATERIAL_CODE

PROD_MARKEDWITH_
INGREDIENTS

PROD_MARKED_RECYCLABLE

PACKAGE _MARKED_
RETURNABLE

DISPATCH_UNIT_INDICATOR

INVOICE_UNIT_INDICATOR

ORDERING_UNIT_INDICATOR

PROD_HANDLING_
INSTRUCTION

MAX_ADM_STACKING_WEIGHT

Repository Attribute

PKG_MATERIAL_CODE

WITH_INGREDIENTS

PROD_MARKED_RECYCLABLE

PACKAGE _MARKED_
RETURNABLE

DESPATCH_UNIT

INVOICE_UNIT

ORDERING_UNIT

SPECTAL_HANDLING_CODE

STACKING_WEIGHT_MAX

Xpath in 1WorldSync message

Attributes/percentageOf
AlcoholPerVolume

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMaterial/
packagingInformation/packaging
Material/packagingMaterial
TypeCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/productMarked
WithIngredients

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/productMarked
Recyclable

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMarked
Returnable

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/isDispatchunit

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/isInvoiceUnit

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/isOrderableUnit

os:envelope/catalogueRequest/
document/item/targetMarket

Attributes/handlingInstructions/
handlingInstructionCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemStacking/
stackingWeightMaximum
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1WorldSync Attribute MDM Data Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message
Type
Max Stacking Weight UOM String MAX_ADM_STACKING_ MAX_ADM_STACKING_ os:envelope/catalogueRequest/
WEIGHT_UOM WEIGHT_UOM document/item/targetMarket
Attributes/maximumStacking
Weight[@uom]
Stacking Factor Integer STACKING_FACTOR STACKING_FACTOR os:envelope/catalogueRequest/

document/item/targetMarket
Attributes/tradeItemStacking/
stackingFactor

Pallet Code String PALLET_CODE PALLET_TYPE_CODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingInformation/
platformTypeCode

Pallet Terms and Conditions String PALLET_HANDL_ONEWAY _ PALLET_HANDL_ONEWAY _ os:envelope/catalogueRequest/
REUSE REUSE document/item/targetMarket
Attributes/packagingInformation/
platformTermsAnd
ConditionsCode

Dangerous Goods Hazardous Code String HAZARD_CODE HAZMAT_CODE1 os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/hazardousMaterial/
dangerousGoods/transportation
Classification/regulated
TransportationMode/hazardous
InformationHeader/hazardous
InformationDetail/dangerous
GoodsHazardousCode

Dangerous Goods Class Code String HAZMAT _CLASS_CODE HAZMAT_CLASSCODE1 os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/hazardousMaterial/
dangerousGoods/transportation
Classification/regulated
TransportationMode/hazardous
InformationHeader/hazardous
InformationDetail/classOf

DangerousGoods
Dangerous Goods Regulation Code String HAZARD_TYPE_CLASS_ HAZARD_TYPE_CLASS_ os:envelope/catalogueRequest/
SYSTEM SYSTEM document/item/targetMarket

Attributes/hazardousMaterial/
transportationClassification/
regulatedTransportationMode/
hazardousInformationHeader/
dangerousGoods
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1WorldSync Attribute MDM Data Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message
Type
RegulationCode
U.N. Dangerous Goods Number String DANGEROUS_GOODS_SUB_ID DANGEROUS_GOODS_HAZARD_  os:envelope/catalogueRequest/
CODE document/item/targetMarket

Attributes/hazardousMaterial/
dangerousGoods/transportation
Classification/regulated
TransportationMode/hazardous
InformationHeader/hazardous
InformationDetail/unitedNations

DangerousGoodsNumber
Dangerous Goods Packing Group String DANGEROUS_GOODS_PACK_ DANGEROUS_GOODS_PACK _ os:envelope/catalogueRequest/
GROUP GROUP document/item/targetMarket

Attributes/hazardousMaterial/
dangerousGoods/transportation
Classification/regulated
TransportationMode/
hazardousInformationHeader/
hazardousInformationDetail/
dangerousGoodsPackingGroup

Dangerous Goods Shipping Name String DANGEROUS_GOODS_SHIP_ DANGEROUS_GOODS_SHIP_ os:envelope/catalogueRequest/
NAME NAME document/item/targetMarket

Attributes/hazardousMaterial/
dangerousGoods/transportation
Classification/regulated
TransportationMode/
hazardousInformationHeader/
hazardousInformationDetail/
dangerousGoodsShippingName

Dangerous Goods Technical Name String DANGEROUS_GOODS_TECH_ DANGEROUS_GOODS_TECH_ os:envelope/catalogueRequest/
NAME NAME document/item/targetMarket

Attributes/hazardousMaterial/
dangerousGoods/transportation
Classification/regulated
TransportationMode/
hazardousInformationHeader/
hazardousInformationDetail/
dangerousGoodsTechnicalName

Flash Point Temperature Decimal FLASHPOINT_TEMP FLASHPOINT_TEMP1 os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/hazardousMaterial/
transportationClassification/
regulatedTransportationMode/
hazardousInformationHeader/
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1WorldSync Attribute

Flash Point Temperature UOM

Hazmat Special Instructions

Trade Item Group Code

Trade Item Group Description

Pricing On Product

Material Safety Data Sheet Number

Number of Layers Per Pallet/Non GTIN Pallet Hi

Number of Trade Items Per Pallet Layer/Non GTIN Pallet Ti

Alternate Item Classification Scheme

MDM Data
Type

String

String

String

String

Boolean

String

Integer

Integer

String

Sync Profile Attribute

FLASHPOINT_TEMP_UOM

HAZMAT_SPECTAL _
INSTRUCTIONS

TRADEITEM_GROUP_CODE

TRADEITEM_GROUP_DESC

PRICING_ON_PRODUCT

MAT_SAFETY_DATASHEET_
NUM

N_GTIN_PALLET_HI

N_GTIN_PALLET_TI

CLASSIFICATION_SCHEME

Repository Attribute

FLASHPOINT_UNITS1

HAZMAT_SPECIAL_

INSTRUCTIONS

TRADEITEM_GROUP_CODE

TRADEITEM_GROUP_DESC

PRICE_ON_PACKAGE

MAT_SAFETY_DATASHEET_

NUM

N_GTIN_PALLET_HI

N_GTIN_PALLET_TI

CLASSIFICATIONSCHEME

Xpath in 1WorldSync message

flashPointTemperature

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/transportation
Classification/hazardous
InformationHeader/flashPoint
Temperature

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/hazardousMaterial/
dangerousGoods/
specialInstructions

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemGroup
Identification/tradeIltemGroup
IdentificationCodeReference

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemGroup
Identification/tradeItemGroup
IdentificationCodeDescription

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/pricingOnProduct

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/safetyDataSheet
Information/sDSSheetNumber

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonGTINPalletH1i

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonGTINPalletTi

os:envelope/catalogueRequest/
document/item/targetMarket

Attributes/alternateClassification/scheme
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1WorldSync Attribute

Color

Color Code Maintenance Agency

List Price

List Price Currency

List Price Basis Per Unit

List Price Basis Per Unit UOM

Suggested Retail Price

Suggested Retail Price Currency

Suggested Retail Price Basis Per Unit

Suggested Retail Price Basis Per Unit UOM

MDM Data
Type

String

String

Decimal

String

Decimal

String

Amount

String

Decimal

String

Sync Profile Attribute

COLOR

COLOR_CODE_MNT_AGENCY

LIST_PRICE

LIST_PRICE_CURRENCY

LIST_PRICE_BASISPERUNIT

LIST_PRICE_
BASISPERUNIT_UOM

RECOMMEND_SALES_PRICE

RECOMMEND_PRICE_
CURRENCY

RECOMMEND_PRICE_PERUNIT

RECOMMEND_PRICE_
PERUNIT_UOM

Repository Attribute

COLOR

COLOR_CODE_AGENCY

LIST_PRICE

PRICEUOMCODE

LIST_PRICE_BASIS_PER_
UNIT

LIST_PRICE_
BASISPERUNIT_UOM

SUGGESTED_RETAIL_PRICE

RECOMMEND_PRICE_
CURRENCY

RECOMMEND_PRICE_PERUNIT

RECOMMEND_PRICE_
PERUNIT_UOM

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/color

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/color/agency

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/cataloguePrice/price

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/cataloguePrice/price
[@currency]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/cataloguePrice/
basisPerUnit

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/cataloguePrice/
basisPerUnit[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/suggestedRetail/
price[@currency]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/suggestedRetail/
price[@currency]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/suggestedRetail/
basisPerUnit[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/suggestedRetail/
basisPerUnit[@uom]
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1WorldSync Attribute

Right of Return for Non-Sold Trade Item

Tax Rate

Tax (Rate) Type Code

Alternate Item Number

Alternate Item Identification Maintenance Agency

Replaced by GTIN

Organic Trade Item Code

Degree of Original Wort

Fat Content UOM

Fat Content Basis of Measure UOM

MDM Data
Type

Boolean

Decimal

String

String

String

String

String

String

String

String

Sync Profile Attribute

RIGHT_RETURN_NSOLD_
TRADE

TAX_RATE

TAX_TYPE

ALTERNATE_ITEM_ID

ALTERNATE_ITEMID_MNT_

AGENCY

REPLACED_ITEM_GTIN

ORGANIC

DEGREE_OF_ORIGINAL_WORT

FAT_CONTENT_UOM

FAT_CONTENT_BASIS_UOM

Repository Attribute

RIGHT_RETURN_NSOLD_
TRADE

TAX_RATE

TAX_TYPE_CODE

ALTERNATE_ID

ALTERNATE_ITEMID_MNT_

AGENCY

REPLACED_BY_GTIN

ORGANIC_CODE

DEGREE_OF_ORIGINAL_WORT

FAT_CONTENT_UOM

FAT_CONTENT_BASIS_UOM

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/rightOfReturn
ForNonSoldTradeItem

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxRate/rate

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxRate/typeCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/alternateltem
Identification/id

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/alternateltem
Identification/agency

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/referencedTradeItem/
referencedTradeItemGTIN/
referencedTradeItem/referenced
TradeItemTypeCode=

REPLACED_BY

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/organic/organicClaim/
organicTradeItemCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/degree0fOriginalWort

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/fatContent[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/fatContentBasisOf
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1WorldSync Attribute

Units Per Consumer Unit

Total Units per Case

Pricing Item Indicator

NA

First Order Date

Last Order Date

Global Classification Code

Pricing Pack

List Price Effective Start Date

List Price Effective End Date

Special Item Code

MDM Data
Type

Integer

Integer

Boolean

Date

Date

Date

String

Decimal

Date

Date

String

Sync Profile Attribute

UNITS_PER_CONSUMER_UNIT

TOTAL_UNITS_PER_CASE

PRICING_ITEM_INDICATOR

PUBLISH_DATE

FIRST_ORDER_DATE

LAST_ORDER_DATE

ALT_ITEM_CLASSN_CODE

PRICING_PACK

LIST_PRICE_DATE_START

LIST_PRICE_DATE_END

SPECIAL_ITEM_CODE

Repository Attribute

UNITS_PER_CONSUMER_UNIT

UNITS_PER_CASE

PRICING_ITEM

PUBLISH_DATE

FIRST_ORDER_DATE

LAST_ORDER_DATE

ADDITIONAL_CLASS_CAT_

CODE

PRICING_PACK

LIST_PRICE_DATE_START

LIST_PRICE_DATE_END

SPECIAL_ITEM_CODE

Xpath in 1WorldSync message

Measure[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/unitsPerConsumerUnit

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/totalUnitsPerCase

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/pricingItemIndicator

os:envelope/catalogueRequest/
document/publication/publishDate

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/firstOrderDate

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/lastOrderDate

os:envelope/catalogueRequest/
document/item/globalAttributes/
globalClassificationCategory/code

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/pricingPack

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/cataloguePrice/
effectiveStartDate

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/cataloguePrice/
effectiveEndDate

os:envelope/catalogueRequest/
document/item/globalAttributes/
marketingInformation/
specialIltemCode
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1WorldSync Attribute

Feature Benefit

Is Raw Material Irradiated

Is Ingredient Irradiated

Peg Hole Number

Barcode Type

Country of Assembly

Variable Trade Item Type

Campaign End Date

Campaign Name

Campaign Start Date

Marketing Message

MDM Data
Type

String

String

String

Integer

String

String

String

Date

String

Date

String

Sync Profile Attribute

FEATURED_PRODUCT_DESC

RAW_MATERIAL_IRRADIATED

INGREDIENT_TRRADIATED

PEG_HOLE_NUMBER

BAR_CODE_TYPE

TRADE_ITEM_COUNTRY_
ASSEMBLY

VARIABLE_TRADE_ITEM_

TYPE

CAMPAIGN_END_DATE

CAMPAIGN_NAME

CAMPAIGN_START_DATE

TRADE_ITEM_MARKETING_
MESSAGE

Repository Attribute

FEATURED_PRODUCT_DESC

RAW_MATERIAL_IRRADIATED

INGREDIENT_TRRADIATED

PEG_HOLE_NUMBER

BAR_CODE_TYPE

TRADE_ITEM_COUNTRY_
ASSEMBLY

VARIABLE_TRADE_TITEM_

TYPE

CAMPAIGN_END_DATE

CAMPATIGN_NAME

CAMPAIGN_START_DATE

TRADE_ITEM_MARKETING_
MESSAGE

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemFeatureBenefit

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/isRawMateriallrradiated

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/isIngredientIrradiated

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/pegMeasurements/
pegHoleNumber

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/dataCarrierTypeCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemCountry
OfAssembly

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/variableTradeItemType

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/campaignEndDate

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/productActivityDetails/
countryOfActivity/countryCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/campaignStartDate

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeltem
MarketingMessage
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1WorldSync Attribute

Season Calendar Year

Season Name

Season Parameter

Seasonal Start Date

Seasonal End Date

Target Consumer Age

Target Consumer Gender

Feature Benefit

Compliance Regulation Code

Import Classification Type

MDM Data
Type

Integer

String

String

Date

Date

String

String

String

String

String

Sync Profile Attribute

SEASON_CALENDAR_YEAR

SEASON_NAME

SEASON_PARAMETER

SEASON_AVAIL_START_DATE

SEASON_AVAIL_END_DATE

TARGET_CONSUMER_AGE

TARGET_CONSUMER_GENDER

TRADE_ITEM_FEATURE_

BENEFIT

CLASS_COMPLIANCE_REG_

CODE

IMPORT_CLASS_TYPE

Repository Attribute

SEASON_CALENDAR_YEAR

SEASON_NAME

SEASON_PARAMETER

SEASON_AVAIL_START_DATE

SEASON_AVAIL_END_DATE

TARGET_CONSUMER_AGE

TARGET_CONSUMER_GENDER

TRADE_ITEM_FEATURE_

BENEFIT

CLASS_COMPLIANCE_REG_

CODE

IMPORT_CLASS_TYPE

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/season/
seasonCalendarYear

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/season/seasonName

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/season/
seasonParameter

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/season/seasonal
AvailabilityStartDate

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/season/seasonal
AvailabilityEndDate

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/targetConsumerAge

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/targetConsumerGender

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeltemFeatureBenefit

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/regulatoryInformation/
regulationTypeCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/importIdentification/
importClassification/import
ClassificationTypeCode
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1WorldSync Attribute MDM Data Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message
Type
Import Classification Value String IMPORT_CLASS_VALUE IMPORT_CLASS_VALUE os:envelope/catalogueRequest/

document/item/targetMarket
Attributes/importClassification/
importClassificationValue

Max DC Delivery Temp Decimal DELIVERY_DC_TEMP_MAX DELIVERY_DC_TEMP_MAX os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeltemTemperature
Information/maximumTemperature

Max DC Delivery Temp UOM String DELIVERY_DC_TEMP_UOM DELIVERY_DC_TEMP_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/deliveryToDC
TemperatureMaximum[@uom]

Max Market Delivery Temp Decimal DELIVERY_MARKET_TEMP_ DELIVERY_MARKET_TEMP_ os:envelope/catalogueRequest/
MAX MAX document/item/targetMarket
Attributes/tradeItemTemperature
Information/maximumTemperature

Max Market Delivery Temp UOM String DELIVERY_MARKET_TEMP_ DELIVERY_MARKET_TEMP_ os:envelope/catalogueRequest/
UOM UOM document/item/targetMarket
Attributes/deliveryToMarket
TemperatureMaximum[@uom]

Max Storage Humidity Decimal STORAGE_HUMIDITY_MAX STORAGE_HUMIDITY_MAX os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeltemHumidity
Information/maximumHumidity
Percentage

Min DC Delivery Temp Decimal DELIVERY_DC_TEMP_MIN DELIVERY_DC_TEMP_MIN os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemTemperature
Information/minimumTemperature

Min Market Delivery Temp Decimal DELIVERY_MARKET_TEMP_ DELIVERY_MARKET_TEMP_ os:envelope/catalogueRequest/
MIN MIN document/item/targetMarket
Attributes/tradeltemTemperature
Information/minimumTemperature

Min Storage Humidity Decimal STORAGE_HUMIDITY_MIN STORAGE_HUMIDITY_MIN os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemHumidity
Information/minimumHumidity
Percentage
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1WorldSync Attribute

Product Range

Inner Pack

Composition Width

Composition Width UOM

Descriptive Size Dim

Material Code

Material Content

Material Percentage

Material Weight

MDM Data
Type

String

String

Decimal

String

String

String

String

Decimal

Integer

Sync Profile Attribute

PRODUCT _RANGE

QUANTITY_OF_INNER_PACK

TRADE_ITEM_COMPOS_WIDTH

TRADE_ITEM_COMPOS_
WIDTH_UOM

DESCRIPTIVE_SIZE_
DIMENSION

MATERTIAL_CODE

MATERTAL_CONTENT

MATERTIAL_PERCENTAGE

MATERTAL_WEIGHT

Repository Attribute

PRODUCT _RANGE

QUANTITY_OF_INNER_PACK

TRADE_ITEM_COMPOS_WIDTH

TRADE_ITEM_COMPOS_
WIDTH_UOM

DESCRIPTIVE_SIZE_
DIMENSION

MATERTAL_CODE

MATERTAL_CONTENT

MATERTAL_PERCENTAGE

MATERTAL_WEIGHT

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/productRange

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/innerPack

os:envelope/catalogueRequest/
document/item/globalAttributes/
tradeItemCompositionWidth

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemComposition
Width[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonPackageDimensions/
nonPackageSizeDimension/
nonPackagedSizeDimension/
descriptiveSizeDimension

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/materialComposition/
textileMaterial/textileMaterial
Composition/materialCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/materialComposition/
materialComposition/
materialContent

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/materialComposition/
textileMaterial/textileMaterial
Composition/materialPercentage

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/textileMaterial/
textileMaterialComposition/
materialWeight
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1WorldSync Attribute

Material Weight UOM

Organic Claim Agency

Size Dimension

Size Dimension UOM

Size Group

Size System

Size Type

Thread Count

Consumer Availability Date

MDM Data
Type

String

String

Decimal

String

String

String

String

String

Date

Sync Profile Attribute

MATERTAL_WEIGHT_UOM

ORGANIC_CLAIM_AGENCY

SIZE_DIMENSION

SIZE_DIMENSION_UOM

SIZE_GROUP

SIZE_SYSTEM

SIZE_TYPE

THREAD_COUNT

CONSUMER_UNIT_AVAIL_
DATE

Repository Attribute

MATERTAL_WEIGHT_UOM

ORGANIC_CLAIM_AGENCY

SIZE_DIMENSION

SIZE_DIMENSION_UOM

SIZE_GROUP

SIZE_SYSTEM

SIZE_TYPE

THREAD_COUNT

CONSUMER_UNIT_AVAIL_
DATE

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/materialWeight[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/organic/organicClaim/
organicClaimAgencyCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonPackageDimensions/
nonPackageSizeDimension/non
PackagedSizeDimension/
sizeDimension

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonPackageDimensions/
nonPackageSizeDimension/size
Dimension[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonPackageDimensions/
sizeGroupCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonPackageDimensions/
nonPackageSizeDimension/size
SystemCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonPackageDimensions/
nonPackageSizeDimension/size
TypeCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/textileMaterial/
textileMaterialComposition/
materialThreadCount

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/consumerAvailability
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1WorldSync Attribute

End Date of Exclusivity

End Date of Max Buying Qty

End Date of Min Buying Qty

First Delivery Date

Start Date of Max Buying Qty

Start Date of Min Buying Qty

Deposit Value End Date

Deposit Value Start Date

Offer On Pack

MDM Data
Type

Date

Date

Date

Date

Date

Date

Date

Date

String

Sync Profile Attribute

END_DATE_OF_EXCLUSIVITY

END_DATE_MAX_BUYING

END_DATE_MIN_BUYING
FIRST_DELIVERY_DATE_
TIME
START_DATE_MAX_BUYING_

QTY

START_DATE_MIN_BUYING_
QTY

DEPOSIT_VAL_END_DATE

DEPOSIT_VAL_EFF_DATE

OFFER_ON_PACK

Repository Attribute

END_DATE_OF_EXCLUSIVITY

END_DATE_MAX_BUYING

END_DATE_MIN_BUYING
FIRST_DELIVERY_DATE_
TIME
START_DATE_MAX_BUYING_

QTY

START_DATE_MIN_BUYING_
QTY

DEPOSIT_VAL_END_DATE

DEPOSIT_VAL_EFF_DATE

OFFER_ON_PACK

Xpath in 1WorldSync message

DateTime

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/endDate
TimeOfExclusivity

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/endDateMaximum
BuyingQuantity

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/endDateMinimumvBuyingQuantity

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/firstDeliveryDateTime

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/startDateMaximum
BuyingQuantity

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/startDateMinimum
BuyingQuantity

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMaterial/
packagingInformation/package
deposit/returnablePackage
DepositAmount

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMaterial/
packagingInformation/package
deposit/depositValueEffectiveDate

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/offerOnPack
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1WorldSync Attribute

Package Marks Diet Allergen

Package Marks Environment

Package Marks Ethical

Package Marks Free From

Packaging Marked Expiration Date Type

Packaging Marked Recyclable Scheme

Returnable Package Deposit Amount

Returnable Package Deposit Code

Security Tag Location

MDM Data
Type

String

String

String

String

String

String

Amount

String

String

Sync Profile Attribute

PACKAGE_MARKS_DIET_
ALLERGEN

PACKAGE _MARKS _
ENVIRONMENT

PACKAGE _MARKS_ETHICAL

PACKAGE_MARKS_FREE_FROM

PKG_MARKED_EXPIRE_DATE_
TYPE

PKG_MARKED_RECYCLE_
SCHEME

RETURNABLE_PKG_DEPOSIT
AMT

RETURNABLE_PKG_DEPOSIT_
CODE

SECURITY_TAG_LOCATION

Repository Attribute

PACKAGE_MARKS_DIET_
ALLERGEN

PACKAGE _MARKS _
ENVIRONMENT

PACKAGE_MARKS_ETHICAL

PACKAGE_MARKS_FREE_FROM

PKG_MARKED_EXPIRE_DATE_
TYPE

PKG_MARKED_RECYCLE_
SCHEME

RETURNABLE_PKG_DEPOSIT
AMT

RETURNABLE_PKG_DEPOSIT_
CODE

SECURITY_TAG_LOCATION

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packageMarks
DietAllergen

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packaging
MarkedLabelAccreditationCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packaging
MarkedLabelAccreditationCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packageMarksFreeFrom

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingDate/
tradeItemDateOnPackaging
TypeCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMarked
RecyclableScheme

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMaterial/
packagingInformation/package
deposit/returnablePackage
DepositAmount

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMaterial/
packagingInformation/package
deposit/returnablePackage
DepositAmount

os:envelope/catalogueRequest/
document/item/targetMarket

Attributes/securityTagInformation/

securityTaglocationCode
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1WorldSync Attribute

Security Tag Type

Terms or Conditions Code

Generic Ingredient

Generic Ingredient Strength

Generic Ingredient Strength UOM

Goods Pick Up Lead Time

Goods Pick Up Lead Time UOM

Invoice Name

Is Size Based Pricing

Is Trade Item Reorderable

MDM Data
Type

String

Varchar

String

String

String

Decimal

String

String

Boolean

Boolean

Sync Profile Attribute

SECURITY_TAG_TYPE

PACKAGING_TERMS_
CONDITIONS

GENERIC_INGREDIENT

GENERIC_INGREDIENT_
STRENGTH

GENERIC_INGREDIENT_STR_
UOM

GOODS_PICKUP_LEAD_TIME

GOODS_PICKUP_LEAD_TIME_

UOM

INVOICE_NAME

IS_TRADEITEM_SIZE_
BASED_PRIC

IS_REORDERABLE

Repository Attribute

SECURITY_TAG_TYPE

PACKAGING_TERMS_
CONDITIONS

GENERIC_INGREDIENT

GENERIC_INGREDIENT_
STRENGTH

GENERIC_INGREDIENT_STR_
UOM

GOODS_PICKUP_LEAD_TIME

GOODS_PICKUP_LEAD_TIME_

UOM

INVOICE_NAME

IS_TRADEITEM_SIZE_
BASED_PRIC

IS_REORDERABLE

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/securityTagInformation/
securityTagTypeCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMaterial/
packagingInformation/packaging
TermsAndCond-itionsCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonFoodIngredient/
nonFoodIngredientName

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonFoodIngredient/
ingredientStrength/
ingredientStrength

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/genericIngredient
Strength[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/goodsPickUpLeadTime

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/goodsPickUpLeadTime[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/invoiceName

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/isTradeltemSize
BasedPricing

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/isTradeIltemReorderable
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1WorldSync Attribute

Ordering UOM

Selling UOM

Max Buying Quantity

Min Buying Quantity

Price By Measure Type

Price Comparison Measurement

Price Comparison Measurement UOM

Retail Price On Trade Item

Price Comparison Content Type

Suggested Retail Price Effective End Date

MDM Data
Type

String

String

Integer

Integer

String

Decimal

String

Amount

String

Date

Sync Profile Attribute

ORDERING_UOM

SELLING_UOM

AGREED_MAX_BUYING_
QUANTITY

AGREED_MIN_BUYING_
QUANTITY

PRICE_BY_MEASURE_TYPE

PRICE_COMP_MEASUREMENT

PRICE_COMP_UOM

RETAIL_PRICE_ON_ITEM

PRICE_COMP_CONTENT_TYPE

EFFECTIVE_END_DATE

Repository Attribute

ORDERING_UOM

SELLING_UOM

AGREED_MAX_BUYING_
QUANTITY

AGREED_MIN_BUYING_
QUANTITY

PRICE_BY_MEASURE_TYPE

PRICE_COMP_MEASUREMENT

PRICE_COMP_UOM

RETAIL_PRICE_ON_ITEM

PRICE_COMP_CONTENT_TYPE

EFFECTIVE_END_DATE

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/orderingUnitOfMeasure

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/sellingUnitOfMeasure

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/agreedMaximum
BuyingQuantity

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/agreedMinimum
BuyingQuantity

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/priceByMeasureType

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/priceComparison
Measurement

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/priceComparison
Measurement [@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/additionalTradeItem
Price/tradeIltemPrice

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/priceComparison
ContentType

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/suggestedRetail/
effectiveEndDate
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1WorldSync Attribute

Suggested Retail Price Effective Start Date

Tax Amount

Tax Amount Currency

Tax (Rate) Type Agency

Tax (Rate) Type Description

Finish Description

Min Product Lifespan from Production

Retail Price On Trade Item Currency

Returnable Package Deposit Currency

Tax (Amount) Type Description

MDM Data
Type

Date

Amount

String

String

String

String

String

String

String

String

Sync Profile Attribute

EFFECTIVE_START_DATE

TAX_AMOUNT

CURRENCY_CODE

TAX_AGENCY_CODE

TAX_TYPE_DESC

TRADE_ITEM_FINISH_DESC

MINLIFE_SPAN_FROM_
PRODUCTION

RETAIL_PRICE_ON_ITEM_
CURR

RETURN_PKG_DEPOSIT_AMT_
CURR

TAX_AMT_TAX_TYPE_DESC

Repository Attribute

EFFECTIVE_START_DATE

TAX_AMOUNT

CURRENCY_CODE

TAX_AGENCY_CODE

TAX_TYPE_DESC

TRADE_ITEM_FINISH_DESC

MIN_LIFE_SPAN_TIME_OF_
PUB

RETAIL_PRICE_ON_ITEM_
CURR

RETURN_PKG_DEPOSIT_AMT_
CURR

TAX_AMT_TAX_TYPE_DESC

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/suggestedRetail/
effectiveStartDate

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxAmount/duty
FeeTaxInformation/dutyFeeTax/
dutyFeeTaxAmount

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxAmount/currency

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxRate/agencyCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxRate/typeDescription

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeltemFinishDescription

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/minimum
TradeItemLifespanFromProduction

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/retailPriceOn
TradeItem[@currency]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMaterial/
returnablePackageDeposit
Amount[@currency]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxAmount/dutyFee
TaxInformation/dutyFeeTax
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1WorldSync Attribute

Tax (Amount) Type Agency

Tax (Amount) Type Code

Material Agency Code

Is Barcode Symbology Derivable

Lead Time UOM

TM Subdivision

Party Receiving Private Data

GTIN Variation Registry

Manufacturer Name

MDM Data
Type

String

String

String

Boolean

String

String

String

Boolean

String

Sync Profile Attribute

TAX_AMT_TAX_AGENCY_CODE

TAX_AMT_TAX_TYPE_CODE

MATERTAL_AGENCY_CODE

ISBARCODEDERIVABLE

LEADTIMEUOM

TARGET_MARKET _
SUBDIVISION

PARTY_RECEIVING_
PRIVATE_DATA

GTIN_VARIATION_REGISTRY

MANUFACTURER_NAME

Repository Attribute

TAX_AMT_TAX_AGENCY_CODE

TAX_AMT_TAX_TYPE_CODE

MATERTAL_AGENCY_CODE

ISBARCODEDERIVABLE

LEADTIMEUOMCODE

TARGET_MARKET _
SUBDIVISION

PARTY_RECEIVING_
PRIVATE_DATA

GTIN_VARIATION_REGISTRY

MANUFACTURER_NAME

Xpath in 1WorldSync message

TypeDescription

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxAmount/dutyFee
TaxInformation/dutyFeeTax
Agency/AgencyCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxAmount/dutyFee
TaxInformation/dutyFeeTax
TypeCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/materialComposition/
textileMaterial/material
AgencyCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/gslTradeItem
IdentificationKey/isBarcode
SymbologyDer-ivable

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/leadTime[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/targetMarket
SubdivisionCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/partyReceivingP
rivateDataGLN

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/gtinVariationRegistry

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/manufacturer/name
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1WorldSync Attribute

Green Dot Indicator

Order Sizing Factor UOM

GLN Of Ship From Party

Name Of Ship From Party

Uniform Resource ldentifier

Link File Name

File Format Name

File Effective Start Date

File Effective End Date

MDM Data
Type

Boolean

String

String

String

String

String

String

Date

Date

Sync Profile Attribute

GREEN_DOT_INDICATOR

ORDER_SIZING_FACTOR_UOM

SHIP_LOCATION_GLN

SHIP_LOCATION_NAME

URT

FILE_NAME_EXT

FILE_FORMAT_NAME

FILE_EFFECTIVE_START_
DATE

FILE_EFFECTIVE_END_DATE

Repository Attribute

PACKAGE _MARKED_GREEN_
DOT

ORDER_SIZING_FACTOR_UOM

SHIP_LOCATION_GLN

SHIP_LOCATION_NAME

URI

FILE_NAME_EXT

FILE_FORMAT_NAME

FILE_EFFECTIVE_START_
DATE

FILE_EFFECTIVE_END_DATE

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/greenDotIndicator

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/orderSizingFactor[@uom]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/partyInRole/

gln with partyRoleCode = SHIP_FROM

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/partyInRole/

name with partyRoleCode = SHIP_FROM

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@nhame="externalFileLink']/row/
attr[@name="uniformResource
Identifier']

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@nhame="externalFileLink']/row/
attr[@name="'externalFile
LinkFileName']

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@nhame="externalFileLink']/row/
attr[@name="'f1ileFormatName']

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@nhame="externalFileLink']/row/
attr[@name="'fileEffective
StartDateTime']

os:envelope/catalogueRequest/
document/item/targetMarket
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1WorldSync Attribute MDM Data Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message
Type

Attributes/flex/attrGroupMany
[@name="externalFileLink']/row/
attr[@name="'fileEffective
EndDateTime']

Link Content Description String CONTENT_DESC CONTENT_DESC os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroup
Many/row/attrQualMany
[@name="externalFilelLink
ContentDescription']/value

File Format Description String FILE_FORMAT_DESC FILE_FORMAT_DESC os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroup
Many/row/attrQualMany
[@name="fileFormat
Description']/value

Consumer Usage Storage Instructions String STORAGE_INSTRUCTION STORAGE_INSTRUCTION os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrQualMany
[@name="consumerUsage
StorageInstructions']/value

Layer Height Decimal LAYER_HEIGHT LAYER_HEIGHT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrQual
[@name="TlayerHeight']

Layer Height UOM String LAYER_HEIGHT_UOM LAYER_HEIGHT_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrQual
[@name="'TlayerHeight'][@qual]

Type Of Information String TYPE_INFORMATION TYPE_INFORMATION os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@nhame="externalFileLink']/row/attr
[@name="typeOfInformation']

Is Trade Item Packed Irregularly? String IS_ITEM_PACKED_ SHIP_LOCATION_NAME os:envelope/catalogueRequest/
IRREGULARLY document/item/globalAttributes/
isTradeItemPackedIrregularly

I[tem Composition Depth Decimal ITEM_COMPOSITION_DEPTH ITEM_COMPOSITION_DEPTH os:envelope/catalogueRequest/
document/item/globalAttributes/
tradeItemCompositionDepth
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1WorldSync Attribute

I[tem Composition Depth UOM

Package Marks Hygienic

Tax Rate Applicability Code

Tax Amount Applicability Code

Clamp Pressure

Clamp Pressure UOM

Orientation Type

Orientation Preference Sequence

Nesting Direction

MDM Data
Type

Varchar

String

String

String

Decimal

String

String

Integer

String

Sync Profile Attribute

ITEM_COMPOSITION_
DEPTH_UOM

PKG_MARKED_HYGIENIC

TAX_RATE_APPLICABILITY_

CODE

TAX_AMT_APPLICABILITY_

CODE

CLAMP_PRESSURE

CLAMP_PRESSURE_UOM

ORIENTATION_TYPE

ORIENTATION_PREF_SEQ

NESTING_DIRECTION

Repository Attribute

ITEM_COMPOSITION_
DEPTH_UOM

PKG_MARKED_HYGIENIC

TAX_RATE_APPLICABILITY_

CODE

TAX_AMT_APPLICABILITY_

CODE

CLAMP_PRESSURE

CLAMP_PRESSURE_UOM

ORIENTATION_TYPE

ORIENTATION_PREF_SEQ

NESTING_DIRECTION

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/globalAttributes/
tradeItemCompositionDepth/

(Quom

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/packagingMarked
LabelAccreditationCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxRate/taxRate
ApplicabilityCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxAmount/tax
AmountApplicabilityCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrQual
[@name="clampPressure']

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrQual
[@name="clampPressure'][@qual]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@nhame="tradeItemOrientation']
/row/attr[@name="orientation

Type']

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name="tradeltemOrientation']/
row/attr[@name="'orientation
PreferenceSequence']

os:envelope/catalogueRequest/
document/item/targetMarket

Attributes/flex/tradeItemNesting/

nestingTypeCode
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1WorldSync Attribute

Nesting Type

Has Display Ready Packaging?

Electrical Usage Trade Item Classification Agency

Electrical Usage Trade Item Classification Name

Electrical Usage Subclassification Name

Display Dimension Type Code

Dimension Depth

MDM Data
Type

String

String

String

String

String

String

Integer

Sync Profile Attribute

NESTING_TYPE

HAS_DISPLAY_READY_PKG

ELEC_USAGE_CLASS_AGENCY

ELEC_USAGE_CLASS_NAME

ELEC_USAGE_SUBCLASS_
NAME

DISPLAY_DIMENSION_CODE

DISPLAY_DIMENSION_DEPTH

Repository Attribute

NESTING_TYPE

HAS_DISPLAY_READY_PKG

ELEC_USAGE_CLASS_AGENCY

ELEC_USAGE_CLASS_NAME

ELEC_USAGE_SUBCLASS_
NAME

DISPLAY_DIMENSION_CODE

DISPLAY_DIMENSION_DEPTH

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/tradeItemNesting/
nestingDirectionCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attr
[@name="hasDisplayReadyPackaging']

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/physical
ResourceUsageInformation/
physicalResourceUsageTrade
ItemClassification/physical
ResourceUsageClassification
Agency

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/physical
ResourceUsageInformation/
physicalResourceUsageTrade
ItemClassification/physical
ResourceUsageClassificationName

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/physicalResource
UsageInformation/physicalResource
UsageTradeItemClassification/
physicalResourceUsage
SubclassificationAgency

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name="displayDimensions']/
row/attr[@name="'display
DimensionTypeCode']

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name="displayDimensions']/
row/attrQual[@name="dimension
Depth']
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1WorldSync Attribute

Dimension Depth UOM

Dimension Width

Dimension Width UOM

Dimension Height

Dimension Height UOM

Warranty Effective Date Type

Warranty Type

Warranty Constraint

MDM Data
Type

String

Integer

String

Integer

String

String

String

String

Sync Profile Attribute

DISPLAY_DIMENSION_
DEPTH_UOM

DISPLAY_DIMENSION_WIDTH

DISPLAY_DIMENSION_
WIDTH_UOM

DISPLAY_DIMENSION_
HEIGHT

DISPLAY_DIMENSION_
HEIGHT_UOM

WARRANTY_EFF_DATE_TYPE

WARANTY_TYPE

WARRANTY_CONSTRAINT

Repository Attribute

DISPLAY_DIMENSION_
DEPTH_UOM

DISPLAY_DIMENSION_WIDTH

DISPLAY_DIMENSION_
WIDTH_UOM

DISPLAY_DIMENSION_
HEIGHT

DISPLAY_DIMENSION_
HEIGHT_UOM

WARRANTY_EFF_DATE_TYPE

WARANTY_TYPE

WARRANTY_CONSTRAINT

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name="displayDimensions']/
row/attrQual[@name="dimension
Depth'] [@qual]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name="displayDimensions']/
row/attrQual[@name="'dimension
Width']

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name="displayDimensions']/
row/attrQual[@name="dimension
width'][@qual]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name="displayDimensions']/
row/attrQual[@name="'dimension
Height']

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name="displayDimensions']/
row/attrQual[@name="dimension
Height'] [@qual]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/warranty
Information/warranty
EffectiveDateType

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/warranty
Information/warrantyType

os:envelope/catalogueRequest/
document/item/targetMarket
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1WorldSync Attribute

Warranty Period

Warranty Information Description

Is Product A Pesticide?

Is Product Aerosol?

Is Product Chemical Not Intended For Human
Consumption?

Percentage Of Plastic Components Made From a Plant

Based Material

Is Product Subject To A Manufacturer Take Back Program?

Manufacturer Take Back Program Fee

MDM Data
Type

Integer

String

String

String

String

Integer

String

Integer

Sync Profile Attribute

WARRANTY_DURATION

WARRANTY_DESC

CONTAINS_PESTICIDE

CONTAINS_PROPELLANT

CHEMICAL_FOR_HUMAN_
CONSUME

RENEWABLE_PLASTIC_

PERCENT

TAKE_BACK_PROGRAM

TAKE_BACK_PROGRAM_FEE

Repository Attribute

WARRANTY_DURATION

WARRANTY_DESC

CONTAINS_PESTICIDE

CONTAINS_PROPELLANT

CHEMICAL_FOR_HUMAN_
CONSUME

RENEWABLE_PLASTIC_

PERCENT

TAKE_BACK_PROGRAM

TAKE_BACK_PROGRAM_FEE

Xpath in 1WorldSync message

Attributes/flex/warranty
Information/warrantyConditions/
warrantyConstraint

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/warranty
Information/warrantyConditions/
warrantyDuration

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/warranty
Information/warrantyDescription

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/doesTrade
ItemContainPesticide

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attr
[@nhame="1isProductAerosol’]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attr
[@nhame="1isProductChemicalNot
IntendedForHumanConsumption']

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/renewablePlant
BasedPlasticComponentsPercent

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/doesManufacturer
HaveTakeBackProgram

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrQualMany
[@name="manufacturer
TakeBackProgramFee']/value
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1WorldSync Attribute MDM Data Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message
Type
Packaging Marked Recyclable Scheme String PKG_MARKED_RECYCLABLE PKG_MARKED_RECYCLABLE os:envelope/catalogueRequest/

document/item/targetMarket
Attributes/packagingMarked
RecyclableScheme

Trade Item Default Time Limit Of Auto Power Down Date POWER_DOWN_DEF_TIME POWER_DOWN_DEF_TIME os:envelope/catalogueRequest/

Function Value document/-item/targetMarket
Attributes/flex/attr
[@name="tradeItemDefaultTime
LimitOfAutoPowerDown
FunctionValue']

Trade Item Default Time Limit Of Auto Power Down String POWER_DOWN_DEF_TIME_UOM  POWER_DOWN_DEF_TIME_UOM os:envelope/catalogueRequest/

Function UOM document/item/targetMarket
Attributes/flex/attr
[@name="tradeIltemDefaultTime
LimitOfAutoPowerDown

FunctionUOM']

Electrical Usage Agency Code String ELE_USAGE_AGENCY_CODE ELE_USAGE_AGENCY_CODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrMany
[@name="electricalUsageAgency
Code']/value

Is Trade Item Auto Powered Down Enabled When Shipped String POWER_DOWN_ENABLED POWER_DOWN_ENABLED os:envelope/catalogueRequest/

To Customer document/item/targetMarket
Attributes/flex/isTradeItem
AutomaticPowerDownEnabled

Electrical Usage Class Code String ELEC_USAGE_CLASS_CODE ELEC_USAGE_CLASS_CODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/physical
ResourceUsageInformation/
physicalResourceUsageTrade
ItemClassification/physical
ResourceUsageClassification

Code
Electrical Usage Sub Class Code String ELEC_USAGE_SUBCLASS_ ELEC_USAGE_SUBCLASS_ os:envelope/catalogueRequest/
CODE CODE document/item/targetMarket

Attributes/flex/physical
ResourceUsageInformation/
physicalResourceUsage
TradeItemClassification/
physicalResourceUsageSub
classificationCode

TIBCO® MDM Add-on for Global Data Synchronization User's Guide



91 | Message Choreography

1WorldSync Attribute

Maximum Energy Usage Time Period

Maximum Energy Usage Time Period UOM

Electrical Usage Class Screen Area Value

Electrical Usage Class Screen Area UOM

Electrical Usage Class Resolution Code

Electrical Usage Class Mode Code

Manufacturer Take Back Program Currency

Warranty Condition Effective Date Type

MDM Data
Type

Decimal

String

String

String

String

String

String

String

Sync Profile Attribute

MAX_ENERGY_USAGE

MAX_ENERGY_USAGE_UOM

TOTAL_SCREEN_AREA

TOTAL_SCREEN_AREA_UOM

DISPLAY_RESOLUTION

RUN_MODE

TAKE_BACK_PROGRAM_FEE_

CURR

WARRANTY_CON_EFF_DATE_

TYPE

Repository Attribute

MAX_ENERGY_USAGE

MAX_ENERGY_USAGE_UOM

TOTAL_SCREEN_AREA

TOTAL_SCREEN_AREA_UOM

DISPLAY_RESOLUTION

RUN_MODE

TAKE_BACK_PROGRAM_FEE _
CURR

WARRANTY_CON_EFF_DATE_
TYPE

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/physical
ResourceUsageInformation/
physicalResourceUsage/physical
ResourceUsage

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name="electricalUsage']/row/
attrQual[@name="maximum
EnergyUsageTimePeriod']
[@qual]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/totalScreenArea

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrQualMany
[@name="electricalUsageClass
ScreenAreaValue']/value[@qual]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/displayResolution
Code

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/physical
ResourceUsageInformation/
physicalResourceUsage/
runModeCode

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrQualMany
[@name="manufacturerTakeBack
ProgramFee'] /value[@qual]

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/warranty
Information/warranty
EffectiveDateType
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1WorldSync Attribute

Warranty Period UOM

Country of Last Provenance/Processing

Trade Channel

Is Hazardous Component Broken Down Easily For Recycling

Percent Of Product Components Labeled For Disassembly
And Recycling

Is Product Disassembly By Recycling Facility Completed
Using Standard Tools

Is Product RPPC Compliant in Target Market

Product RoHS Compliance Code

MDM Data
Type

String

String

String

String

Decimal

String

String

String

Sync Profile Attribute

WARRANTY_DURATION_UOM

COUNTRY_LAST_PROVENANCE

TRADE_CHANNEL

HAZARDOUS_COMP_
REMOVABLE

DISASSEMBLY_RECYCLE_
PERCENT

DESIGN_FOR_EASY_
DISASSMBLY

IS_RIGID_PLASTIC_
PACKAGING

IS_ROHS_COMPLIANT

Repository Attribute

WARRANTY_DURATION_UOM

COUNTRY_OF_LAST_
PROCESSING

TRADE_CHANNEL

HAZARDOUS_COMP_
REMOVABLE

DISASSEMBLY_RECYCLE_
PERCENT

DESIGN_FOR_EASY_
DISASSMBLY

IS_RIGID_PLASTIC_
PACKAGING

IS_ROHS_COMPLIANT

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name="warrantyConditionInfo']/
row/attr[@name=warranty
Perdiod']

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/productActivity
Details/countryOfActivity/
countryCode productActivityType
Code=LAST_PROCESSING

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrMany
[@nhame="tradeChannel']/value

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/areHazardous
ComponentsRemovable

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/components
LabeledForDisassembly
RecyclingPercen

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attr
[@name="1sProductDisassembly
ByRecyclingFacilityCompleted
UsingStandardTools']

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/isTradeItem
RigidPlasticPackagingContainer

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/isTrade
ItemROHSCompliant
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1WorldSync Attribute

Is Product Considered Universal Waste?

Can Product Be Easily Upgraded Or Maintained By
Consumer

Materials That Fail RoHS Compliance

Link File Name

MDM Data
Type

String

String

String

String

MDM Operations for 1WorldSync Messages

Sync Profile Attribute

IS_UNIVERSAL_WASTE

IS_UPGRADEABLE_OR_
MAINTAIN

ROHS_COMPL_FATLURE_
MATERTAL

EXT_FILE_LINK_FILE_NAME

Repository Attribute

IS_UNIVERSAL_WASTE

IS_UPGRADEABLE_OR_
MAINTAIN

ROHS_COMPL_FATLURE_
MATERTAL

EXT_FILE_LINK_FILE_NAME

The following is a list of 1WorldSync messages and corresponding operations selected by MDM for these messages.

Supplier Operations

MDM Operations for 1WorldSync Messages (Supplier Operations)

1WorldSync message

type

ITEM ADD Incremental Deliver To
Yes Datapool

ITEM MODIFY/CORRECT Incremental Deliver To
Yes/No Datapool

Operation selected on Synchronization Profile

Operation
Add
Operation

Data Correction/

Cancel/ Discontinue/ Reinstate

Xpath in 1WorldSync message

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/isTrade
ItemUniversalWaste

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/isTradeItem
ConsumerUpgradeableOr
Maintainable

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/rOHSCompliance
FailureMaterial

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attr[@name=
'externalFileLinkFileName']

Corresponding Operation and sub-operation selected in synchronization event

Add: New

ADD:CORRECT

Beside this ADD:CANCEL, ADD:DISCONTINUE and ADD:REINSTATE are also handled with this

message.
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1WorldSync message
type

LINK ADD

LINK DELETE

PUBLICATION ADD

Retailer Operations

Operation selected on Synchronization Profile

Incremental
Yes /No
Incremental
Yes/No
Incremental

Yes /No

Deliver To
Datapool
Deliver To
Datapool
Deliver To

Trading Partner on
Datapool

MDM Operations for 1WorldSync Messages (Retailer Operations)

Message Type

1WorldSync Catalogue Item Notification (CIN)

1WorldSync Catalogue Item Confirmation (CIC)

1WorldSync Request For Catalogue Item Notification

(RFCIN)

1WorldSync Catalogue Item Notification Response (CINR)

1WorldSync Catalogue Item Confirmation Response

Incoming/
Outgoing

Incoming

Outgoing

Outgoing

Outgoing

Incoming

Operation
Add/ Data Correction
Operation
Add/ Data Correction
Operation

Add/ Publish

SubOperation for Add/Publish:

New

SubOperations Only applicable to Publish operation:
For RELOAD-COPY: Initial Load

For RELOAD-ORIGINAL- Initial Load+ Include Rejected
Records

Description

Corresponding Operation and sub-operation selected in synchronization event

LINK:NONE

LINK:UNLINK

PUBLISH:NEW
PUBLISH:IMPLICIT

PUBLISH: RELOAD-COPY
PUBLISH: RELOAD-ORIGINAL

This new or initial or correction load message is received from Datapool when the supplier publishes the record for the retailer.

Catalog Item Confirmation message of the Received, Rejected, Review, and Synchronize type sent by the retailer in receipt of the CIN message

received.

For the steps to specify this message, refer Specifying Catalogue Item Confirmation Response.

The RFCIN message sent by the retailer with isReload set as true/false.

For the steps to specify this message, refer to Specifying Request For Catalogue Item Notification Message.

This response message is sent by MDM in response to CIN.

The Catalog Item Confirmation response (CICR) received from Datapool in response to CIC messages.
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Message Type Incoming/ Description

Outgoing
1WorldSync Request For Catalogue Item Notification Incoming The Request For Catalog Item Notification Response (RFCINR) received from Datapool in response to RFCIN messages.
Response
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Specifying Catalogue Item Confirmation Response

Procedure

1.
2.
3.

4
5.
6

T1.

Log in to the user’s enterprise with user credentials.
Click Browse and Search.

Select a repository and click View All.

. Select the record for which the CIC message is to be specified.

On the View Record page, select Send Response.

. Select the required Action.

o Review: Select the Confirmation Status Code and Corrective Action.
e Received: Select the Retailer Credential.
o Synchronised: Select the Retailer Credential.

o Rejected: Select the Confirmation Status Code and Corrective Action.

Click Submit.

Specifying Request For Catalogue Item Notification Message

Procedure
1. Log in to the user’s enterprise with user credentials.
2. Click Browse and Search.
3. Select a repository and click View All.
4. Select the record for which message is to be specified.
5. On the View Record page, select Send Message.
6. Select the Action as RFCIN - Generate RFCIN Message.
7. Select the Datapool.
8. Select Trading Partner.
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Note: Verify the Company Credential and Trading Partner Credential
details.

9. Click Submit.

Correction Versus Modify

Based on GS1 Standards and Global Data Synchronization Network (GDSN) standards,
changes to some attributes require a new GTIN.

Information regarding the GS1 Standards is available at GS1 documentation site.

For these attributes, MDM generates a Correct message. For changes to all other
attributes, MDM generates a Modify message.

MDM sends Item correction for the following 1WorldSync attributes:

Alternate Item Classification Code

« Alternate Item Classification Scheme
o Brand Name

o Brand Owner GLN

o Canceled Date

o Depth (if change > 20%)

e Depth UOM

 Discontinued Date

o EANUCC Code

o EANUCC Type

« Global Item Classification Code
o Gross Weight (if change > 20%)
e Gross Weight UOM

« Height (if change > 20%)

o Height UOM

o Net Content
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Net Content UOM

Net Weight

Net Weight UOM

Product Type

Qty of Next Level Item(s)
Volume (if change > 20%)
Volume UOM

Width (if change > 20%)
Width UOM

Supported 1WorldSync Responses

MDM supports the following 1WorldSync responses:

Catalogue Response

ITEM MAINTENANCE CATALOGUE RESPONSE
ITEM LINK CATALOGUE RESPONSE
ITEM PUBLICATION CATALOGUE RESPONSE
MESSAGE EXCEPTION RESPONSE
1SYNC GDSN ITEM REGISTRY RESPONSE
Item Synchronization Response
Item Authorization Response
1SYNC Catalogue Item Notification (1SYNC CIN)
1SYNC Catalogue Item Notification Response (1SYNC CINR)
1SYNC Catalogue Item Confirmation (1SYNC CIC)
1SYNC Catalogue Item Confirmation Response (1SYNC CICR)
1SYNC Request For Catalogue Item Notification (1SYNC RFCIN)

1SYNC Request For Catalogue Item Notification Response (1SYNC RFCINR)
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Changing Message Choreography

You can use MDM to work with specific datapools.

Procedure
1. Update Rulebase to support New Message Type. For MDM to support a new message
type, the first step is to update the rbformatattributes_gdsn.xml rulebase file so
the new synchronization format is detected in the synchronization profile Ul.

o Update the $MQ_COMMON_DIR/standard/rulebase/rbformatattributes_gdsn.xml
file.

2. Update Map file to support New Message Type. The next step is to update the map
file to support the new message type.

o Update the datapool specific map file from the $MQ_COMMON_DIR/standard/maps
folder.

« For more details on datapool specific map files for different message types,
refer to GDSN-Specific Maps.

3. Update Sync Operation Identifier Rulebase. Next, update the datapool specific sync
operation identifier rulebase to identify datapool specific sync operations.

o Update the appropriate file in:$MQ_COMMON_DIR/standard/rulebase.

o For 1WorldSync, the rulebase name is rbtransorasupplier.xml

4. Status Derivation. When a datapool receives a message from the MDM supplier or
retailer applications, a response is sent to the appropriate application. Based on the
response, MDM updates the status of the record. For example, if an "ltem add"
message is sent, the record is internally updated based on the response received
from the datapool. You can update the status derivation.

o To add or to update an operation from the Ul on the supplier or retailer
applications, change the constraints from the following file $MQ_COMMON_
DIR/standard/rulebase/rbsyncstatusupdatederivation.xml.

o To update from the Ul, change the constraints in the $MQ_COMMON_
DIR/standard/rulebase/rbsyncstatusupdatederivation.xml update
statusderivation.xml file.

o To update record status derivation on receiving a response from the datapool,
change the constraints in the $MQ_COMMON_
DIR/standard/rulebase/statusderivation.xml file.
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5. Message Handler Selection. To change the message handler selection, properties
similar to the following should be updated in $MQ_HOME/config/gdsn.config

e com.tibco.cim.connector.plugin.mapping.handlemessaging.supplier.*1lsync
*=com.tibco.cim.init.connector.plugin.handlemessaging.supplier.1lSync

e com.tibco.cim.init.connector.plugin.handlemessaging.supplier.1Sync.cla
ss=com. tibco.mdm.gdsn.integration.connector.TransoraMessagingHandler

Configurable Components

Record Validation on Ul

To enable record validation through the Ul, depending on your datapool, copy the
appropriate rulebase from the standard rulebase folder to your enterprise specific
repository location:

File to copy For 1WorldSync: _1sync_mastercatalog_catalogvalidation.xml
Copy from $MQ_HOME/plugins/gdsn/<version>/common/standard/rulebase
Copy to $MQ_COMMON_DIR/<ENTERPRISE_INTERNALNAME>/catalog/master/<REPOSITORYID>

Rename it to catalogvalidation.xml.

Synchronization Profile Validation

Out-of-the-box catalog synchronization is provided through datapool specific rulebase
files which declare validation rules.

File to copy For 1WorldSync: _1Sync_catalogvalidation.xml
Copy from $MQ_HOME/plugins/gdsn/<version>/common/standard/rulebase

Copy to $MQ_COMMON_DIR/standard/rulebase

Rulebase for Protocol Selection

This rulebase decides the protocol to be used by the messaging handler for outgoing
messages or the response handler for incoming messages.

$MQ_COMMON_DIR/standard/rulebase/rbconnectorprotocolderivation_gdsn.xml
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GDSN Impact on Workflows and Rulebase

GDSN impacts the workflows and rulebase in TIBCO MDM.
e GDSN Impact on Rulebase

o GDSN Impact on Workflows

GDSN Impact on Rulebase

Modifying Business Process Rules

In the Rule List page, click the repository name to modify the rule. Use this page to modify
the existing conditions, actions, and defaults used in workflow processing. If a backend
system is part of the rule template, only Datapools associated with that backend system
are displayed.

SyncOperationAttribute

This function is used to find the operation date. The function gets the latest sync date for
the given Operation (only ADD is supported) from a Datapool or Trading Partner.

Syntax

<var>0OPERATION_DATE</var>

<op func="SyncOperationAttribute">

<const type="string">ADD</const>

<const type="string">1Sync</const>

<!--const type="string">Trading Partner Name</const-->
</op>

For this function, three parameters can be specified.

The second parameter is the marketplace or datapool name. This is optional; if not
specified, the rulebase evaluates it.

The third parameter is the trading partner name and is optional. If not specified, it looks
for all trading partners; if specified, it looks for the operation for the given trading
partner.
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GDSN Impact on Workflows

GDSN Specific Workflows

The following table lists the various GDSN processes along with supported Document Type, Document Sub Type, Repository, and so on.

GDSN Processes

Document Type Document Sub Repository Sync Default Default Oorg Software Doc Process Definition Name Default
Type Profile Sender Receiver Type Edition Format

Record Authorization Any Any Any 1Sync Any Any Any Any wfoutlsync62cic26vl.xml - 1sync CIC Process  No

Notification

RecordAuthorization Any Any Any 1SyncTest  Any Any Any Any wfoutlsync62cic26vl.xml - 1sync CIC Process  No

Notification

RecordPublication Any Any Any 1Sync Any Any Any Any wfoutlsync62cic26vl.xml - 1sync CIC Process  No

Notification

RecordPublication Any Any Any 1Sync Any Any Any Any wfoutlsync62cic26vl.xml - 1sync CIC Process  No

Request

RecordPublication Any Any Any 1SyncTest  Any Any Any Any wfoutlsync62cic26vl.xml - 1sync CIC Process  No

Notification

RecordPublication Any Any Any 1SyncTest  Any Any Any Any wfoutlsync62cic26vl.xml - 1sync CIC Process  No

Request

Request for CIN Any Any Any 1SyncTest  Any Any Any Any wfoutlsync62cic26vl.xml - 1sync CIC Process  No

Notification

Request for CIN Any Any Any 1Sync Any Any Any Any wfoutlsync62cic26vl.xml - 1sync CIC Process  No

Notification

Any Any Any Any Any Any Any Any cim2cim wfoutveloselcin26v2.xml - CIN Process for No

document CIM2CIM

Request for CIN Any Any Any Any Any Any Any Any wfin26rfcinv2.xml - Receive RFCIN Process No

Notification

RFCIN Notification Any Any Any Any Any Any Any Any wfin26catactionRFCINv2.xml - RFCIN Retailer No
Process

RecordPublication Publication Delivery Any Any Any Any Any Any Any wfin26prodnotifv2.xml - Response No
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Notification

RecordPublication

Notification

RecordContent
Notification

RecordContent
Notification

RecordContent
Notification

RecordContent
Notification

RecordContent
Notification

RecordContent
Notification

RecordContent
Notification

RecordContent
Notification

RecordContent
Notification

RecordContent
Notification

RecordContent
Notification

RecordContent
Notification

RecordContent
Notification
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Document Sub
Type

Notification

Any

Datapool Response

Notification

Registry Response

Notification

Internal Error
Notification

Record Add

Notification

Data Change

Delete

Discontinue

Cancel

Data Correction

Record Add

Notification

Data Change

Data Correction

Delete

Repository Sync

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Profile

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Default
Sender

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Default
Receiver

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Org
Type

Any

Any

Any

Any

Retailer

Retailer

Retailer

Retailer

Retailer

Retailer

Any

Any

Any

Any

Software
Edition

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Doc
Format

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Any

Process Definition Name

Notification process

wfin26prodnotifretailerv4.xml - Record
Notification process

wfin26prodnotifv2.xml - Response
Notification process

wfin26prodnotifv2.xml - Response
Notification process

wfin26prodnotifv2.xml - Response
Notification process

wfin26prodnotifretailerv4.xml - Record
Notification process

wfin26prodnotifretailerv4.xml - Record
Notification process

wfin26prodnotifretailerv4.xml - Record
Notification process

wfin26prodnotifretailerv4.xml - Record
Notification process

wfin26prodnotifretailerv4.xml - Record
Notification process

wfin26prodnotifretailerv4.xml - Record
Notification process

wfin26prodnotifprocessv2.xml - Record data
notification Process

wfin26prodnotifprocessv2.xml - Record data
notification Process

wfin26prodnotifprocessv2.xml - Record data
notification Process

wfin26prodnotifprocessv2.xml - Record data
notification Process
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Document Type Document Sub Repository Sync Default Default Org Software Doc Process Definition Name Default
Type Profile Sender Receiver Type Edition Format

RecordContent Cancel Any Any Any Any Any Any Any wfin26prodnotifprocessv2.xml - Record data No

Notification notification Process

RecordContent Discontinue Any Any Any Any Any Any Any wfin26prodnotifprocessv2.xml - Record data No

Notification notification Process

RecordAuthorization Any Any Any Any Any Any Any Any wfin26prodnotifbasicv3.xml - Incoming No

Notification Message processing Process

Purge Historical Data Any Any Any Any Any Any Any Any wfin26purgev3.xml - Purge process No

Any Any Any Any Any Any Any Any Any wfoutagentrics50cin26v2.xml - Agentrics CIN No

Process

Any Any Any Any 1SyncTest Any Retailer Any 1Sync wfoutlsync65cin26v1l.xml - 1Sync CIN process  No
document

Any Any Any Any 1Sync Any Retailer Any 1Sync wfoutlsync65cin26v1l.xml - 1Sync CIN process No
document

Any Any Any Any 1SyncTest Any Any Any Any wfoutlsync62cic26vl.xml - 1sync CIC Process  No

Any Any Any Any 1Sync Any Any Any Any wfoutlsync62cic26vl.xml - 1sync CIC Process  No
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Setting up CIM to CIM

Two MDM applications can be connected. The full setup for testing the CIM to CIM
Synchronization capability is mentioned later. As an administrator, you can connect and
synchronize two MDM environments.

Need for Synchronization

TIBCO MDM supports organizations to communicate with trading partners through
datapools. For example, a supplier can do business with a trading partner through a
datapool like 1WorldSync.

However, an organization may sometimes want to communicate privately with its trading
partners without a third party datapool. Also, companies in different locations may need
to internally synchronize data in their systems, involving datapools.

In such cases, organizations can deploy instances of CIM per location and synchronize as
required. To do this, TIBCO provides an out-of-the-box functionality to connect and sync
two or more CIM instances. Instances from different entities can communicate with each
other directly, without involving a third party datapool.

Types of Synchronization
Synchronization can occur between any of the two types:
o Two or more enterprises on a single TIBCO MDM instance

o Two different TIBCO MDM instances

How it Works

Process in which four different enterprises are created on a single CIM instance.

o BrandOwner, VeloselMarketPlace, Bottlerl, and Bottler2 are four enterprises
created.

o BrandOwner is the main enterprise of type Supplier. The BrandOwner subscribes to
the VeloselMarketplace enterprise (to which it synchronizes all updates). It has
Bottlerl and Bottler2 as trading partners.
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« VeloselMarketplace is an enterprise of type Marketplace. Consider this as the central
location to which data is synchronized and from where updates are received (by the

subscribed suppliers). It has BrandOwner, Bottlerl and Bottler2 as trading
partners.

« Bottlerl and Bottler2 are enterprises of type Supplier. They are both subscribed to
the VeloselMarketplace enterprise (to receive BrandOwner’s updates) and have
BrandOwner as a trading partner.

In the scenario, whenever Brandowner has information to synchronize, for example a
record, it is synchronized to VeloselMarketplace, from where Bottlerl and Bottler2
receive the update (record) because of their subscription.

Note: You can synchronize by creating a special enterprise of type 'Marketplace'
with the name as VeloselMarketplace. The name of the enterprise has to be
VeloselMarketplace for the application to work as provided out-of-the-box.
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Synchronizing Two CIM Instances

The following steps are involved in synchronizing two CIM instances. Each step is
explained in detail in the following sections.

Procedure

1.

Setting up Queue Configuration
Make the required queue configuration changes.

Creating Enterprise and Prepopulating Data
Run the required database scripts.

Configuring Database Changes
Run the application server. Create three or more enterprises. Populate the
enterprises with data by running XML packs.

Company Profile and GLN credentials
Create company profiles and GLN credentials for each enterprise.

Trading Partner Profile
Define trading partners for each enterprise and input GLNs.

Changing Rulebase
Make the required rulebase changes.

Datasource and Input Map for BrandOwner
Create Datasource and InputMap for BrandOwner enterprise.

Processing Reverse Relationships (Optional Step)
Only required if you need reverse relationships processed.

Testing your CIM to CIM Setup
Test your setup.
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Setting up Queue Configuration

Before you begin
If you are in the process of synchronizing 1WorldSync datapool, do not follow the steps
listed here for queue setup; instead use the out-of-the-box queue configuration.

Procedure
1. Queue Setup for CIM to CIM Integration Messages:

o For communication between two enterprises, you need gateways to transport
messages across two firewalls and from the Q_ECM_INTGR_STD_OUTBOUND_
INTGR_MSG queue of the sender instance to Q_ECM_INTGR_STD_INBOUND_
INTGR_MSG queue of the receiver instance. These gateways cannot be used for
testing, but a simple trick can be used to simulate it.

» Because the messaging framework helps in mapping the logical and physical
queue names and supports connectivity to multiple JMS servers from the same
instance, you can use the Q_ECM_INTGR_STD_INBOUND_INTGR_MSG physical
queue hosted on one of the JMS servers (the one connected to
VeloselMarketplace) and map it to:

o the StandardOutboundintgrMsg logical queue used to send outbound
integration messages from the BrandOwner instance.

o the StandardIinboundIntgrMsg logical queue used to receive inbound
integration messages in the VeloselMarketplace instance.

2. The following changes need to be done in ConfigVvalues.xml. To connect to two
different queue managers, BrandOwner will need two different clusters. If
BrandOwner uses TIBCO EMS, add the following lines to ConfigVvalues.xml after the
TIBCO Messaging Cluster section.

o Change 1, search for <Category name="TIBCO EMS" visibility="Advanced">.Add
the following lines:

<!-= V2V ENTRIES ->

<ConfValue
description="com.tibco.cim.queue.cluster.TIBCOCluster2 - added
for v2v'" name="com.tibco.cim.queue.cluster.TIBCOCluster2"
propname="com.tibco.cim.queue.cluster.TIBCOCluster2"
readonly="false" sinceVersion="7.1" visibility="Basic'">
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<ConfString
default="14nherit:com.tibco.cim.queue.cluster.DefCluster"
value="1inherit:com.tibco.cim.queue.cluster.DefCluster"/>
</ConfValue>
<ConfValue
description="com.tibco.cim.queue.cluster.TIBCOCluster2.clusterL
jaison.class - added for v2v"
name="com. tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.
class"
propname="com.tibco.cim.queue.cluster.TIBCOCluster2.clusterlLiai
son.class" readonly="false" sinceVersion="7.1"
visibility="Basic">
<ConfString default =
"com.tibco.mdm.integration.messaging.queue.tibco.TIBCOCluster
Liaison" value =
"com.tibco.mdm.integration.messaging.queue.tibco.TIBCOCluster
Liaison"/>
</ConfValue>
<ConfValue description =
"com.tibco.cim.queue.cluster.TIBCOCluster2.defUser - added for
v2v" name = "com.tibco.cim.queue.cluster.TIBCOCluster2.defUser"
propname = '"com.tibco.cim.queue.cluster.TIBCOCluster2.defUser"
readonly = '"false" sinceVersion = "7.1" visibility = "Basic">
<ConfString default = "admin" value = "admin"/>
</ConfValue>
<ConfValue description =
"com.tibco.cim.queue.cluster.TIBCOCluster2.defPassword - added
for v2v'" name =
"com.tibco.cim.queue.cluster.TIBCOCluster2.defPassword" propname
= "com.tibco.cim.queue.cluster.TIBCOCluster2.defPassword"

readonly = '"false" sinceVersion = "7.1" visibility = "Basic">
<ConfString default = "" value = ""/>
</ConfValue>

<ConfValue description =
"com.tibco.cim.queue.cluster.TIBCOCluster2.defClientID - added
for v2v'" name =
"com.tibco.cim.queue.cluster.TIBCOCluster2.defClientID" propname
= "com.tibco.cim.queue.cluster.TIBCOCluster2.defClientID"

readonly = '"false" sinceVersion = "7.1" visibility = "Basic">
<ConfString default = "null" value = "null"/>
</ConfValue>

<ConfValue description =
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"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clust

eredServers" name =
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clust
eredServers" propname =
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clust
eredServers" readonly = "false" sinceVersion = "7.1" visibility
= "Basic'">

<ConfString default = "LocalhostServer" value =
"LocalhostServer'"/>
</ConfValue>
<ConfValue description =
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clust
eredServer.LocalhostServer" name =
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clust
eredServer.LocalhostServer" propname =
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clust
eredServer.LocalhostServer" readonly = "false" sinceVersion =

"7.1" visibility = "Basic">

<ConfString default = "tcp://localhost:7222" value =
"tcp://localhost:7222"/>
</ConfValue>
<ConfValue description =
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clust

eredServer.encoding.LocalhostServer - added for v2v" name =
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clust
eredServer.encoding.LocalhostServer" propname =
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clust
eredServer.encoding.LocalhostServer" readonly = "false"
sinceVersion = "7.1" visibility = "Basic">

<ConfString default = "UTF-8" value = "UTF-8"/>
</ConfValue>

<ConfValue description =
"com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.cluster -
added for v2v'" name =
"com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.cluster"

propname =
"com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.cluster"
readonly = "false" sinceVersion = "7.1" visibility = "Basic">

<ConfString default = "TIBCOCluster2" value =
"TIBCOCluster2"/>
</ConfValue>
<ConfValue description =
"com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.addToINDI -
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added for v2v'" name =
"com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.addToINDI"

propname =

"com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.addToJINDI"

readonly = "false" sinceVersion = "7.1" visibility = "Basic">
<ConfBool default = "false" value = "false"/>

</ConfValue>

<ConfValue description =
"com.tibco.cim.queue.queue.StandardInboundIntgrMsg.cluster -
added for v2v'" name =
"com.tibco.cim.queue.queue.StandardInboundIntgrMsg.cluster"

propname =
"com.tibco.cim.queue.queue.StandardInboundIntgrMsg.cluster"
readonly = "false" sinceVersion = "7.1" visibility = "Basic">

<ConfString default = "TIBCOCluster2" value =
"TIBCOCluster2"/>
</ConfValue>

o Change 2, search for <Category name="StandardOutboundintgrMsg"
visibility="Advanced">. Add the following lines:

<!- V2V ENTRIES ->

<ConfValue description = "" disHotDeployable = "false" name =
"EMS Queue Name" propname =
"com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.cluster.TIB

COCluster2.queue" sinceVersion = "7.0" visibility = "Advanced">
<ConfString default = "Q_ECM_INTGR_STD_OUTBOUND_INTGR_MSG"
value = "Q_ECM_INTGR_STD_OUTBOUND_INTGR_MSG" />
</ConfValue>

o Change 3, search for <Category name="StandardInboundintgrMsg"
visibility="Advanced">. Add the following lines:

<!-= V2V ENTRIES ->

<ConfValue description="" isHotDeployable="false" name="EMS
Queue Name"

propname="com. tibco.cim.queue.queue.StandardInboundIntgrMsg.cl
ust er.TIBCOCluster2.queue" sinceVersion="7.0"
visibility="Advanced">

<ConfString default="Q_ECM_INTGR_STD_ OUTBOUND _INTGR_MSG"

value="Q_ECM_INTGR_STD_ OUTBOUND_INTGR_MSG"/>

</ConfValue>
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Creating Enterprise and Prepopulating Data

Before you begin
Ensure that the Application Server is running.

Procedure
1. Create four or more enterprises.

Enterprise Type
BrandOwner Supplier
VeloselMarketplace Marketplace
Bottlerl Supplier
Bottler2 Supplier

2. Create BrandOwner Enterprise:

« Create a BrandOwner Enterprise of type Supplier with Internal Name as

bowner
Attribute Value
Enterprise BrandOwner

Enterprise Type  Supplier

Internal Name bowner

o Create a user admin with first name admin and last name admin. Assign the
Work Supervisor and Admin roles to this user.
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Attribute Value
User Name admin
First/Middle/Last  admin//admin

Roles Work Supervisor/Admin

o Import XML Pack for BrandOwner Enterprise, you can import an XML pack to
prepopulate the enterprise with some data.

o Log in to the BrandOwner enterprise.

o Select System Operations > Import Metadata.

Import Metadata
Specify metadata file ( jar/zip) for upload

File Details

File to Upload Choose File | No fie chosen

o Provide the path to the following xml file:$MQ_COMMON_
DIR/common/standard/samples/cim2cimmetadata/Brandowner/BrandOwne
r-MetaData.jar.

o Refer to Step 6 to view the data generated through XML pack import.

3. Create VeloselMarketplace Enterprise (This is just for subscription purposes. The
real Velosel Marketplace Enterprise resides on Instance 2):

o Create an Enterprise VeloselMarketplace of type Marketplace with Internal
Name as Veloselm.
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Attribute Value

Enterprise VeloselMarketplace
Enterprise Type  Marketplace

Internal Name Veloselm

o Create a user admin with first name admin and last name user. Assign the
Work Supervisor and Admin roles to this user.

Attribute Value

User Name admin
First/Middle/Last  admin//admin

Roles Work Supervisor/Admin

o Import XML Pack for VeloselMarketplace Enterprise, you can import an XML
pack to prepopulate the enterprise with some data.

o Log in to the VeloselMarketplace enterprise.
o Select System Operations > Import Meta Data.

o Provide the path to the following xml file:$MQ_COMMON_
DIR/standard/samples/cim2cimmetadata/VeloselMarketplace/VeloselM
arketplace-MetaData.jar

o Refer to Step 6 to view the data generated through XML pack import.
4. Create Bottlerl Enterprise:
« Create an Enterprise Bottlerl of type Supplier with Internal Name as Bottlerl.

Attribute Value

Enterprise Bottlerl
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Attribute Value

Enterprise Type  Supplier

Internal Name Bottlerl

« Create a user admin with first name admin and last name user. Assign the
Work Supervisor and Admin roles to this user.

Attribute Value

User Name admin
First/Middle/Last  admin//admin

Roles Work Supervisor/Admin

o Import XML Pack for Bottlerl Enterprise, you can import an XML pack to
prepopulate the enterprise with some data.

o Log in to the Bottlerl enterprise.
o Select System Operations > Import Meta Data.

o Provide the path to the following xml file:$MQ_COMMON_
DIR/standard/samples/cim2cimmetadata/Bottlerl/Bottlerl-
MetaData.jar.

o Refer to Step 6 to view the data generated through XML pack import.
5. Create Bottler2 Enterprise:

o Create an Enterprise Bottler2 of type Supplier with Internal Name as Bottler2

Attribute Value

Enterprise Bottler2
Enterprise Name  Supplier

Internal Name Bottler2
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o Create a user admin with first name admin and last name user. Assign the
Work Supervisor and Admin roles to this user.

Attribute Value
User Name admin
First/Middle/Last  admin//admin

Roles Work Supervisor/Admin

o Import XML Pack for Bottler2 Enterprise, you can import an XML pack to
prepopulate the enterprise with some data.

o Log in to the Bottler2 enterprise.
o Select System Operations > Import Meta Data.

o Provide the path to the following XML file:$MQ_COMMON_

DIR/standard/samples/cim2cimmetadata/Bottler2/Bottler2-
MetaData.ja

o Refer to Step 6 to view the data generated through XML pack import.

6. Data generated through XML Pack Import: By importing the various XML packs, the
respective enterprises are populated with the following: Repository: For example,
MC_V2VITEMMASTER

Repositories

Repository Name | (D 0

[ | MC_V2VITEMMASTER 35031 I

Attributes: some custom attributes in repository MC_V2VITEMMASTER

“VeloselExt
Position Name Display Name Column Name Type Length Display in Record List
=4 AftrStr AftrStr CATTRSTR String 256 No
= Aftrint Atftrint CATTRINT Integer 0 No
= |8 AftrDec AttrDec CATTRDEC Decimal |0 No
= |7 AttrDate AdtrDate CATTRDATE Date 0 No
= 13 AttrAmt Attramt CATTRAMT Amount 0 No

Output Maps: an output map OM_V2VOUTPUT based on the EANUCCExt Output
format created in repository MC_V2VITEMMASTER

TIBCO® MDM Add-on for Global Data Synchronization User's Guide



117 | Synchronizing Two CIM Instances

View Repository

Repository
Last Modified
Repository

MC_V2VITEMWMASTER
03/12/2010 16:32.46
MC_V2VitemMaster

Table Name:
Last Modified By

MCT_35031
admin,admin

{ Aﬂr\bﬂesm Relalionshipsﬁ Output Maps [ Classification Schemesj

QOutput Map Name

7| oM W2VoUTPUT

Description

EANUCCExt cutput map

Output Format

EANUCCEXT

Synchronization Format: EANUCCEXT synchronization format with some custom

attributes

Synchronization Formats

Synchronization Format Name
71| EANUCCEXT
[T EAN.UCC.SUBSCRIPTION

Description

EAN.UCCExt Catalog Format
1SYNC Cataleg Format
EAN.UCC Catalog Format

Subscription Catalog Format

Pre-defined Fixed Length
No No
Yes No
Yes No
Yes No

The following Business Process rules are created:
« Brandowner enterprise: Custom Protocol Selection and Rulebase Selection

« VeloselMarketplace enterprise: Custom Protocol Selection, Rulebase Selection,
and Repository Selection for Received Records

« Bottlerl and Bottler2 enterprises: Custom Protocol Selection and Repository
Selection for Received Records

Configuring Database Changes

Procedure
1. Navigate to the database.

2. Run the following scripts from the database.
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Result

Note: Use the OrgID of your organization and replace it in the SQL below where
it displays <Org ID Here>.

o Bottler Subscription Rulebase

insert into ConfigurationDefinition (ID, TYPE, OWNERID, GLOBAL, NAME,
SELECTOR, DESCRIPTION, DEFINITIONTYPE, DEFINITION, ACTIVE,
MODMEMBERID, MODDATE, MODVERSION)

VALUES (Mg_Sequence_1l.nextval, 'Rulebase', <Brandowner's Org ID
Here>, 'N', 'Bottler Subscription', ¢SUBSCRIPTION’, 'Select
Subscription.', 'File', 'bottler/rulebase/rbsynchtradingpartner.xml',
"Y', 1, SYSDATE, 1);

COMMIT;

o BrandOwner Translation Map

insert into ConfigurationDefinition

(ID, TYPE, OWNERID, GLOBAL, NAME, SELECTOR, DESCRIPTION,
DEFINITIONTYPE, DEFINITION,

ACTIVE, MODMEMBERID, MODDATE, MODVERSION)

VALUES (Mq_Sequence_1l.nextval, 'XSLT', <Brandowner's Org ID Here>,
'N', 'Custom Map', 'CONNECTOR',

'Message Translation.', 'File',
'standard/maps/mpfromcatact26toveloselcinvl.xsl', 'Y', 1, SYSDATE,
1);

COMMIT;

o VeloselMarketplace Translation Map

insert into ConfigurationDefinition

(ID, TYPE, OWNERID, GLOBAL, NAME, SELECTOR, DESCRIPTION,
DEFINITIONTYPE, DEFINITION,

ACTIVE, MODMEMBERID, MODDATE, MODVERSION)

VALUES (Mq_Sequence_1l.nextval, 'XSLT', <VeloselMarketplace's Org ID
Here>, 'N', 'Custom Map', 'CONNECTOR', 'Message Translation.',
'File', 'standard/maps/mpfromcatact26toveloselcinvl.xsl', 'Y', 1,
SYSDATE, 1);

COMMIT;

insert into ConfigurationDefinition

(ID, TYPE, OWNERID, GLOBAL, NAME, SELECTOR, DESCRIPTION,
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DEFINITIONTYPE, DEFINITION,
ACTIVE, MODMEMBERID, MODDATE, MODVERSION)

VALUES (Mg_Sequence_1l.nextval, 'XSLT', <VeloselMarketplace's Org ID
Here>, 'N', 'Custom Map', 'CONNECTOR',

'Message Translation to create Response.', 'File',
'standard/maps/mpfromveloselcintoveloselcinrvl.xsl', 'Y', 1, SYSDATE,
1);

COMMIT;

o VeloselMarketplace Subscription Rulebase

insert into ConfigurationDefinition (ID, TYPE, OWNERID, GLOBAL, NAME,
SELECTOR, DESCRIPTION, DEFINITIONTYPE, DEFINITION, ACTIVE,
MODMEMBERID, MODDATE, MODVERSION) VALUES (mg_sequence_l. nextval,
'Rulebase', <VeloselMarketplace's Org ID Here>, 'N', 'Bottler
Subscription', 'SUBSCRIPTION', 'Select Subscription.', 'File',

'bottler/rulebase/rbsynchveloselmarketplace.xml', 'Y', 1, SYSDATE, 1)
COMMIT;

« VeloselMarketplace Translation Maps (Instance 2)

o XSL Map for translating CIM CIN to mIXML: mpfromveloseltomlxml26v1.xsl

o XSL Map for translating CIM CIN to CIM CIN Response:
mpfromveloselcintoveloselcinrvl.xsl

Note: For simplicity, you can make all the above Subscription Rulebase and
Translation Map files globally available as follows:

o Enter avalue '1' instead of <Brandowner's OR VeloselMarketplace's Org ID
Here> for column OWNERID

o Enter a value 'Y' instead of 'N' for column GLOBAL.

Company Profile and GLN credentials

Create GLN credentials for each enterprise. These credentials are used to uniquely identify
the enterprise to communicate with.
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Creating GLN for BrandOwner Enterprise

1. Log in to the BrandOwner enterprise.

2. Subscribe to VeloselMarketplace.

1. Select Administration > Datapool Profiles and click Subscribe (in the Actions
column) against VeloselMarketplace.

2. Click Modify against VeloselMarketplace, click Modify in the Supported
Synchronization Formats section and select the EANUCC synchronization
format. Click Save.

3. Create a Company Profile called BrandOwner and create a GLN for it.
1. Select Administration > My > Company Profile.

2. Create a valid credential by clicking the Create link in the Credential section.

3. On the Create Credential page, provide Domain as GLN and ID as <GLN> and

click Save.
Company
Name BrandQwner
Contact Information
Main Phone No "Main Phone’ azsigned.
General Info Email No "General Info Email assigned.
Main FTP No "Main FTF" as=igned.
Datapool
VeloselMarketplace Credentials
Credentials
Identity Domain
0044444447736 GLN

Creating GLN for VeloselMarketplace Enterprise

Procedure
1. Log in to the VeloselMarketplace enterprise.

2. Subscribe to VeloselMarketplace.
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a. Select Administration > Datapool Profiles and click Subscribe (in the Actions
column) against VeloselMarketplace.

b. Click Modify against VeloselMarketplace, click Modify in the Supported
Synchronization Formats section and select the EANUCC synchronization
format. Click Save.

3. Create a Company Profile VeloselMarketplace and create a GLN for it.
a. Select Administration > Company Profile
b. Create a valid GLN by clicking the Create link in the Credential section.

c. On the Create Credential page, provide Domain as GLN and ID as <GLN>. Click
Save.

Creating GLN for Bottlerl Enterprise

Procedure
1. Login to the Bottlerl enterprise.

2. Subscribe to VeloselMarketplace

a. Select Administration > Datapool Profiles and click Subscribe (in the Actions
column) against VeloselMarketplace.

b. Click Modify against VeloselMarketplace, click Modify in the Supported
Synchronization Formats section and select the EANUCC synchronization
format. Click Save.

3. Create a Company Profile called Bottlerl and create a GLN for it.
a. Select Administration > Company Profile.
b. Create a valid GLN by clicking the Create link in the Credential section.

c. On the Create Credential page, provide Domain as GLN and ID as <GLN>. Click
Save.

Creating GLN for Bottler2 Enterprise

Procedure
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1. Login to the Bottler2 enterprise.
2. Subscribe to VeloselMarketplace

a. Select Administration > Datapool Profiles and click Subscribe (in the Actions
column) against VeloselMarketplace.

b. Click Modify against VeloselMarketplace, click Modify in the Supported
Synchronization Formats section and select the EANUCC synchronization
format. Click Save.

3. Create a Company Profile called Bottler2 and create a GLN for it.
a. Select Administration > Company Profile.
b. Create a valid GLN by clicking the Create link in the Credential section.

c. On the Create Credential page, provide Domain as GLN and ID as <GLN>. Click
Save.

Trading Partner Profile

Define trading partners for each enterprise and provide the GLN credentials of those
trading partners.

o Note: The GLN credentials provided here for trading partners should be the
same ones defined in Company Profile and GLN credentials for each enterprise.

Creating Trading Partner Profile for BrandOwner Enterprise

Procedure

1. Login to the BrandOwner enterprise and define Bottlerl and Bottler2 as trading
partners.

2. Create a Trading Partner Profile: Bottlerl.
a. Select Administration > Trading Partner Profiles.

b. Create a Trading Partner with name as Bottlerl; select VeloselMarketplace
under the Datapool section; select the EANUCCEXT Synchronization format.
Click Save.
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c. Once the Bottlerl Trading Partner Profile is created, click Bottlerl in the
Trading Partner Profiles List.

d. Click Extended Credentials against VeloselMarketplace in the Datapool
Participation section.

e. Click Create to create a Credential for Bottlerl.

f. Select Domain as GLN, and provide the <GLN as the Identity. Click Save. The
GLN you provide here should be the one defined in Creating GLN for Bottlerl
Enterprise.

3. Follow the same steps to create a Trading Partner Profile: Bottler2 and provide
extended credentials listing the GLN.

Creating Trading Partner Profile for VeloselMarketplace
Enterprise

Procedure
1. Login to the VeloselMarketplace enterprise and define BrandOwner, Bottlerl and
Bottler2 as trading partners.

2. Create a Trading Partner Profile: BrandOwner.
a. Select Administration > Trading Partner Profiles.

b. Create a Trading Partner with the name BrandOwner; From the Datapool
section, select VeloselMarketplace. Now select the EANUCCEXT
Synchronization format. Click Save.

c. After you create the BrandOwner Trading Partner Profile, click BrandOwner in
the Trading Partner Profiles List.

d. Click Extended Credentials against VeloselMarketplace in the Datapool
Participation section.

e. Click Create to create a Credential for BrandOwner.

f. Select Domain as GLN, and provide the <GLN as the Identity. Click Save. The
GLD you provide here should be the one defined in Creating GLN for Bottlerl
Enterprise.
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Create Credential

Company Name Bottler1

Domain GLN w

Identity 0044444447793

| Save || Cancel

3. Follow the same steps to define Bottlerl and Bottler2 as trading partners and
provide extended credentials listing their respective GLN IDs.

Creating Trading Partner Profile for Bottlerl and Bottler2

Procedure

1. Login to the Bottlerl and Bottler2 enterprises respectively and define BrandOwner
as a trading partner for each.

2. Provide extended credentials listing the BrandOwner GLN.

Changing Rulebase

You need to make some changes to the rbsynchtradingpartner.xml rulebase file through
which marketplaces and trading partners are specified.

Procedure

1. In $MQ_COMMON_DIR/bottler/rulebase, open the rbsynchtradingpartner.xml
rulebase file.

2. Make the following changes in this file for variable declaration.
« Declare Variables for Enterprises

o Search for the following section:
<!-- Convenience variables to hold GLN number to use. -->

o Provide the following as the first four variable declarations:
BO_GLN, VM_GLN, TP1GLN, TP2GLN.

o Your code should read as follows:
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<declare usage="local">
<var>BO_GLN</var>

</declare>

<dec'lare usage="local">
<var>VM_GLN</var>

</declare>

<declare usage="local">
<var>TP1GLN</var>

</declare>

<declare usage="1local">
<var>TP2GLN</var>

</declare>

« Assign Credential Variables and Values

o Search for the following section:
<name>AssignCredentials</name>

o Provide the appropriate GLN variables (BO_GLN, VM_GLN, TP1GLN,
TP2GLN) and the GLNs. Ensure that the GLNs match what you have
defined in the UL.

o Your code should read as follows:

<action>
<assign>
<var>B0O_GLN</var>
<const type="string'">0044444447786</const>
</assign>
<assign>
<var>VM_GLN</var>
<const type="string'">0044444447779</const>
</assign>
<assign>
<var>TP1GLN</var>
<const type="string'">0044444447793</const>
</assign>
<assign>
<var>TP2GLN</var>
<const type="string'">0044444447700</const>
</assign>
</action>
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« Define Marketplaces for each Product

o Search for:<description>Marketplaces for Each
Products</description>

o Search for the following variable:<var>SenderArray</var>

o Assign the following variables to SenderArray:<var>BO_GLN</var>
<var>B0_GLN</var>

o Search for the following variable:<var>ChannelArray</var>

o Assign the following variables to ChannelArray:<var>VM_GLN</var>
<var>VM_GLN</var>

o Search for the following variable:<var>TradingPartnerArray</var>

o Assign the following variables to TradingPartnerArray:<var>TP1GLN</var> <var>TP2GLN:

o Note: Two variables are added to the Sender Array and
Channel Array sections respectively, for two trading partners.
You need as many variables in these sections as trading
partners.

Datasource and Input Map for BrandOwner

Create a datasource and input map for the BrandOwner enterprise.

Creating Datasource

Procedure
1. Log in to the BrandOwner enterprise.

2. Select Item Data > Data Sources
a. Create Datasource DS_V2ViItems.

b. Provide some data as input to the datasource.
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Creating Inputmap

Procedure

1. Create an input map between the DS_V2VItems datasource and the MC_
V2VItemMaster repository.

2. Select Item Data > Repositories

a.

Select the check box against the MC_V2VITEMMASTER repository and click the
Manage Input Maps button.

Repositories

-::::','- Create 2@ Delete LEI Copy ™we Manage Input Maps E Get Record Count -::::','- Create Named Version

Repository Name EEL

¥ | MC_V2VITEMMASTER 35031

Click Create to create a new input map.
On the Create Input Map page:

Provide an Input Map Name and Input Map Description. Select Split/Approval
Required.

Select DS_V2VIitems check box and click Next.
Map the required attributes. The following are required:

e Record ID

o Record ID Extension

o Related Records

o SupplierID

o GTIN

o Brand_Owner_ID

e Brand _Owner_ID

e Content_Owner_IDContent_Owner_ID

e« Name_Of Brand_Owner

« Name_of_Datapool
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e Name_Of_Info_Provider
e Source_Data_Pool ID

o Target_Market_ID

v Unassigned
* Checking the box will not merge empty data fields
Name | Type | Data Source Attribute _| Expression
Record ID String | ;] I;@FRESH.ID |
Record ID Extension String | v] @FRESH.EXT |
Related Records String | || @Frest.contams |
g. Click Save.

Processing Reverse Relationships (Optional Step)

By default, the workflows are set up to process forward relationships (for example: A
contains B, B contains C, C contains D).

In case you have reverse relationship hierarchies (for example, A contained by B, B
contained by C, and so on), you need to make some changes to process reverse
relationships so that data is propagated correctly from BrandOwner to Marketplace and
Bottlers.

Procedure

1. Change to the wfin26cim2cimsyncV1l.xml Workflow. You can use this workflow for
CIM to CIM synchronization.

a. Open the $MQ_COMMON_DIR/standard/workflow/wfin26cim2cimsyncVl.xml file.

Search for the following section:<!-- Sample transition to flip
the root of bundles --> <!-- Transition
FromActivity="HandleRecordCollectionForFlipDecision"
ToActivity="ManageRecordCollectionForFlip">
<Description>If the Rulebase Selection Business Process
Rule is set, only then transition to ApplySynchRuleBase and
Spawn Publish Workflow</Description> <Rule>
<Parameter name="Rulebase" type="string" eval="rule"
source="Rulebase Selection"
direction="1in">inDoc</Parameter>
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<Parameter name="result" type="boolean"
direction="out"/>
<Condition format="bsh"><![CDATA[
result = (Rulebase != null && !Rulebase.equals
")
</Condition>
</Rule>
</Transition>
<Transition FromActivity="ManageRecordCollectionForFlip"
ToActivity="ApplySynchRuleBase"/
-=>

b. Uncomment this section (commented out by default) to process reverse
relationships.

2. Change to the wfin26catsourceimportv2.xml Workflow. You can use this workflow for
import/load and import events.

a. Open the $MQ_COMMON_DIR/standard/workflow/wfin26catsourceimportv2.xml
file.

b. Search for:<Activity Name="ManageRecordCollection">

c. Search for the RelationshipName parameter:<Parameter direction="in"
name="RelationshipName" type="string"
eval="constant">Contains</Parameter>

d. Change this from Contains to ContainedBy to process reverse relationships.

3. Change to the wfin26catsourcev5.xml Workflow. You can use this workflow for
datasource loads and import of records.

a. Open the $MQ_COMMON_DIR/standard/workflow/wfin26catsourcev5.xml file.
b. Search for:<Activity Name="ManageRecordCollection">

c. Search for the RelationshipName parameter:<Parameter direction="in"
name="RelationshipName" type="string"
eval="constant">Contains</Parameter>

d. Change this from Contains to ContainedBy to process reverse relationships.

4. Change to the wfin26prodnotifprocessv2.xml Workflow. You can use this workflow to
process the incoming record messages and to save data.

a. Open the $MQ_COMMON_DIR/standard/workflow/wfin26prodnotifprocessv2.xml
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file.
b. Search for the following activities:
o <Activity Name="GetProductinfo">
o <Activity Name="GetProductinfo2">

c. Add the following parameter:

<Parameter direction="1in" name="RelationshipName" type="string"
eval="constant">Contains</Parameter>.

Testing your CIM to CIM Setup

After completing all the outlined steps, you can test your CIM to CIM setup.

Procedure
1. Log in to the BrandOwner enterprise and add a record.

2. This record is synchronized to VeloselMarketPlace and to Bottlerl and Bottler2.

3. You can login to VeloselMarketPlace, Bottlerl, and Bottler2 to verify the
synchronization.
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Troubleshooting CIM to CIM

Issue Solution

In a CIM to CIM setup, when attempting to import This problem may be seen if you are on an
over 100 records, you may get a "No data to read Oracle 11 version lower than 11.1.0.7 (for
from socket" error. DB Error code: 17410. example, 11.1.0.6). Try updating to 11.1.0.7.
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Supplier and Retailer Setups

You can use Supplier and Retailer side setups to create Supplier and Retailer Enterprise in
TIBCO MDM.

Supplier Setup
You can use this setup to create and define an enterprise.

You can also select and define a repository for messages.

Creating Supplier Enterprise

Procedure
1. Log in to the tibcocim enterprise with superuser credentials.

2. Select Administration > All Company > Profiles.
a. Click Create and create a new Profile with Type as Supplier.

b. Create a user for the enterprise with Administrator and Work Supervisor
Roles.

3. Log out of the enterprise.

Defining Supplier Enterprise

You can define credentials, subscribe to the datapool, define the Synchronization Format,
and set up trading partners. 1Sync is used as an example here.

Procedure
1. Log in to the newly created enterprise with the created user credentials.

2. Select Administration > My Company Profile.

a. Click the Create link in the Credentials section.
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b. Create a Credential with Domain as GLN and provide your Supplier GLN as the
Identity.

3. Select Administration > Datapool Profiles.
a. Subscribe to 1Sync by clicking the Subscribe link in the Actions column.
b. Click Modify in the Actions column.
c. Click Modify again under Supported Synchronization Formats.
d. Select 1Sync from the list of Synchronization Formats. Click Save.
4. Select Administration > Trading Partner Profiles.
a. Click Create to create a new Trading Partner.

b. Provide details to create the Trading Partner and select 1Sync as the Default
Synchronization Format. Click Save.

c. In newly created Trading Partner Profiles, click on Modify.
d. Select 1Sync as the Datapool. Click Save.
e. Click the newly created trading partner in the trading partner list.

f. Click the Extended Credentials link against the 1Sync in the Datapool
Participation section.

g. Click Create to create a credential.

h. Select Domain as GLN and provide the GLN of the trading partner as the
Identity.

i. Click Save.

5. Select Administration > My Company Profiles.
a. Click the Credentials link against 1Sync in the Datapool Participation section.
b. Click Create to create a credential.

c. Select Domain as GLN. The Supplier GLN is populated in the Identity drop-
down list.

d. Specify the Batch User ID, User ID, and Password for the Supplier GLN.

e. Click Save.
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Note: TIBCO MDM supports more than one GLN in an enterprise. You can create
more than one GLN in an enterprise.

Defining Repository for Outgoing Messages

You can create or define the repository that messages will go out from.

Procedure
1. Deploy repository model from TIBCO MDM Studio containing the 1Sync output map
and UDEX and GPC classification schemes.
For more information about creating repositories, see TIBCO MDM Studio Repository
User’s Guide.

2. (Optional step) Perform this step to use out-of-the-box catalog validation file of
TIBCO MDM. The file contains some predefined validations associated with datapool
validations.

a. Navigate to $MQ_COMMON_DIR/standard/rulebase.

b. Copy the _1sync_mastercatalog_catalogvalidation.xml rulebase file and
place it into the $MQ_COMMON_
DIR/enterprise/catalog/master/repositoryID folder.

c. Rename the file as catalogvalidation.xml.

Selecting Repository for Incoming Messages

You can select the repository to which messages from the retailer side should be directed.

Procedure
1. Log in with the Supplier credentials.

2. Create a Business Process Rule to select the repository for the Add Notification
event. To create a Business Process Rule, follow these steps:

a. Click Business Processes, then click the Repository Selection rule.
b. Click the Default business process template and click Create.

c. Select Conditions > the trading partner name is, and then select your trading
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partner (specify the trading partner name only if you want messages from
different trading partners to be added to partner specific repositories).

d. Select Conditions > The UDEX Code is, and then select your defined UDEX
code or select Any.

e. Select Actions > The repository to add the record to, and then select your
repository.

f. Select Actions > Treat new CINs as ’data change’ messages, and then select
Yes, consider it as changes.

g. Click Save.

Retailer Setup
You can use this setup to create and define an enterprise.

You can also select repository, approvers, and editors for records.

Creating the Retailer Enterprise

Procedure
1. Log in to the tibcocim enterprise with superuser credentials.

2. Select Administration > All Company Profiles.
a. Click Create and create a new Profile with Type as Retailer.

b. Create a user for that enterprise with Administrator and Work Supervisor
Roles.

3. Log out of the enterprise.

Define the Retailer Enterprise

The Retailer side setup is similar to the Supplier setup. See Supplier Setup.

The only difference is the GLN definition. For example:
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Case 1

If the Supplier and Retailer is TIBCOCIM, then on the Retailer side, follow these steps:

o When defining the GLN in the Company Profile, provide the Trading Partner GLN of
the Supplier.

o When defining the Trading partner GLN, provide the Supplier GLN defined in the
Company Profile.

Case 2

If the Supplier is not TIBCOCIM, then on the Retailer side, follow these steps:
o Define the GLN of the Retailer in the Company Profile.
o Define the Supplier GLN in the Trading Partner’s GLN.

o Note: TIBCO MDM supports more than one GLN in an enterprise. You can create
more than one GLN in an enterprise.

Selecting Repository for Incoming Messages

You can select the repository to which messages from the supplier side should be
directed.

Procedure
1. Log in with the Retailer credentials.

2. Create a Business Process Rule to select the repository for the Add Notification
event. To create a Business Process Rule, follow these steps:

a. Click Business Processes, then click the Repository Selection rule.
b. Click the Default business process template and click Create.

c. Select Conditions > the trading partner name is, and then select your trading
partner (specify the trading partner name only if you want messages from
different trading partners to be added to partner specific repositories).

d. Select Conditions > The UDEX Code is, and then select your defined UDEX
code or select Any.

e. Select Actions > The repository to add the record to, and then select your
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repository.

f. Select Actions > Treat new CINs as ’data change’ messages, and then select
Yes, consider it as changes.

g. Click Save.

Selecting Approvers for Received Records

You can set up a rule for approvers of received records.

Procedure

1. Click Business Processes, then click the Approvers for Received Records rule.

2. Click the Default Business Process Template. Click Create to create a new rule.

3. Under Conditions > the trading partner name is, and then select the defined trading
partner.

4. Select Actions > Set the participant user to, and then provide the user information.

5. Select Actions > Set the next work item state to, and the define the next state of
the workitem. For example, you can set the workitem state to Final Step.

6. Click Save.

Selecting Editors for Received Records

You can set up a rule for editors of received records.

Procedure

1.
2.
3.

Click Business Processes, then click the Editors for Received Records rule.
Click the Default Business Process Template. Click Create to create a new rule.

Select Conditions > the trading partner name is, and then select the defined trading
partner.

Select Actions > Set the participant user to, and then provide the user information.

Select Actions > Set the next work item state to, and then define the next state of
the workitem. For example, you can set the workitem state to Final Step/Done.

TIBCO® MDM Add-on for Global Data Synchronization User's Guide



138 | Supplier and Retailer Setups

6. Click Save.

Detecting New Backend Systems

You can set up a rule to define the user or role to notify when a new backend system is
detected.

Procedure
1. Click Business Processes, then click Unknown Trading Partner Alert.

2. Click the Default Business Process Template. Click Create to create a new rule.
3. Select Actions > Set the participant user to, and then provide the user information.

4. Click Save.
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Setting up GPC Classification Scheme Data Load

Setting up the data load for the Global Product Classification scheme includes configuring
GPC Classification Scheme Loading and configuring Support for GPC Code.

Configuring GPC Classification Scheme Loading
The GPC data source is provided as out-of-the-box set up in the TIBCOCIM enterprise.

You can upload new GPC codes into CIM.

Procedure
1. Add the following dataset to the filewatcher.xml catalog.

<DataSet type="single">

<l--

There should be no MasterCatalog Element when importing a Standard
Classification Scheme such as GPC, UDEX.
-—>

<Name>DataSetS2</Name>

<Credential domain="Z7z">

<!-- This is a pre-defined credential-->
<Identity>GLOBAL</Identity>

</Credential>
<Action>ImportClassificationScheme</Action>
<URIInfo scheme="local">
<Relative>MQ_COMMON_DIR</Relative>

<!-- This directory 1is created outOfBox -->
<URI>velosel/GPC</URI>

</URIInfo>

<Incremental>Yes</Incremental>

<DataSource>

<RevisionID>

<!-- This a pre-defined data source 1in Velosel enterprise -->
<BaseName>GPC</BaseName>

</RevisionID>

</DataSource>

<ClassificationScheme>
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<RevisionID>

<!-- This a pre-defined classification scheme -->
<BaseName>GPC</BaseName>

</RevisionID>

</ClassificationScheme>

</DataSet>

2. Ensure that the following subdirectories exist under the $MQ_COMMON_
DIR/velosel/GPC/ directory.

incoming
rejected
done

3. Place the data file (.csv) in the $MQ_COMMON_DIR/velosel/GPC/incoming directory. The
.csv file is used to upload when the FileWatcher polling interval time is over. All the
rows from the .csv file are uploaded into the GPC data source. If the upload is
successful, the .csv file is copied into the done directory.

Configuring Support for GPC Code

Procedure
1. You can add GPC Dropdowns for Editing Records in a Repository.

2. For dependent drop-downs, add the following section to your catalog validation
rulebase:

<declare>
<var>GPC_classification</var>
<link type="datasource">
<literal>GPC</literal>
</1link>
</declare>
<constraint>
<name>GPC CODE</name>
<description>GPC CODE dropdown</description>
<usefor>
<var>GPC_SEGMENT_CODE</var>
</usefor>
<action>
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<select novalue="option">
<table source="classification'">
<literal>GPC_classification/SEGMENT_CODE</literal>
<literal>GPC_classification/SEGMENT_DESC</literal>
</table>
</select>
</action>
</constraint>
<constraint>
<name>FAMILY CODE</name>
<description>GPC Hierarchy Level 2 dropdown</description>
<usefor>
<var>GPC_FAMILY_CODE</var>
</usefor>
<condition>
<defined>
<var>GPC_SEGMENT_CODE</var>
</defined>
</condition>
<action>
<select novalue="default">
<table source="datasource'">
<literal>GPC</literal>
<literal>FAMILY_CODE</literal>
<literal>FAMILY_DESC</literal>
<where>
<sql>
<eq>
<literal>SEGMENT_CODE</literal>
<const type="string'">?</const>
</eq>
</sql>
<var>GPC_SEGMENT_CODE</var>
</where>
</table>
</select>
</action>
</constraint>
<constraint>
<name>CLASS CODE</name>
<description>GPC Hierarchy Level 3 dropdown</description>
<usefor>
<var>GPC_CLASS_CODE</var>
</usefor>
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<condition>
<defined>
<var>GPC_FAMILY_CODE</var>
</defined>
</condition>
<action>
<select novalue="default">
<table source="datasource'">
<literal>GPC</literal>
<literal>CLASS_CODE</literal>
<literal>CLASS_DESC</literal>

<where>
<sql>
<and>
<eq>
<literal>SEGMENT_CODE</literal>
<const type="string">?</const>
</eq>
<eq>
<literal>FAMILY_CODE</literal>
<const type="string'">?</const>
</eq>
</and>
</sql>
<var>GPC_SEGMENT_CODE</var>
<var>GPC_FAMILY_CODE</var>
</where>
</table>
</select>
</action>

</constraint>
<constraint>
<name>BRICK CODE</name>
<description>GPC Hierarchy Level 4</description>
<usefor>
<var>ADDITIONAL_CLASS_CAT_CODE</var>
</usefor>
<condition>
<defined>
<var>GPC_CLASS_CODE</var>
</defined>
</condition>
<action>
<select novalue="default">
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<table source="datasource'">
<literal>GPC</literal>
<literal>BRICK_CODE</literal>
<literal>BRICK_DESC</literal>

<where>
<sql>
<and>
<eq>
<literal>SEGMENT_CODE</literal>
<const type="string">?</const>
</eqg>
<eq>
<literal>FAMILY_CODE</literal>
<const type="string">?</const>
</eq>
<eq>
<literal>CLASS_CODE</literal>
<const type="string">?</const>
</eqg>
</and>
</sql>
<var>GPC_SEGMENT_CODE</var>
<var>GPC_FAMILY_CODE</var>
<var>GPC_CLASS_CODE</var>
</where>
</table>
</select>
</action>

</constraint>
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Configure TIBCO BusinessConnect and TIBCO
BusinessWorks

You can configure TIBCO BusinessConnect for sending documents to and receiving
documents from different data pools.

Details for configuring only TIBCO BusinessConnect to work with the application are
provided. Refer to the appropriate documentation if you want to use any other AS2
Gateway.

TIBCO BusinessConnect 5.x supports JMS, however the TIBCO BusinessWorks plug-in for
BusinessConnect 5.x is still required.

Prerequisites for configuring TIBCO BusinessConnect

o TIBCO BusinessConnect 5.3.0 must be installed on the system. See TIBCO Business
Connect documentation for details.

o A database must be installed. BusinessConnect 5.x supports Oracle, DB2, MySQL,
and SQL Server.

e TRA 5.6.1, Business Works 5.7.2, TIBCO Administrator 5.4.0, TIBCO EMS 5.1.2 must be
installed on the system.

o UserID and password to access the TIBCO BusinessConnect Admin console.

o Port 4080 or any other port on which TIBCO BusinessConnect is listening needs to
be opened.

Setting up TIBCO Administrator

Procedure
1. Install TIBCO Administrator in console mode and read the installation guide.

2. For Linux/UNIX setup, create Domain using the domain utility TIBCO_TRA_
HOME/bin/domainutility.

o Set defaults settings, give domain names as: <<DOMAIN_NAME>>/, choose UTF-
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8 for character set, default ports -> http port=9090, AJP 1.3 port =8009,
shutdown port =8005, username=admin, password=admin

o If UTF-8 does not work, change the characters to another character set

o Change the owner to vsadmin and give all the rights to the tibco folder as -

sudo chown -R vsadmin:vsadmin /home/tibco/
sudo chmod -R 777 /home/tibco

3. On Windows, you can create a new domain using Programs - > TIBCO - > TIBCO
Runtime Agent & Adapter SDK 5.5 - > Domain Utility.

4. After successfully configuring TIBCO Administrator, start TIBCO Administrator by
executing the following on Linux/UNIX platform: <<TIBCO_
HOME>>/administrator/domain/<<DOMAIN_NAME>>/bin/tibcoadmin_<<DOMAIN_
NAME>>/&

5. Start TIBCO Hawk Agent by executing the following on Linux/UNIX platform:
<<TIBCO_HOME>>/tra/domain/<<DOMAIN_NAME>>/hawkagent_<<DOMAIN_
NAME>>/&

6. For Windows installations, start TIBCO Hawk Agent as an NT service.
7. On Windows, set up TIBCO Administrator as an NT service.

8. Access the Administrator URL as:
http://<machinename>:9090/administrator/servlet/tibco_administrator

Setting up BusinessConnect

You can configure BusinessConnect by:
« Configuring BusinessConnect (new configuration)

« Importing an existing setup from another installation and customizing the imported
BusinessConnect configuration

The following criteria should be met before configuring BusinessConnect:

Procedure

1. Database and Database user. A Database (which can be used by the
BusinessConnect setup) should be configured.
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2. TIBCO EMS 5.1.2 should be installed and started as an NT service on Windows; on
Linux it should be started on root.

3. Install Unlimited Strength JCE Policy FilesTo use BusinessConnect security
features, download and install JavaTM Cryptography Extension (JCE) Unlimited
Strength Jurisdiction Policy Files 1.5.0. To download and install the policy files,
follow these steps:

o Download the required files for Windows, Sun Solaris, HP-UX, Linux, and IBM
AlX.

e Unzip jce_policy-1_5_0.zip
e Copy US_export_policy.jar and local_policy.jar to TIBCO_
home\jre\1.5.0\lib\security

4. TIBCO Administrator and TIBCO Hawk should be started.

Configuring New BusinessConnect

Procedure
1. Start TIBCO Administratorhttp://<machinename>:9090/administrator/servlet/tibco_
administratorLogin as admin/admin.

2. Check if the BusinessConnect link appears in left side panel. If not, click Application
management - > All service instance - > machine name - > Plug-Ins - > Add - and
browse to the bcwebadmin.war file of BusinessConnect. The .war file can be found
on:<<TIBCO_HOME>>/bc/5.3/admin-plugins/ bcwebadmin.warAdding the .war file
takes some time.

3. In the left side panel, BusinessConnect is available. Click BusinessConnect - >
Manage Installation.

4. Provide database details for installation and test connection for Oracle. Sample
database details:JDBC Driver: tibcosoftwareinc.jdbc.oracle.OracleDriver JDBC URL:
jdbc:tibcosoftwareinc:oracle://<oracleservername>:1521;SID=<<DATABASE_NAME>>
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TIBCO Administrator

o seplcanon Mamuparmant

Logged iono dev_be as adenin | about | Botd | Loy

Sonfiguration | tmport/Expert

Tnstallation Prafix [ ax AXBE ) ax ke

5] ew stamunt werk
b
L g Sustoassconnact Batabase Usarnama bouser
(g oot servars P p—

Supang al | Gotlipes a8 Connaction Pool tire 16

Enstalation Nama 8C-dus_be

JOBE Crivar Class | tb<osoftmareinc pibe orade, SradeDriver ~
JORE URL jdhc: tibcosofwaremnc: oracle://localhost:1521; 51D wbodb

C o ]

shangs.

Creating Participants

Procedure

1. Creating participant of type Partner

a. Click BusinessConnect - > Participants

Expand All | Collapse all
Eﬁ; User Management
o] Qi Resource Management
3 Application Domains
' g Installed Soft
[rpy) Installed Softwars
—
L !Madmu
3] [ﬁr Application Management
ﬂ: BW Manual Work

C] ‘“i BusinessConnact

a Business Agreement;

)‘E‘ Log Viewer

| %.| Opaerations Editor
| G| Participants

| R i

|l Reporting

&
[ &) svstem sattings

]
&)

[‘U UDDT Servers

Expand All | Collapse All

b. Select type of participant as Partner and create and provide a name to the

participant.

Partiipant Nama 141_¢ bt
Paicpant Trps #artnar v

on Canial

c. Provide all relevant details, click the Active check box to activate the

participant.
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Ganesl | Businass Locatiens | Cradentisls | Protadels | Preey Satnngs

Participant Hama 15yrc-A52 0065065555851
Adtive 2]
Typa Parnar

Addrass 2nd Una
Addrass 3rd Lina
e Satal Tip Coda
Cauntry LIS
Fhana (1124434267
Fax (3124632267
Emad cortomaersuppor B rnc.org
ek URL
Frimary Lagal Contact -
Primary Support Contact -

d. Click the Credentials tab.

e. Click the New Certificate tab. Provide the alias name and upload the certificate
provided by the Trading partner (Data pool in case of MDM) followed by Save.

f. Click the Protocols -Enable tab.

New Partner Participant: test_partner

Genaral | Business Locations | Credentials | Protocsls | Proxy Settings

h. Click the newly enabled protocol EZcomm as in the following page.
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I

j. Click the Add New tab to create a new AS2 ID.
k. Create new AS2 ID.

L e

L.

m. Click Transports -Add tab.
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P Earticipant: tast partnar

Edit Enabled Protocol: EZComm

0. Provide details for the newly created Transport.

‘I test_tp

‘http:/;l as2 preprod. 1sync.org:4080/exc hange/8 3801 60030003

‘I VELOSE-AS2-MME-SUBJECT

‘F I checked

‘F I checked

‘F I checked

=

|I Refore Qinminn _"I

A e Sinnen "I

‘l hitp:/#10 97 97.130:4080VEZComm

[

[3

[

‘l 300

p. Change the URL as per the trading partner specification.
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[15vNe_asz ]

httpsfi as2.preprod.1sync. /8380160030003

P —

© Comummmnn s s
© e wresies

| Genarsl | Buriness Locstions | Cradantisls | Protoes,

Default »
MTP Default |~

r. Click Save to save the participant.
2. Creating participant of type Host

a. Click BusinessConnect - > Participant.

b. Select the type of participant as Host and create and provide a name to the

participant.

c. Click the Active check box to activate the participant.
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e. Provide the alias of the key, upload the private key (public key of which has
sent to Partner) and click Save.

f. Click the Protocols tab and enable EZcomm protocol as enabled earlier to
create Partner Participant.

g. Create a new AS2 ID, clicking on the newly enabled protocol EZcomm - > AS2
Identifier - > Add new link. In AS2 Identity, provide GLN on data pool.
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ASZ Domain | ASZ_ID ¥

ASZ Tdantity

h. Click Save to save the participant.

Creating New Operations

Procedure
1. Click Business Connect - > Operation Editor.

/) TIBCO Administra

Expand All | Collapse All

@ *I. User Managerment

=] gi- Resource Managernent

[B Application Domains

[Eé Application Management
EE_[ BW Manual Work
=] E BusinessConnect
@ Business Agreement:
Log Viewer

.‘ Operations Editor

E Participants

2. Click the Edit button in the right pane for Protocol EZComm.

Prokacal | EZComm v

3. Click the radio button for EZComm protocol and then click the New > Category
button.

4. Save the new category.

TIBCO® MDM Add-on for Global Data Synchronization User's Guide



154 | Configure TIBCO BusinessConnect and TIBCO BusinessWorks

Hame TestOperation

DBascription This is » test operatiar|

5. Click the new version button to create a new version for the new category. Provide
details and Save the version.

Hame 1.0

Dasaiption Wersion 1.0

6. Click the New Operation button to create a new operation for this version.

Edit Operations: EZComm

[ expon varsion [[ev oparation [[oaiate varsion

BO0 s

@O0 pasooenton

B00 Tastossration
@8 10

7. Select the operation type as Asynchronous Request-Response and click OK.

‘Oparstion Type [TTTY

8. On the next page, enter a name for the new operation.

mew Asynchronous Request-Response Operation

Asynchranous Request-Rasponis Operation | Requast Adion | Rarponte Acion

Mama AsyncRequestResonse

Cesaiption
Jebnd

Vialidate Massage [ |

Publish SEHML Private Procass [
Meazage
Qutbound

Validate Message [

9. Click the Request Action tab and select the Require Digital Signature and Require
Content Encryption check boxes.
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Hame [request
Dasaiption
Plragtion Initistor to Respondar
Validation Schama Name - f'c changs rsmove
Raquire Digital Signature []
Raquire Content Encryption
Wait tima for Response (seconds) 1600

Eos BC Palette use only
ML Dacumant Validation | x50+

Koot XML Elemant Name

Asynchrenous Request-Response Oparation | Request Adion | Response

ction

10. Click the Response Action tab and select the check boxes as previously mentioned.

11. Click the Save button to save the newly created operation.

12. Create this operation once for all participants.

Configuring System Settings

Procedure

1. Click the BusinessConnect - > System settings menu in the left panel.

2 TIBCO Administra

Expand All | Collapse All

[I_‘_t| User Management

5] ‘l:ﬂil Resource Management
[E Application Domasins
a Installed Software
[ - Machines

“;d Application Management
“7-@] BwW Manual Work
= C! BusinessConnect

—
@ Business Agreement:

@ Log Viewer

[_1__: Operations Editor
[E Participants
[ﬂ: Reporting

2. Click JDBC Configuration in the right pane.
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3. Click JDBC Configuration to create new JDBC connection details for
BusinessConnect.

Mlisz 8C-Connection
B Brivar Class | tibcosoftwareine jobe.oracle. OracleDriver ~|
JDBC URL | il i 1521;510=bedb

Database Usemame boused
Database User Passvord zat.
Connaction Paol Sire 16

Sample database details are as follows:JDBC Driver Class:
tibcosoftwareinc.jdbc.oracle.OracleDriverJDBC URL:
jdbc:tibcosoftwareinc:oracle://localhost:1521;SID=bcdbDatabase User: bcuser
Password: bcuser

4. Click Test Connection, if the connection is successful, click Save.

Indude Massags in Log Entries
Audit Logs | be-db - Expart dudi Schama Grasts dugh Tabler

Mon Repudistion Logs | bo-db - Espart NE Schama Grasts NE Tables

Runtima Dats Store | be-db ~

5. Select the newly created BusinessConnect connection in Audit Logs, Non
Repudiation Logs, Runtime Data Store, and click Done.

Defining Business Agreement

Procedure
1. Click BusinessConnect- > Business Agreement in the left panel.

2. Click the New tab to create a new agreement.
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Select the Host party and Partner party radio buttons for which you want to make
an agreement as shown in the following page and click OK.

Mew Agreement

Click the Valid check box on the next page and provide dates for start and end of

the agreement.

JL__cancel || aeely |

This Party Tibco-Dav-0065065555951
Counter Party 1yncASI 0065065535551
valid
‘StartData |November | [1 w2007 v
End Data | 0ctober v [31 v (2010 v

Click the Add Protocol Binding tab, to add new protocol binding. Select EZComm

6.

from available protocols.
7. Click the EZComm protocol link and provide details.
8. Click the Document Security tab and select values.
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Edit Protocol Binding: EZComm

Show Advanced

Oparation Bindings | Decument Security | Transports |

Tibeo_private_key v

ste | 1Sync-PreProd-Certificate v

L e e v

Here the values should be defined as follows:Signing Key: Name of the TIBCO’s
private certificate.Digest Algorithm: MD5Encryption Certificate: Name of Trading
Partner CertificateEncryption Algorithm: Encryption algorithm used by Trading
PartnerVerification Certificate: Name of Trading Partner CertificateDecryption Key:
Name of the TIBCO’s private certificate

9. Click the Transports tab and select values.

Deploying the BusinessConnect configuration (Single Server
Mode)

Procedure
1. Deploy the configuration, click Administrator - > Business Connect - > System
Settings - > Deployment Configuration -click Create deployment Configuration.
The Business Connect link in Application Management is displayed.

2. Select a machine to deploy the Business Connect installation. Click Application
Management - > Business Connect - > Configuration - > Single Server.par. Select
the machine name. If you do not see the machine name, it may be due to the hawk
agent.

3. Select Application Management > BusinessConnect > Configuration >
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BusinessConnect > Configuration and click Save.

4. Click Application Management - > BusinessConnect - > Configuration - > Business
Connect - > HTTP

Enabla HTTP Tranipart
TP Park 4080

6. Click Application Management - > BusinessConnect - > Configuration - >
BusinessConnect.

8. Click the JMS link and provide the JMS details. After completing all the details click
Test connection to test the JMS connection. Save the details, if the test connection
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is successful.Sample details are as follows:JNDI Context Factory:
com.tibco.tibjms.naming.TibjmslInitialContextFactoryJNDI Context URL:
tcp://localhost:7222Topic Connection Factory: TopicConnectionFactoryQueue
Connection Factory: QueueConnectionFactory

** shange,

o
Quaus Connastion Factary QueusConnectionFactory
Rassnnact Max, Duration (mins) 10
Sacurad [
Vartfy JMS Sarver []
M3 Servar Certificats Hone v
Expactad JMS Server Host Hame

Strong Ciphars Only [+
Use Trace []

Connected

Initistor Raguest Quaus AX.BC.BC-day_be INITIATOR. REQUEST

Initistor Rasponse Quaus AH.BC.BC-day be
Raspondar #4,BC.BC-deu_b

Raspondar Response Quaus #4.8C.0¢-dev_boRESPONDER.RECPONSE

IHITIATOR. RESPONSE

9. Click Application Management - > BusinessConnect - > Configuration - > Business
Connect - > Deploy.

| Deploy | Revert | undegloy | Histary | Uparade |[]show deployed configuration

10. Click the Deploy Tab. Ensure the Start successfully deployed services check box is
selected.

Deploy Configuration

Start puccarsfully daployed rarvices

Daployable. {Hev)

11. Check the status of BusinessConnect availability. Click the Application Management -
> BusinessConnect - > Service Instance. The BusinessConnect instance status
displays as either stand by or running.
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12. If after the deployment, the BusinessConnect instance is not started, click
Application Management - > BusinessConnect - > Service Instance - >
BusinessConnect > Instance check box and click Start.

13. If all the actions are successful, the BusinessConnect instance should be in running
state. If the BusinessConnect instance cannot be started successfully, check the
TIBCO Administrator logs (<<TIBCO_HOME>>administrator\domain\<<DOMAIN_
NAME>>\logs\audit.txt) to find the cause.

Setting up Business Works

Prerequisites

« Before you start a BW project, create a directory as follows: <<TIBCO_
HOME>>\ fsjndi\designerExtendedJars

« Add the following JAR to this location: fscontext.jarjndi.jarproviderutil.jar
o Edit the designer.tra file located in <<TIBCO_HOME>>\designer\5.5\bin.

« Add the following entry to this file:tibco.class.path.extended %CUSTOM_CP_
EXT9%%PSP%%STD_CP_EXT%:<<TIBCO_HOME>>/fsjndi/designerExtendedJars

Procedure

1. Start TIBCO Designer.

2. Click New empty project.
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) TIBCO Designer. (A=)

.lE‘.TBJé.Ei" Administration \

New project from template
Open existing project
Reopen project

Delete project

Help Exil

[ Show this panel only on startup

3. Specify the project directory and encoding.

)) Save Project

Multi-File Project | xmL Ganan|

Project Directory: | capveFrojects |

The project directory is the directory that will contain all ofthe project
files. The name of the project will be the name of the project directory.
Designer will remove all non-project files from the Project Directory on
creationisave.

TIBCO Messaging Encoding:

Multi-User System v| Test Configuration

4. Click Project -Import Full Project.

ECN View Resources Palettes Multi-User T

Mew Project ]
Open

Reopen »
Clase Ctri+i

Save Cirl+&

Save As Cirl+Ehift+5
Save As Template

Walidate Project For Deployment. Ctrl+Shift+k

Load Full Project
Hide Library Resources

Import Full Project...

Export Full Project.
Import Resources from File, Folder, URL...
Export Resources to File...

Print Setup

Print Ctrl+p
Save As JPEG

Generate HTML Report

Exit Crl+Q

5. Import vcrepo.dat from the existing BW project directory (directory of the same
name as your existing BW configuration).

6. Alternately, if you don’t want to import the existing project, copy the existing BW
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project directory with another name. This is similar to importing the existing BW
project.

7. Edit the project as imported and copied above.

8. Change the following Global variables per the project requirement:

« bindingFile: Provide the directory location where you want to place your
binding file for this project.

« receiveFile: Provide the directory location where you want the received
messages to be saved.

o hostName: Provide the name of the participant which you configured in BC as
Participant of type Host.

o tpName: Provide the name of the participant which you configured in BC as
Participant of type Partner.

The Sample values are as follows:

Project Edit View Resources Paleftes Mult-User Tools Window Help

Ra@i DA x =Qde b EE|NuE -]

Dianlayrns "CimProtesiadi Svn-0055065555551"
--HBI DirLedger=""

~fBL DirTrace=""

MBI HawkEnabled = "false"
~HBL JmsProviderUr = "tcp:ilocalhost 7222
~-fBL JmsSsiProviderUr = "ssliocalhost 7222
Bl RemoteRvDaemon=""
fI8I RvDaemon = "tep: 7500
-HBL RvNetwork ="
~fBL RvService = "7500"
FIBI RvaHost="lacalhost'
-HBL RvaPort = "7E00"
~HBL TIBHawkDaemaon = "tep:7474"
- HBL TIBHawkNetwork = "
~HBI TIEHawkService = "7474"

Palettes | Tester || Global Variables | Project

(- HBI bindingsFile = "fle/CIBW-Proje ctsifsjndifl Bync-00B50B55556561" j

LB eventOueue = "Velosel_Guene_StandardinfgrEvent”

B hostiarme = "Tibeo-Dev-0065065555551"

MBI inhoundGueue = "elosel_Glueue_Slandardinboundintarisg”

- HBL outbound Queue = "Velosel_Queus_StandardOuthoundimgritsy’

%1 parseOutboundmsg = "false”

; L receivedFile ="CJBW-Projects/CimProcesses1 Sync-0065065555551 ireceived/receive X
“| &I tprame = "1 Sync-A52-83801 60030003"

9. Click Project Tab -Shared Connection.

10. If you already have a BusinessConnect connection configured, update the
connection.

11. Click the ‘Update from Configuration stores’ button.
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Bt B ots Wngow Holp

CaBibax=0derHE

= (3 CimProcessest Sync- 1085085555551 i /Shared Gonnsctions DIE
5 CJAESChamas

BCSererConts | JUS Connectise

Tt MG Connechen
& () sharea Frocasses
i "

cheens
Protass Detnson
racens

e
T5 ransorwxaLTasa
T LT Fenst

PaiBes Testi DVanatias | Preject

T BCSarverCanfig (BusinessConnect Connection) £ = ]
Configuralon | Budines i Connde! Ganae Accass | JWS)

Mg BCBANGIConRY

Deszripton: A

Updata Traspee Setings. (2]

i O

12. Select the Select operations check box; click OK on the next page.

Select operations to import for protocol: EZComm

TRl Neng

BC/1.DiNotify
Devoperation!! .0iAsyncRequestResponseCperation
[¥] TestOperation/ DifsyncRequestResponse

13. Click the Import selected Business Protocol button.

14. Click the BusinessConnect Server Access tab.

1 BCServerConfig (BusinessConnect Connection) ) .| [w)]
Configuration | BusinessConnect Server Access | Jus|
JDBCDriver.  tibcosoftwareinc jdbe.oracle.Oracle Driver v
JDBC URL: jdbetibcosoftwareing oracleocalhost 1521, 8I0=bedb
DB User: [beuser
DB Password: | =r=+

[ update from Configuration Stre Impont Selected Business Protoco

20Matdam £

15. Click Update from Configuration Store followed by the Import Selected Business
Protocol button.

TIBCO® MDM Add-on for Global Data Synchronization User's Guide



165 | Configure TIBCO BusinessConnect and TIBCO BusinessWorks

16. Click the JMS tab of the previous page.

17. Click Update from Configuration Store followed by the Import Selected Business

Protocol button.

18. If you have created a new BusinessConnect connection, ensure the property ‘Server
Details’ of all the activities point to a valid BC connection. A sample activity ‘Send
Request to TP’ of process ‘Send to TP Process’ is as follows:

MuibUser Tocks Yindow Help

Cetntion

Ba@EDix 5042k EEKEELHEE S

= £3 Cenrocessest B 085005555551

i & LY AESchamas
£ BeSchamas

= S processes
3 = 5 inbouna
] S eceie ganessl aroes
E - Recinnd i dip! " fogen TP
) - Freeime e eip! Ul ¢
2 S Receiv rusgonse homs TP () Ll
& & Fecewe securty e ———
= 5 5 Outbound
g & Send 10 TP prockss~
5
i
2

rcesa
p———
T LT ot

Haeng,

Cenfiguranan | mout| Output | Erer Cutpul

Descripion: ¥
[os— nar CoseassonsCsmecorageese | (80 (g) @]
Opacason Hame: e ooty -
Parsa 0L Pavioad a]

Gemtrats Uriras Transacton 0. (7]

untWar fr Resgpenss =

GG

Sand Requestio TP

B i

19. Start the test engine by clicking the Tester tab on the left followed by a green start

signal.

)) Select Processes to Load

@ CimProcesses! Sync-0065065555551
El-a Processes
Inboung
£y Receive general errars
Receive receipt error from TP
Receive receipt timeout errars
Receive response from TP (1)
i [7] & Receive security errars
=5 Outhound
:. Send to TP process(currenty
@ Shared Processes
E £+ Process Definition

Select Al
Clear Al
Save

Advanced

Load Selected
Load & Start Current

Cancel

LG

20. Click Load selected.

21. After a successful start,

all processes should be visible.
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) 1Bco 0w Syme 00803551

Erowet E00 Yiew EOSOUICES PaaDES NUB-Uid 00 YWNOOW HOW

Lol bdxs0d2pBE Do ERHEE-S
ol -1 EEE

BT |

feadrse  Transiorm MML

Configuraton | Quiput Eanse| Outped | Eror Outpat

& D O

Testing the MDM-BusinessWorks-BusinessConnect
Connectivity

Procedure

1.
2.

10.

Have a ready-to-publish catalog in MDM.

In TIBCO Designer, ensure the BW tester is running, check for
Processes\Outbound\Send To TP Process, and all setup done.

The Binding file accessed by the BW setup should have the IP of the machine from
where testing has to be done.

The BC engine should be running and all setups should be done. Open TIBCO
Administrator.

Publish the product from MDM.

Check BW for Processes\Outbound\Send To TP Process, whether the message
received, as the activities flow shows green.

Check TIBCO Administrator for BusinessConnect, in Log Viewer, for a Audit Logs, for
selected time range, whether the message reached and whether the message went
out to the trading partner.

Check for acknowledgment from the datapool.
Check for response in BusinessConnect, BusinessWorks and MDM eventLog.

TIBCO BusinessConnect EZComm Protocol does not record advisory messages, such
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as the Responder Acknowledgment, in the audit log.
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GDSN Predefined Components - An Overview

The out-of-the-box GDSN components are provided in the $MQ_
HOME/plugins/gdsn/version/common/standard folder. You can see these components if
you have the GDSN plug-in installed. The available components are maps, rulebases,
workflows, and templates.

Note: Do not modify the GDSN components supplied in this directory. If a
modification is required, maintain the modified file in an enterprise-specific
directory.

GDSN-Specific Rulebases

This section introduces you to rulebases specific to GDSN provided in the $MQ_
HOME/plugins/gdsn/version/common/standard/rulebase folder.

GDSN-Specific Rulebases

File Description

_1sync_catalogvalidation.xml This rulebase declares validation rules for out-of-the-box
catalog synchronization for 1Sync datapool.

-lsync_mastercatalog_ This rulebase declares validation rules for the master

catalogvalidation.xml catalog used in synchronization having 1SYNC catalog
output map.

rbapprover.xml This is an empty rulebase which is used in the workflow

wfin26prodnotifretailerv4.xml to flag any errors or
warnings in the incoming message data. This rulebase
should be customized as per your business process

needs.
rzconneitorpmtocower"Vat"°n— This rulebase decides the protocol to be used by the
gasn.xm message handler for outgoing messages or the response
handler for incoming messages.
rbconnectorrolederivation.xml This rulebase decides the protocol to be used by the
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File

rbduplicate.xml

rbeditor.xml

rbformatattributes_gdsn.xml

rbgdsnrelationship.xml

rbGPCClassificationscheme.xml

rbresponsehandlerprotocolderivation_
gdsn.xml

rbretailerval.xml

rbsendmessage_gdsn.xml

Description

message handler for outgoing messages or the response
handler for incoming messages.

This rulebase provides a sample duplicate check
constraint for incoming messages. The sample rulebase
is used to implement a duplicate check for GDSN
incoming messages.

This is an empty rulebase which is used in workflow
wfin26prodnotifretailerv4.xml and other incoming
message processing workflows to flag any errors or
warnings in the incoming message data. This rulebase
should be customized as per your business process
needs.

Format specific attributes to be used for a marketplace.

This rulebase is used to identify the relationship to be
used in the GDSN edition.

This rulebase drives the classification codes for the GPC
predefined classification scheme.

This rulebase is used to identify the protocol used for
message processing.

This is a sample retailer validation rulebase.

The generic page is available from the Product View page,
where there is an actions link for SendMessage based on
the user privileges (Role). The Ul that opens on clicking
this link is completely customizable based on the
underlined rulebase rbsendMessage.xml, Currently, it is
used to send an RFCIN message and generate a fact
sheet.

The following customizations are possible:

o Customize the product attributes that can be
displayed.

o Customize actions that can be performed.

o Customize the MarketPlace and TradingPartner
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File Description

Credentials.

o Customize the user defined attributes.

rbsyncstatusupdatederivation.xml This sample rulebase is used to customize the manual
synchronization status update action.

rbtolerance.xml Permissible values for attributes are defined in this
rulebase.

rbtransorasupplier.xml This rulebase identifies different sync operations for the
1SYNC datapool.

rbUDEXClassificationscheme.xml This rulebase derives the classification codes for the

UDEX predefined classification scheme.

rbworkitemdescription_gdsn.xml This rulebase derives out-of-the-box workitem
descriptions for the GDSN edition.

rbcim2cimsupplier.xml This rulebase identifies the operation state machine for
CIM to CIM supply side.

GDSN-Specific Forms

This section introduces you to forms specific to GDSN provided in the $MQ_
HOME /plugins/gdsn/version/common/standard/forms folder.

GDSN-Specific Forms

File Description

fmretailer.xml  ysed to populate retailer information on retailer side

GDSN-Specific Workflows

This section introduces you to workflows specific to GDSN provided in the $MQ_
HOME /plugins/gdsn/version/common/standard/workflow folder
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GDSN-Specific Workflows
File

wfin26RFCINv2.xml

wfin26catsynchv7_gdsn.xml

wfin26cim2cimsyncVl.xml

wfin26proddatanotifbasicv2.xml

wfin26prodnotifbasicv3.xml

wfin26prodnotifprocessv2.xml

wfin26prodnotifretailerv4.xml

wfin26prodnotifv2.xml

wfin26catactionRFCINv2.xml

wfoutlsync62cic26vl.xml

wfoutveloselcin26v2.xml

wfoutlsync65cin26v1.xml

Description

The workflow to receive and process publication request
(RFCIN) for suppliers.

The workflow to initiate synchronization with datapool or
custom channel.

CIM to CIM synchronization workflow.

The incoming record notification workflow for, primarily, data
add/change messages. Recommended for GDSN retailers and
similar usage where the received data needs to be processed
and saved.

The incoming record notification workflow, primarily, for data
publication messages. It is a variation of
wfin26proddatanotifbasicv2.

The workflow to process the incoming record message and save
data.

The workflow to process the incoming record message and save
data. It is a variation of wfin26prodnotifprocessv2 targeted
towards datapools and integration hubs.

The workflow to receive a notification of a response for a
previous synchronization request sent. The notification is issued
by CIM when a response is received and processed.

The workflow to implement initiation of publication request
(RFCIN) for retailers.

The workflow to translate the incoming 1Sync CIC message to
an mIXML format.

The workflow to translate the incoming CIM2CIM message to an
mIXML format.

The workflow to translate the incoming 1Sync CIN message to
an mIXML format.
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GDSN-Specific Maps

This section introduces you to translation maps specific to GDSN provided in the $MQ_
HOME/plugins/gdsn/version/common/standard/maps folder.
GDSN-Specific Maps

File Description

mpfromlsync62cicwlto26vl.xsl This XSLT translates an incoming CIC message (1SYNC
Iltem Authorization Response) to the mIXML format.

mpfromcatact26tolsync65vl.xsl This XSLT translates an outgoing mIXML message to the
1Sync Catalog Request message format (1SYNC Item
Maintenance message).

mpfromcatact26tononebxml70vl.xsl This sample map file generates a non-ebxml outbound
message.
mpfromcatact26toveloselcinvl.xsl This file translates the outgoing mIXML messages to a

message format used in CIM-to-CIM synchronization.

mpfromcatact26toveloselcinvl_all_ This file translates the outgoing mIXML messages to the

Attributes.xsl message format used in CIM-to-CIM synchronization. It
maps all the catalog attributes rather than filtering out
EAN.UCC format specific attributes.

mpfromveloselcintoveloselcinrvl.xsl  This file is used in CIM-to-CIM synchronization to generate
a response for an incoming message.

mpfromveloseltomlxml26vl.xsl This file translates an incoming message to the mIXML
format during CIM-to-CIM synchronization.
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Error Messages

Errors are classified depending on the category type of error and a description is provided
for each error code. This section lists the GDSN-specific error messages.

Rulebase Errors

Rulebase Errors

MDM
Error
Code

RB-1110

RB-1111

RB-1112

RB-1113

RB-1115

Error Description

Synchronization profile $Catalog$ is being synchronized with retailer $TradingPartners.
Approval required. (<Parameter name='"RECORD_COUNT'/> records.)

Synchronization profile $Catalog$ is validated for synchronization with retailer
$TradingPartnerS. Review required. (<Parameter name='"RECORD_COUNT'/> records.)

Synchronization profile $Catalog$ is being synchronized with trading partner
$TradingPartnerS$. Approval required. (<Parameter name='RECORD_COUNT'/> records.)

Synchronization profile $Catalog$ is validated for synchronization with trading partner
$TradingPartner$. Review required. (<Parameter name='"RECORD_COUNT'/> records.)

A message was received for which the trading partner identified by <Parameter
name='CUSTOM_DOMAIN'/> <Parameter name='"CUSTOM_GLN'/> was not recognized.
Actions required.

Miscellaneous Errors

This section contains GDSN-specific errors in the Rulebase (RUL), General (GEN), and
Service (SVC) categories.
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Miscellaneous Errors

MDM Error
Code

RUL-4620

GEN-7073

GEN-7218

GEN-7229

SVC-11013

SVC-11046

Error Description

Action Type must be either IRulebase.ELEM_ACTION_TYPE_THEN or
IRulebase.ELEm_ACTION_TYPE_ELSE.

Application shutting down. Internal error.

Delete datapool <Parameter name='"NAME'>?

Synchronization format is default format for trading partner.

Unsupported record state <Parameter name='"RECORD_STATE'"> specified for entity
object.

Cannot initiate workflow.

Administration Errors

Administration Errors

MDM
Error
Code

ADM-3005

ADM-3033

ADM-3315

ADM-3326

ADM-3328

ADM-3329

ADM-3330

Error Description

Invalid value <Parameter name="VALUE'> specified. Cannot generate Check digit.
No trading partners found.

Not subscribed to datapool.

<Parameter name='TYPE'> of company cannot have trading partners.

Global trading partner name <Parameter name='NAME"> already used within same
enterprise. Specify unique name.

Private trading partner name <Parameter name='NAME"> already used within same
enterprise. Specify unique name.

Global trading partner name <Parameter name="NAME"> used in another enterprise.
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MDM
Error
Code

ADM-3331

ADM-3332

Error Description

Name should be unique across all enterprises.

Private trading partner name <Parameter name="NAME"> used in another enterprise.
Provide a unique name.

Trading partner name <Parameter name='"NAME"> already used.

Catalog Errors

Catalog Errors

MDM
Error
Code

CAT-
1068

CAT-
1069

CAT-
1201

CAT-
1202

CAT-
1203

CAT-
1247

CAT-
1271

CAT-

Error Description

No credentials for Trading partner <Parameter name="VALUE'> (<Parameter
name='VARIABLE">) defined on <Parameter name="'VARIABLE2'">,

Datapool or trading partner credentials not provided. Correct and re-try.

Organization currently not subscribed to any datapools. Ensure subscription to at least
one datapool before attempting to synchronize.

Synchronization profile associated with datapool <Parameter name="NAME'> not
subscribed by your organization. Subscribe to the specified datapool first.

Already subscribed to this datapool.
Associate GPC/UDEX classification scheme with repository for synchronization with
predefined datapools.

Invalid synchronization profile; Trading partner <Parameter name='NAME"> deleted.

Synchronization format <Parameter name='"VALUE2'> not supported by Datapool
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MDM
Error
Code

1279

CAT-
1280

CAT-
1293

CAT-
1304

CAT-
1305

CAT-
1306

CAT-
1307

CAT-
1308

CAT-
1309

CAT-
1310

CAT-
1311

CAT-
1312

CAT-
1313

CAT-

Error Description

<Parameter name="VALUE'>.

Repository does not support output formats of datapool <Parameter name='"VALUE'>.

Warning: <Parameter name='"VALUE"> with relationships.

Cannot load Synchronization profile '<Parameter name='"NAME'>".

Synchronization profile <Parameter name='VALUE'>.

Synchronization profile <Parameter name='"VALUE'> (<Parameter name='VALUE2'> items).

Synchronization profile <Parameter name='"VALUE'> (<Parameter name='"VALUE2'> items)
synchronization with <Parameter name="VALUE3'>.

Synchronization profile <Parameter name='"VALUE'> (<Parameter name='"VALUE2'> items)
synchronization on <Parameter name="VALUE3'>.

Synchronization profile <Parameter name='VALUE'> synchronization with <Parameter
name="VALUE3'>.

Synchronization profile <Parameter name="VALUE'> synchronization on <Parameter
name="VALUE3'>.

Preview of synchronization profile <Parameter name='VALUE'> (<Parameter
name='VALUE2'> items).

Validation of synchronization profile <Parameter name='VALUE'> (<Parameter
name='VALUE2'> items).

Iltem <Parameter name='"VALUE"> added to repository <Parameter name="VALUE2'>.

ltem <Parameter name='VALUE'> changed in repository <Parameter name='"VALUE2'>.
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MDM
Error
Code

1314

CAT-
1315

CAT-
1316

CAT-
1317

CAT-
1318

CAT-
1319

CAT-
1320

CAT-
1321

CAT-
1322

CAT-
1323

CAT-
1324

CAT-
1325

CAT-
1326

CAT-

Error Description

ltem <Parameter name='VALUE'> deleted in repository <Parameter name="VALUE2'>.
Conflicts in item <Parameter name='"VALUE'> in repository <Parameter name='"VALUE2'>,
Action required.

Synchronization profile <Parameter name="VALUE"> synchronization with <Parameter
name="VALUE3'> on <Parameter name='VALUE4'>.

Synchronization profile <Parameter name='VALUE'> (<Parameter name='VALUE2'> items)

synchronization with <Parameter name='VALUE3'> on <Parameter name='VALUE4">,

On <Parameter name='VALUE3'">.

[tem <Parameter name='VALUE'> added <Parameter name='VALUE3'">.

Iltem <Parameter name='VALUE'> changed <Parameter name='VALUE3'>.

Item <Parameter name='VALUE"> deleted <Parameter name='VALUE3'">.

[tem <Parameter name='VALUE"> corrected <Parameter name='VALUE3'>.

Item <Parameter name="VALUE'> pending <Parameter name='VALUE3'>.

ltem <Parameter name="VALUE'> pending with <Parameter name='"VALUE2'> <Parameter

name='VALUE3'>.

ltem <Parameter name='VALUE'> pre-authorized <Parameter name="VALUE3'>.

ltem <Parameter name='VALUE'> pre-authorized by <Parameter name='"VALUE2'>
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MDM
Error
Code

1327

CAT-
1328

CAT-
1329

CAT-
1330

CAT-
1331

CAT-
1332

CAT-
1333

CAT-
1334

CAT-
1335

CAT-
1336

CAT-
1337

CAT-
1338

CAT-
1339

CAT-

Error Description

<Parameter name='VALUE3'>.

Item <Parameter name='VALUE"> authorized <Parameter name='VALUE3'">.

Iltem <Parameter name='VALUE'> authorized by <Parameter name='"VALUE2'> <Parameter
name="VALUE3'>.

[tem <Parameter name='VALUE'> deleted <Parameter name='VALUE3'>.

Iltem <Parameter name='"VALUE'> deleted by <Parameter name="VALUE2'> <Parameter
name='VALUE3'>.

ltem <Parameter name='VALUE'> rejected <Parameter name="VALUE3">.

Iltem <Parameter name='VALUE'> rejected by <Parameter name="VALUE2'> <Parameter
name='VALUE3">.

I[tem <Parameter name="VALUE'> publication requested <Parameter name="VALUE3'>.
I[tem <Parameter name='"VALUE"> publication requested by <Parameter name='VALUE2'>
<Parameter name="VALUE3'>.

Iltem <Parameter name='VALUE'> load requested <Parameter name='VALUE3'>.

Iltem <Parameter name='VALUE'> load requested to <Parameter name="VALUE2'>
<Parameter name='VALUE3'>.

Iltem <Parameter name='"VALUE"> published <Parameter name='VALUE3">.

I[tem <Parameter name='"VALUE"> published to <Parameter name="VALUE2'>.

ltem <Parameter name="VALUE'> changed <Parameter name="VALUE3">.
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MDM
Error
Code

1340

CAT-
1341

CAT-
1342

CAT-
1343

CAT-
1344

CAT-
1345

CAT-
1346

CAT-
1347

CAT-
1348

CAT-
1349

CAT-
1350

CAT-
1351

Error Description

ltem <Parameter name="VALUE'> changed to <Parameter name="VALUE2'> <Parameter
name='VALUE3">.

[tem <Parameter name='VALUE'> de-listed <Parameter name='VALUE3'>.

[tem <Parameter name='VALUE'> de-listed from <Parameter name='VALUE2'> <Parameter
name='VALUE3'>.

[tem <Parameter name='VALUE"> withdrawn <Parameter name='VALUE3'>.

[tem <Parameter name='VALUE'> withdrawn from <Parameter name='VALUE2'>
<Parameter name='VALUE3'>.

[tem <Parameter name='VALUE'> loaded <Parameter name='VALUE3'>.

Item <Parameter name='VALUE'> loaded to <Parameter name='VALUE2'> <Parameter
name='VALUE3'>.

[tem <Parameter name='VALUE'> corrected <Parameter name='VALUE3'>,
[tem <Parameter name='VALUE"> corrected to <Parameter name='VALUE2'> <Parameter
name="VALUE3'>.

[tem <Parameter name='VALUE'> not received <Parameter name="VALUE3'>.

Iltem <Parameter name='VALUE'> not received by <Parameter name='VALUE2'>
<Parameter name="VALUE3'>.
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GDSN Samples

The GDSN samples are located in the $MQ_
HOME /plugins/gdsn/version/common/standard/samples folder.

TIBCO® MDM Add-on for Global Data Synchronization User's Guide



181 | WorldSync Samples

WorldSync Samples

The GDSN-specific 1WorldSync samples are:
o mixml indoc (supplier)
e sync messages (retailer)

e sync messages (supplier)

mlxml indoc (supplier)

These samples are located in the $MQ_

HOME /plugins/gdsn/version/common/standard/samples/1Sync/mlxml indoc/Supplier
folder:

Add_Cancel.xmlAdd_Correct.xmlAdd_Discontinue.xmlAdd_New.xmlAdd-
Reinstate.xmlLink.xmlLink-UnLink.xmlPublish_New.xmlPublish-Reload-copy.xmlPublish-
Reload-original.xml

These internal MDM messages are converted to 1WorldSync datapool format.

These are MDM specific internal formats for the corresponding sync
operation/suboperation selected in the synchronization profile/workitem or send
response/message pages.

The naming convention for the sample files is OPER_SUBOPER. xm1, where OPER is the
operation selected in synchronization event, SUBOPER is the suboperation selected in
synchronization event. For details of operation and suboperation, see MDM Operations for
1WorldSync Messages (Supplier Operations).

sync messages (retailer)

These samples are located in the $MQ_

HOME /plugins/gdsn/version/common/standard/samples/1Sync/sync messages/Retailer
folder.
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1WorldSync Samples: Sync Messages (Retailer)

File name

CICR.xml

CINR.xml

CIN-Hierarchy-
New.xml

CIN-Hierarchy-
Correction.xml

CIN-
singleRecord-
New.xml

CIC_RECEIVED.xml

CIC_REJECTED.xml

CIC_REVIEW.xml

CIC_
SYNCHRONISED.xml

Item Cancel.xml

Item Delete.xml

Item
Discontinue.xml

Description

Catalog Item Confirmation Response (CICR) received from Datapool in response
to CIC messages.

This message is sent by CIM in response to CIN.

This new or initial load message is received from Datapool when the supplier
publishes the hierarchy for the retailer.

This correction message is received from Datapool when the supplier publishes
the hierarchy for the retailer.

This new or initial load message is received from Datapool when the supplier
publishes single record for the retailer.

The CIC message with status as RECEIVED sent by retailer in receipt of CIN. By
default, this is sent by CIM or by the retailer on clicking the send response link
on the Record View page.

The CIC message with status as REJECTED sent by retailer in receipt of CIN. This
message is sent when a user takes action on authorization work item and
selects Reject Notification or by the retailer on clicking the send response link
on the Record View page.

The CIC message with status as REVIEW sent by retailer in receipt of CIN. This
message is sent when user takes action on authorization work item and selects
Review Notification or by the retailer on clicking the send response link on the
Record View page.

The CIC message with status as SYNCHRONISED sent by retailer in receipt of
CIN. This message is sent by the retailer on clicking the send response link on

the Record View page.

When the supplier publishes the hierarchy for the retailer with CancelDate
populated, this correction message is received from Datapool.

This delete message is received from Datapool when the supplier publishes the
delete operation for the retailer.

When the supplier publishes the hierarchy for the retailer with DiscontinueDate
populated, this correction message is received from Datapool.
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File name

RFCIN.xml

RFCINR.xml

Description

The RFCIN message sent by the retailer with isReload set as true or false.

This message is sent on selecting the Send Message link on the Record View
page. The Include Rejected Record option should be selected or cleared.

Request For Catalog Item Notification Response (RFCINR) received from
Datapool in response to RFCIN messages.

sync messages (supplier)

These samples are located in the $MQ_
HOME /plugins/gdsn/version/common/standard/samples/1Sync/sync messages/Supplier

folder.

1WorldSync Samples: Sync Messages (Supplier)

File name

Add_New.xml

Add_Correct.xml

Add_
Discontinue.xml

Add_Cancel.xml

Description

ITEM ADD message is sent for
the new records added but not
synchronized to the datapool.

ITEM CORRECTION message
having values for the modified
records.

ITEM CORRECTION message
having discontinueDate
populated for the records, which
have to be discontinued.

ITEM CORRECTION message
having cancelDate populated for
the records, which have to be
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Operation Selected on

Synchronization Profile

Incremental

Yes

Incremental

Yes/No

Incremental

Yes/No

Incremental

Yes/No

Deliver
To

Datapool

Deliver
To

Datapool

Deliver
To

Datapool

Deliver
To

Operation

Add

Operation

Data
Correction

Operation

Data
Correction/

Discontinue

Operation

Data
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File name

Add-Reinstate.xml

Link.xml

Link-UnLink.xml

Publish_New.xml

Publish-Reload-
original.xml

Publish-Reload-
copy.xml

Description

canceled.

ITEM CORRECTION message not
having cancelDate or
discontinueDate for the records
that were canceled or
discontinued.

ITEM LINK ADD message sent to
1WorldSync if a new relationship
for the parent record or change
in relationship of parent record
is detected.

ITEM LINK DELETE message sent
to 1WorldSync when a
relationship change of parent
record is detected.

PUBLICATION ADD message of
New type sent to the retailer, for
example, Trading Partner.

PUBLICATION ADD message of
New type, sent to the retailer,
for example, Trading Partner.

PUBLICATION ADD message of

Operation Selected on

Synchronization Profile

Incremental

Yes/No

Incremental

Yes/No

Incremental

Yes/No

Incremental

Yes/No

Incremental

Yes/No

Incremental

Datapool

Deliver
To

Datapool

Deliver
To

Datapool

Deliver
To

Datapool

Deliver
To

Trading
Partner
on
Datapool

Deliver
To

Trading
Partner
on
Datapool

Deliver

Correction/

Cancel

Operation

Data
Correction/

Reinstate

Operation

Add/Data
Correction

Operation

Add/ Data
Correction

Operation

Add/ Publish

Operation

For RELOAD-
ORIGINAL-
Initial Load+
Include
Rejected
Records

Operation
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File name Description Operation Selected on
Synchronization Profile

InitialLoad type, sent to the Yes/No To For RELOAD-
retailer, for example, Trading COPY: Initial
Partner. Trading  Load
Partner
on
Datapool
CIC_REVIEW.xml Catalog Item Confirmation None None None

message of the Review type
received from Datapool initiated
by retailer or Trading Partner.

This is an incoming message.

CIC_RECEIVED.xml Catalog Item Confirmation None None None
message of the Received type
received from Datapool initiated
by retailer or Trading Partner.

This is an incoming message.

CIC_REJECTED.xml  Catalog Item Confirmation None None None
message of the Rejected type
received from Datapool initiated
by retailer or Trading Partner.

This is an incoming message.

CIC_ Catalog Item Confirmation None None None
SYNCHRONISED.xml  message of the Synchronised

type received from Datapool

initiated by retailer or Trading

Partner.

This is an incoming message.
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cim2cim metadata

This section contains the details of GDSN-specific cim2cim metadata samples located in
the $MQ_HOME /plugins/gdsn/version/common/standard/samples/cim2cim metadata

folder.

cim2cim Metadata Samples

File name

Bottlerl-MetaData.jar

Bottler2-MetaData.jar

BrandOwner-MetaData.jar

VeloselMarketplace-
MetaData.jar

Description
Bottlerl-specific repository and Business Process Rules are created.
Bottler2-specific repository and Business Process Rules are created.

Brandowner-specific repository and Business Process Rules are
created.

VeloselMarketplace-specific repository and Business Process Rules
are created.
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Legal and Third-Party Notices

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH EMBEDDED
OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR PROVIDE LIMITED
ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE EMBEDDED OR BUNDLED
SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY OTHER TIBCO SOFTWARE OR FOR
ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS OF A
LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE
AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER
LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE
SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH SOFTWARE
LICENSE AGREEMENT OR CLICKWRAP END USER LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN
THE “LICENSE” FILE(S) OF THE SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS
AND CONDITIONS, AND YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN
AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, and TIBCO ActiveMatrix BPM, TIBCO Administrator, TIBCO
Business Studio, TIBCO Enterprise Message Service, TIBCO General Interface, TIBCO Hawk, TIBCO
iProcess, TIBCO JasperReports, TIBCO Spotfire, TIBCO Spotfire Server, and TIBCO Spotfire Web
Player are either registered trademarks or trademarks of TIBCO Software Inc. in the United States
and/or other countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle
Corporation and/or its affiliates.

This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which
is available at: https://scripts.sil.org/OFL

Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.

All other product and company names and marks mentioned in this document are the property of
their respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. See the readme file for the
availability of this software version on a specific operating system platform.
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THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS.
CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE
INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE
IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED IN
THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT
NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer
to TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 1999-2020. TIBCO Software Inc. All Rights Reserved.
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